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1 Introduction  

 

Chapter 1.  CIMON XPANEL 

 

1. XPANEL Introduction 

 

XPANEL provides optimized on-site performance using unique technology from CIMON-SCADA. 
XPANEL's broad range of systems covers everything from small machines to large industrial 
facilities, and provides top-quality performance with outstanding reliability and stability in every 
industrial field. Its Windows CE-based OS serves as a stable foundation, and its powerful 
Networking, Graphics Library, Communication Drivers, and convenient Editing UI make it easy 
for beginners to use.   

 

2. XPANEL Properties 

 

1) A Wide Range of Libraries 

Users can easily access a wide variety of Switch and Image Libraries, sorted by category. 

 

 

2) Mass Storage Space 
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● Program capacity is up to 128MB. There is no capacity limit on high-resolution color images.  

● With sufficient storage space, Xpanel supports Project Saving/Data Logging/ Alarm 
Saving/Recipe features, without requiring any memory expansion. 

 

 

3) Screen Capture  

The current Xpanel screen can be saved as a Bitmap Image file, without requiring any 
connection to a PC.  Critical moment and Trend graphs can also be saved as bitmaps, a useful 
feature when reporting operating system status. 

 

 

 

4) Easy and Detailed Animation 

● With a variety of Animation Libraries, even beginners can create vivid animations of on-site 
situations. 
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● New animations can be created and saved using the Animation Editor. 

 

 

5) Simulator 

● Projects created on a PC can be run virtually. The Simulator feature allows you to test a 
projects operation, even without Xpanel and PLC. 

● The Xpanel database simulator feature changes Tag values virtually, providing realistic and 
vivid simulation. 

 

 

6) Security 

● Xpanel's security features allow you to tailor user access to specific functions and operation by 
dividing security into 10 levels.  
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7) Multi-Language/Font  

● Xpanel provides unlimited support for Multi-Language display within a single page, an 
extremely useful feature in a global industrial environment. 

● Xpanel can use standard Windows fonts. 

● Xpanel uses a string Table to store translated strings for quick localization.   

● Applicable Languages: 
 - Korean, English, Chinese (Simp., Trad.), Japanese, German, Arabic, Hebrew, etc.  

(Any language supported by Windows)   
 

※Font type is dependent on the specific Language. 
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8) Data Bridge 

Xpanel synchronizes data between the various devices connected to it. 

It supports data sharing between devices connected to different serial ports, and between 
devices with serial and Ethernet connections. Xpanel serves as a bridge, allowing data sharing 
between devices with no common Communication method. 

 

 

9) Ethernet Communication 

Ethernet Communication allows for High-speed communication. One Ethernet port can 
communicate with several devices simultaneously. 

High-speed data sharing between Xpanel and CIMON SCADA is compatible with a variety of 
network configurations. 

For a downloading/uploading projects, Ethernet Communication is much faster and more 
convenient for on-site installation. Xpanel includes remote monitoring and controlling features. 
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10) High Quality LED Display 

 
Xpanel supports Full Color SVGA (260,000), and allows high-quality graphics with a wide view 
angle. Low power, low heat and full brightness make it one of the most powerful and vivid high-
definition HMI in the market. 

 

 

11) Script  

 
● Xpanel's script language supports C syntax for easy use, and allows user-defined functions. 

 

● A variety of Script types are supported, such as On StartUp, Manual, Periodic, on page 
opening/closing. 

 

 
 

12)  Logistics Management 
 

A wide range of Barcode Readers and RFID Readers are supported, allowing efficient Logistics 
Management. 
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•  Barcode Reader 
Serial and USB-type Barcode Readers are supported. Xpanel's code39 feature displays barcodes 
on screen. 

 
• RFID Reader 
A variety of products, such as Omron, Sick, LSIS, etc. are supported. Xpanel supports changing 
Tag Values. 

 

 
 

13)   Remote Monitoring and Controlling (VNC) 
 

Users can control and monitor the Xpanel screen from a PC or Smart phone using Ethernet 
Communication. 

 
• On IOS : Pocket Cloud 
• On Android : Mocha VNC Lite 

  

※ This feature applies to all models, and need the latest XpanelDesigner. 
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14)  Schedule 
 

●  Xpanel allows execution of pre-registered operations at a pre-determined time. 
 

A variety of schedule configuration operations are available, such as certain time, annually, 
monthly, daily. Calling other operations, such as Writing Tag Value and Script, is supported. 

 

 
 

15)  Data Logging 
 

● Raw Data from a device, or an inner memory value, can be saved, based on a variety of 
conditions. Depending on the logging conditions, data is managed by Model or Block. 

 
● Collected Data can be converted from Binary file format to CSV format. Data can be stored on 
USB Memory and SD Memory up to the limits of the device's capacity. Trend Graph allows 
immediate on-screen access to logged Info.  
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16)  External Interface 
 

A variety of external devices are supported through the USB port, including scanners, keyboards, 
pointing devices and printers that support the PCL driver.  

 

 

 
17)  Alarm Message 

 
● A real-time Alarm summary is available to users on screen. Xpanel allows an unlimited Alarm 
list with a maximum of 10 groups. Depending on the Alarm status, the Alarm action can be 
determined by opening an Alarm Page or by using a Script. The Alarm summary is saved as a 
CVS file, which can be opened in EXCEL. 

● The Scroll Message feature displays Alarms as scrolling messages across the bottom of the 
screen. The Administrator can see the status of each Alarm without checking the Alarm Window. 

 

18)  VNC (Virtual Network Computing)  

● Operator can control the client’s  Xpanel remotely by an Ethernet network connection. 

● VNC makes it possible to provide prompt technical support without a visit to the site. 
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19)  Recipe 

● Production, Assembly line and Machine settings are registered in advance, then later selected 
and applied to the appropriate device. 

● Xpanel's user interface makes it easy to create a project.   

● Recipe settings tables can be modified on-site while the device is in operation. 

● The settings table can be printed out as a Text file; these settings can then be entered in the 
XpanelDesigner settings table. 
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3.  Xpanel Specification 

1) General Specification 

 

Item Description 

Permitted Voltage DC24V or AC100-240V 

Ambient Temperature 0℃ ~ 60℃ 

Storage Temperature -10℃ ~ 60℃ 

Ambient Humidity 10%RH ~ 90%RH (Non-condensing, wet bulb temperature: 39℃ max. 

Storage Humidity 10%RH ~ 90%RH (Non-condensing, wet bulb temperature: 39℃ max 

Air Pressure Vibration 
Resistance 

(Available altitude) 
800hPa ~ 1114hPa(Up to 2000m/6,500ft) 

Dust 0.1mg/m
3
 or less 

Pollution Degree Pollution degree 2 or less 

Corrosive gases Free from corrosive gases 

Vibration Resistance 

IEC61131-2 Compliant 
On occasional Vibration 

10Hz to 75Hz 0.075mm, 57Hz to 150Hz 9.8m/s
2
 

On continuous Vibration 
10Hz to 57Hz 0.035mm, 57Hz to 150Hz 4.9m/s

2
 

X,Y,Z directions for 10 cycle (80min.) 

Noise resistance  1uS 

Electrostatic Discharge 
Immunity 

Contact Discharge 4kV (IEC61000-4-2) 

Discharge in Air 8kV 
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2) Model Specification 
 

 
 

 

Type XT04CD-DN XT04CD-DE XT07CD-DN XT07CD-AN XT07CD-DE XT07CD-AE 

Panel Size 4.3” 7” 

Resolution 480X272 800 X 480 

LCD Color TFT 

Color 65,536 Colors 

Luminance 400 cd/㎡ 

Memory 128MByte DDR2 SDRAM 

Storage 128MByte SLC NAND Flash 

OS Windows CE 6.0 

Programming Tool(HMI) Xpanel Designer 

Audio None 1 Port 

Interface 

Ethernet None 10/100BaseT None 10/100 BaseT 

Serial(COM1) RS232C 

Serial(COM2) RS422/485 

Serial(COM3) None 

USB HOST 1 Port 

Tool Port 1 Port 

SD Card Slot None 1 Slot 

Input Power DC24V DC24V AC100-240V DC24V AC100-240V 

Dimension(mm) 128X102X50 185X127X50 

Panel Cut(mm) 120X94 177X119 
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Type XT08CD-A XT08CD-D XT10CD-D XT10CD-A XT12CD-A XT15CD-A 

Panel Size 8” 10.4” 12.1” 15” 

Resolution 800 X 600 1024X768 

LCD                                                        Color TFT 

Color 262K Colors 16.7M colors 

Luminance 350 cd/㎡ 400 cd/㎡ 450 cd/㎡ 400 cd/㎡ 

Memory 128MByte DDR2 SDRAM 256MByte DDR2 SDRAM 

Storage 128MByte SLC NAND Flash 

OS Windows CE 6.0 Windows Embedded Compact 7 

Programming Tool(HMI) Xpanel Designer 

Audio None 

Interface Ethernet 10/100 BaseT 

Serial(COM1) RS232C RS422/485 

Serial(COM2) RS422/485 RS232C 

Serial(COM3) None RS232C 

USB HOST 1 Port 

Tool Port 1 Port 

SD Card Slot 1 Slot 

Input Power 
AC100-
240V 

DC24V AC100-240V 

Dimension(mm) 227.5 X 176.5 X 59.5 280 X 220 X 47 330X250X83 395X310X89 

Panel Cut(mm) 217 X 166 267 X 207 319 X 239 382 X 297 
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3) Xpanel  Cut Size 
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4. Installation Guide 
 

◆ Critical Safety Information 
 

※ Warning 
 

1) System Configuration 
 

 Please do NOT create Xpanel Graphic Objects that can threaten the safety of the 
device or the operator. If Xpanel malfunctions, but continues to send ON/OFF 
output, this can cause a major accident. To prevent this, install a Limit Switch to 
detect circuit errors and malfunctions. 
 

 Please do NOT create Xpanel Graphic Objects to control Device Safety operations 
such as Emergency Stop.  Device Safety operation switches must be hardware based  
and installed separately. 
 

 Please configure the system so that it will not be affected by the status of 
communication between Xpanel and the Device. 
 

 Please avoid using Xpanel to provide any important warnings, such as those 
involving Operator safety, Device Breakdown or Production Suspension. 
 

 Xpanel is not compatible with extreme conditions which require extremely high 
stability and reliability, such as those involving Aircraft Control devices, Aerospace 
equipment, Nuclear Power Control devices, Medical Life-Support equipment, or 
Central Data Transmission devices. 
 

 If Xpanel operates with Transportation systems (Vehicles, Trains, or Vessels), 
Disaster & Crime Prevention systems, Safety Devices, Medical Equipment (Except 
Life-Supporting), the System must be designed to take into consideration Device 
breakdown prevention & management in order to assure safe and reliable 
operation. 
 

 If the Xpanel LCD Backlight breaks down and the screen turns black, Xpanel will still 
be operating. If the operator touches the Xpanel screen without knowing that it is 
black because of a Backlight malfunction, an accident could result. This is another 
important reason to avoid creating Xpanel Graphic Objects to control Device Safety 
operations such as Emergency Stop. 
 

 If the LCD Backlight suddenly turns off, please follow the procedure below to check 
the LCD status. 

(1) Check to see if Standby mode is off. If it is off, and no images are displayed 
on the screen, the backlight is damaged. 

(2) If Standby mode is on, and no images are displayed after you touch the 
screen, the backlight is damaged.                                          
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2) Installation 
 
 Please do not disassemble Xpanel. An Electric Shock can occur because of the high 

voltage used by Xpanel's internal components. 
 Please do not physically alter Xpanel, because it can cause electric shock or fire. 
 Please avoid using Xpanel in a place where flammable gas is present, since it can 

cause an explosion. 
 

3) Wiring 
 
 To prevent electric shocks, make sure to disconnect Xpanel from any Power source 

when working on wiring. 
 Please do not apply more than the allowed voltage. 
 For tightening the screws on the Terminal Block, proper torque is between 0.5~0.6 

N·m. If accurate torque is not applied to the screws, a short circuit, fire or device 
breakdown could result. 

 Please be careful not to drop any metal or cable pieces into Xpanel's interior. 
 

4) Maintenance 
 

 Xpanel use a Lithium battery to run its internal Clock. There may be a risk of 
explosion if the battery is mounted the wrong way during replacement. If you need 
to replace the battery, please contact your Xpanel provider or distributor. 
 

 

※ Attention 
 

1) Installation 
 

 Secure all connections between cable connectors and Xpanel. A loose connection 
can affect device operation. 

 Both Communication and Input/Output cables should be separated from Power or 
the Power Line by at least 10 cm. 

 
2) Wiring 

 
 Ground the FG line of the Xpanel separately from the FG lines of other Devices. 

Wiring these FG lines too close may cause an electric shock or unit malfunction.  

 Be sure that the rated voltage and terminal layout are within the designated range, 
and wire Xpanel correctly. If the supplied voltage differs from the rated voltage,  or 
incorrect wiring or grounding is applied, it may cause a fire or unit malfunction. 

 When tightening the screws on the Terminal Block, proper torque is between 
0.5~0.6 N·m. If accurate torque is not applied to the screws, it can cause short-
circuit, fire, or device breakdown. 

 Please be careful not to drop any metal and cable pieces into Xpanel's interior. 
 



 

17 Introduction  

 

3) Maintenance 
 

 The LCD contains a strong irritant material. If for any reason, the LCD panel is 
damaged and its contents come into contact with any part of your body, be sure to 
wash that area with running water for 15 minutes. If any of this liquid gets into your 
eyes, wash your eyes and seek medical assistance immediately. 

 
4) Product Disposal 

  
 Product disposal procedures should be in accordance with local or national laws. 

 
 
 

◆ General Safety Information 
 

1) Do not strike the touch panel with a hard or pointed object, or press the touch panel 
with too much force. Doing so may damage the touch panel or the display. 

2) Do not install Xpanel where the ambient temperature exceeds the allowed range. Doing 
so may cause Xpanel to malfunction, or shorten its operational life. 

3) Do not restrict or block Xpanel's rear ventilation, 
4) Do not install or use Xpanel in an environment with extreme changes in temperature. 

Extreme temperature change can cause dew to condense inside Xpanel, resulting in 
device malfunction. 

5) Be sure to keep water, liquid, metal. or charged dust out of Xpanel's interior. 
6) Do not use or place Xpanel in areas exposed to direct sunlight or in a dusty or dirty 

environment. 
7) Do not use or place Xpanel in areas subject to high vibration. 
8) Do not use paint thinner or organic solvent to clean Xpanel. 
9) If you store Xpanel in areas where the temperature is lower than allowed level, the 

liquid in the LCD will congeal, and the LCD may be damages. If, on the other hand, the 
storage area’s temperature becomes higher than the allowed level, the liquid in the LCD 
will become isotropic, causing irreversible damage to the LCD. Therefore, it is important 
to store the panel only in areas where temperatures are within the range specified in 
this manual. 

10) After turning Xpanel OFF, be sure to wait a few seconds before turning it ON again. If 
Xpanel started too soon, it may not start up correctly. 

11) Because of the possibility of accidental loss of data, it is important to back up Xpanel's 
project data on a regular basis. 
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◆ Wiring 

※ Warning 

1) When connecting Xpanel to a power source, be sure that Xpanel's power supply is 
completely turned OFF, via a breaker or similar unit, to avoid an electric shock. 

2) Since there is no power switch on the Xpanel unit, be sure to attach a breaker-type 
switch to its power cable. 

3) To avoid a short circuit caused by loose ring terminals, be sure to use ring terminals with 
a insulating sleeves. 

4) When the FG terminal is connected, be sure that the wire is grounded. 
 
 

● Connecting to Power 
- When connecting Xpanel to Power, be sure to follow the procedures given below. 

 
(1) Be sure that Power Cable is unplugged from the power supply. 
(2) Unscrew the screws on the terminals, then insert Ring Terminals and tighten the screws. 
(3) if the operator comes into contact with any electrical components, it could cause a fatal 

accident (because a charge is stored in the circuit, the operator could be injured by 
touching electrical components even if the device is turned off). Please wait for 5 
minutes after Xpanel is turned off. 

(4) Be sure that the Ring terminal wires are connected correctly. 
(5) Copper wire or the equivalent should meet at least 60% of its requirement.  

(6) Copper wire size must be within the 18AWG(0.823 ㎟) ~ 26AWG (0.405 ㎟) range. When 

tightening the screws, proper torque is between 0.79~0.88 N·m. 

● Notice on Connecting to Power 
- Please pay special attention when connecting Xpanel to a Power supply, as described below. 

 
(1) If the power supply voltage exceeds Xpanel's rated voltage range, use a voltage 

transformer. 
(2) Between power and ground, be sure to use a power supply with low noise. If there is 

still an excessive amount of noise, use a noise reducing transformer. 
(3) The power supply cable should not be bundled with or kept close to main circuit lines 

(high voltage, high current), or input/output signal lines. 
(4) Connect a surge absorber to handle power surges. 
(5) To reduce noise, make the power cable as short as possible. 

 
● Notice on Grounding 

(1) When grounding to the FG terminal at the rear of Xpanel, (on the Power Input Terminal 
Block), be sure to create an exclusive ground. 

(2) Inside the Xpanel unit, the SG (Signal Ground) and FG (Frame Ground) terminals are 
connected to each other. 

(3) When connecting the SG of external device to the SG of Xpanel, be sure that no short-
circuit loop occurs. 
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5. Package Content 

The following items are contained in the Xpanel package. Before using Xpanel, please confirm 
that all items listed here are included. 

※ The diagram below is for illustration purposes, and may differ from actual size. 

• Xpanel Unit     • Fastener: 8 EA 

 

 

 

 

• 5P Connector(XT08/XT10/XT12/XT15)         • Installation Guide 
 
 
 
 
 
 
 
 
                                    • Installation CD                                        •Power Plug (XT07/XT07/12/15) 

 
 

 

 
 

 

This unit has been carefully packed with special attention to quality. However, should you find 
anything damaged or missing, please contact your local Xpanel distributor immediately. 
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Chapter 2.  Menu Configuration and Features 

 

1. XpanelDeisgner Configuration 

This chapter describes the various tool bars and configuration options.  

 

1) Menu:  Select configuration Tools. 

2) Tool Bar:  Displays menu functions as icons for quick access. 

3) Color Tool:  Select object and background colors. 

4) Project Workspace:  Provides shortcuts to a variety of features and pages used in the 

project. 
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5) Page:  For project development.   

6) Tag Window:  Displays the Tags included in the current page. It includes shortcuts to Tag 

configuration and Object Properties. 

7) Object Window: Displays the current Tag properties in tree view. 

8) Coordinates:  Shows the mouse location. 

2. Menu Configuration 

1) File 

 

(1) New Page 

Create a New Page. 

 

(2) Open 

Open other pages during development. This is useful for access to other project 

features such as page files, Scripts and Databases.  

 

(3) Close 

Close the current page. 
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(4) New Project 

Create a new project. 

 

(5) Close Project 

Close the current project. 

 

(6) Copy Project 

Copy and back up the current project. 

 

(7) Save 

Save the current project. 

 

(8) Save as 

Save the current project under a different name.  

 

(9) Save All 

Save all work. 

 

(10) Convert To Runtime Project 

Compile the current project. This compiles without downloading, and includes 

error-detection.  

 

(11) Frame Editor 

Edit individual frames of the Xpanel screen. 

 

(12) Page setup 

Printer settings, such as Headers, Footers, Margins, and Black&White Reversal. 

 

(13) Preview 

Display a preview before printing out. 

  

(14) Print 

Print out the current page. 

  

(15) Exit 

Close Xpanel Designer. 
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2) Edit 

 

(1) Undo 

Cancel the last operation.  

 

(2) Redo 

Reverse the last Undo operation. 

 

(3) Cut 

Delete the selected item and copy it to the Clipboard. 

 

(4) Copy 

Copy the selected item to the Clipboard. 

 

(5) Paste 

Paste the item currently in the clipboard to the selected location on the page. 

 

(6) Delete 

Delete an item without copying it to the clipboard. 

 

(7) Select All 

Select all items on the page. 

 

(8) Find 

Find a tag or string in the project. 

 

(9) Replace 

Replace a Tag name or String.  This can be done on a page by page basis, or for the 

whole project. 
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This is useful for quickly converting between Virtual Tags and Real Tags. 

 

(10) Object Configuration 

Open the Object Configuration dialog box. 

 

(11) Graphic File Paste 

Paste a Graphic File into the page.  Supported file types include JPG and BMP, but 

not PNG. 

 

(12) Insert Animation Bitmap 

Insert an Animation into the Page, from either the XpanelDesigner Library or from 

a custom user library created with User Library Edit from the Tools Menu. 
 

3) Draw 
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Object Type Display Description 

(1) Line 
 

 

 

Draw a line Object on the page. 
You can control line color and 

thickness using Object 
Configuration. 

 

(2) Rectangle 
 

 

Draw a rectangle on page. You 
can change the fill and border 

color using Object 
Configuration. 

 

(3) Ellipse 
 

 

Draw an ellipse on the page. 
You can change the fill and 
border color using Object 

Configuration. 
 

(4)Arc 
 

 

Draw an arc on the page. You 
can change the fill and border 

color using Object 
Configuration. 

 

(5) Sector 
 

 

Draw a sector on the page. You 
can change the fill and border 

color using Object 
Configuration. 

 

(6) Chord 
 

 

Draw a chord on the page. You 
can adjust chord color and 

thickness using Object 
Configuration. 

 
 

(7) Polyline 
 

 

Draw a polyline on the page. 
Line color and thickness can be 

adjusted using Object 
Configuration. 
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(8) Polygon 
 

 

Draw a polygon on the page. A 
polygon can be drawn 

connecting between the 
beginning and the end of a free-

form curve. 
 

(9) Text 
 

 

Enter text on the page. The font 
type and size can be adjusted. 

 

(10) Dynamic 
Tag 

 

 

Display the value of a Tag in the 
database. 

 

(11)Date&Time 
 

 

Display the date and time on 
the page. You can choose three 

display modes. 
(Year/Month/Day,Hour:Min:Sec, 
Year/Month/Day Hour:Min:Sec) 

 

  

(12) String Value 

Display the value of a String Tag. 

 

 

(13) Multi Language String  

Multiple language Strings can be used by selecting Multi Language Setup in the 

Tool menu. 
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(14) Trend Graph 

Display Trend Graph on the Page.  Six types of Trend Graph are available (YT, SPC, 

ST, Scope, Log, and XY). 

 

 

(15) DataLog 

Display log data in a table. This feature is supported on real-time based systems. 
 

(16) Key Input Window 

Create a dialog box which takes a String or Number as Input. When no Keyboard is 

available, a virtual soft keyboard can be used to enter input. 

 

 

※ For the End Code, refer to the ASCII Code Table. 
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(17) Alarm Summary 

Display pre-determined alarm information on the screen, based on the Alarm 

condition. 

 

(18) Switch/Lamp 

Handle various functions with one button. With a variety of Switch/Lamp Libraries 

available, it is possible to configure several operations at the same time. 
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(19) Library 

A variety of Object libraries are available, such as Machinery, Equipment, Lamps 

etc. Please update to the latest version of XpanelDesigner on a regular basis so you 

can take advantage of library updates. 

 

 

4) View 

(1) Redraw 

 

(2) Current Page Position To Runtime 

 

(3) Tag Window 

The Tag Window displays all the tags used on the current page. It lists tag names, 

kinds (i.e., digital or analog), addresses and types. 
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(4) Object Window 

Displays Object Properties in the form of a tree view. 

 

 

(5) Project Workspace 

This provides convenient access to project management features. You can view a 

list of pages added to the project, and you can check, open and delete pages. You 

can use shortcut functions such as “database” or “script”.  

 

(6) Main Tool 

The Main Tool is a toolbar which includes the most commonly used features in 

Xpanel.  

 

 

(7) Status Tool 

The Status Tool displays the mouse location, along with XpanelDesigner status 

messages. 
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(8) Drawing Tool 

Draw Objects, such as Diagrams, Dynamic Tags, Text, etc. 

 

 

(9) Color Tool 

The Color Tool allows you to select colors for Object such as diagrams. 
 

 

(10) Arrange Tool 

Arrange or place objects on the Page. 

 

Group 
 

Combine the selected objects into a group 

Ungroup 
 

Release a grouped set of objects. 

Bring To Front 
 

Bring the selected object to the front of a set of overlapping 
objects. 

Send To Back 
 

Move the selected object to the back of a set of overlapping 
objects. 

One Step Forward 
 

Bring the selected object forward one step in a set of overlapping 
objects. 

One Step Backward  
Move the selected object one step back in a group of overlapping 
objects. 

Align 
 

Aligns the selected objects based on the alignment selection. 
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Space Horizontal 
 Distribute the horizontal spacing of objects evenly. 

Space Vertical 
 

Distribute the vertical spacing of objects evenly. 

90’Clockwise  
 

Rotate the selected object 90° clockwise. 

90’Counterclockwise 
 

Rotate the selected object 90° counter-clockwise. 

Horizontal 
 

Flip the selected object horizontally. 

Vertical 
 

Flip the selected object vertically. 

Reshape 
 

 
Diagram shapes can be changed by dragging the edge of the 
object. 

Snap To Grid 
 

 
After dividing page into a small grid, this feature aligns objects to 
the grid lines when you draw or move them. It is useful for 
controlling vertical and horizontal alignment. 

 

(11) Font Tool 

Select the font type and size. 

 

 

 

(12)  Switch/Lamp Tool 

Change the Switch/Lamp State by changing its Tag value status. 
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(13) Tag View Tool 

 

(14)  Zoom In/Out 

Control the magnification of the screen (up to 800%). 
 

5) Online 

(1) Setup Link 

Select the type of connection between the PC and Xpanel:  either “USB cable” or 

“Ethernet”. 

 

(2) Download To Xpanel (PC->Xpanel) 

Download the project from the PC to Xpanel. 

 

 

 (3) Upload From Xpanel (Xpanel->PC) 

This feature transmits the downloaded project from Xpanel to the PC. 
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(4) Upload From Storage (Storage->PC) 

Transfer a project from a portable storage device (USB memory or SD memory) to 

the PC. 

 

(5) Make Executing Removable Memory 

The project is downloaded to USB or SD memory. After installing the removable 

memory device into Xpanel, the operator can run the project without 

downloading it to Xpanel. This feature is useful when the size of project is too 

large to download to Xpanel. 

 

(6) Copy Project To Removable Memory 

Download the project from the PC to USB memory or SD memory. After inserting 

the memory device into Xpanel, the project can be transmitted to Xpanel through 

the Ethernet Loader. This allows you to update a project in the field using portable 

memory, rather than a PC. 

 

(7) Stop Xpanel Application Program  

When the PC is connected to Xpanel and online, this will terminate the current 

project and exit to Xpanel Desktop. 

 

(8) Run Xpanel Application Program 

When the PC is connected to Xpanel and online, this will re-run the terminated 

project. 

 

(9) Run Remote Control Server 

This command must be run before using VNC.  

 

(10) Stop Remote Control Server 

This command must be run in order to stop VNC. 

 

(11) Run Remote Control Viewer 

This allows you to monitor and Control the Xpanel screen from the PC using VNC.  
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(12) Upgrade Xpanel Application Program 

Upgrade the Xpanel Application Program. If the Application Program versions used 

by Xpanel and XpanelDesigner are different, you must re-download the project to 

run properly. You do not need to use this feature unless the Xpanel Application 

Program file is corrupted, or until an upgrade becomes necessary for other 

reasons. 

 

(13) Xpanel Repair Mode 

This feature is used when you cannot download the project to Xpanel for any 

reason, or if an error occurs. After running Repair Mode, you must execute System 

Shutdown or download the project to Xpanel to finish the process. 

 

(14) Xpanel Touch Calibration 

When the touch screen is not accurate, run Xpanel Touch Calibration. With this 

feature on, press the touch calibration points as directed. After the completion of  

the calibration process, you must run System Shutdown to save the calibration 

settings.   
 

6) Arrange 

(1) Group 

Combine the selected objects into a group. 

 

(2) UnGroup 

Release a grouped set of objects. 

 

(3) ReGroup 

Regroup previously ungrouped Objects. 

 

(4) Bring To Front 

Bring the selected object to the front of a set of overlapping objects. 

 

(5) Send To Back 

Move the selected object to the back of a set of overlapping objects. 

 

(6) One Step Forward 

Bring the selected object forward one step in a set of overlapping objects. 

 

(7) One Step Backward 

Move the selected object one step back in a group of overlapping objects. 

 

 

(8) Arrange 

Arranges the selected objects based on the alignment selection. 
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 (9) Rotate 

 

A. 90° Rotate clockwise : Rotate the selected object 90° clockwise. 

B. 90° Rotate counter-clockwise : Rotate the selected object 90° counter-

clockwise. 

 

(10) Flip 

A. Horizontal : Flip the selected object horizontally. 

B. Vertical : Flip the selected object vertically. 

 

(11) Diagram Reshape 

Diagram shapes can be changed by dragging the edge of the object. 

 
 

(12) Enable Snap 

After dividing page into a small grid, this feature aligns objects to the grid lines 

when you draw or move them. It is useful for controlling vertical and horizontal 

alignment. 

 

 
(13) Grid Configuration 

Three grid types (No grid, Line, Dot) are supported. The user can choose the grid 

interval and colors.  
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(14) Make Symbol 

Set a picture or object as the page background. Once the background is set, you 

cannot edit it. 

 

(15) Break Symbol 

Release a picture or object from being the Page Bacground. 

 

7) Tools 

(1) Page Setup 

Change general settings for the page, such as shapes, background color, security 

level, page size, etc. 

 

 
 (Please see the detailed description in ‘Chapter 4 – Page Setup') 

(2) User Library Edit 

Edit and add a user-created library. 
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(3) Bitmap Edit 

Edit Bitmap objects on the page. This feature provides simple editing, but does not 

support many of the functions that you would find in Paint or a professional image 

editing program. 

 

 
 

  

(4) Run Simulator 

Check an Xpanel project on the PC simulator. This feature provides virtual 

simulation even without a connection between Xpanel and PLC. Using the Xpanel 

Database Simulator, you can change the Tag value. 
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(5) Run simulator With Active Page 

Without setting up a Starting Page, the current Page can be run on the Simulator.  
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(6) Project 

Change overall project settings such as Xpanel Type, Multi-language. For example, 

you can change the project model size from 10.4” to 7” by using the Convert 

feature.  

 

 
 

 

(7) Database 

Create and edit Tags for communication. Tag types can be Digital, Analog, or 

String. A Real tag is used for actual communication with the device.  A Virtual tag 

uses Xpanel's internal memory. 
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(8) CIMON-XPANEL Setup 

Set up Xpanel operation. The Initial Page of Xpanel must be selected before 

downloading the project to Xpanel. If the Initial Page is not set, an error message 

will appear during downloading. 

 

 
(9) I/O Device 

Set Xpanel's communication properties, such as Serial/Ethernet, Protocol, Comm. 

Speed, etc. 
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(10) Alarms 

To create the Alarm list and set Alarm conditions. The Alarm summary and Alarm 

Action can be set when the Alarm is ON. 

 

 
 

 

(11) Security 

Limit access to Xpanel only to users with sufficient authority. Security is divided 

into 10 Levels. A user ID can be given a password. Operations such as Log On/Off 

Actions can be configured. 
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(12) Data Logging 

Collect and save Data in a variety of formats. The data logging Start Option, 

Logging Option, and Logging Tag must be set up.  

 

 
 

(13) Scripts 

Scripts supports C-style syntax. There are three types of script: “On StartUp(Auto)”, 

“Manual” and “Period”. 
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(14) String Editor 

Create a set of strings.  You can display string value according to tag value. 

 

 
  

(15) Data Server 

When Xpanel is used as a Data server, it can transmit tag values to equipment and 

clients. 

● Xpanel Data Server - CIMON dedicated communication with CIMON 

SCADA by Ethernet. 

● MODBUS Slave : Communicate with Modbus Master in Modbus 

Protocol (RTU or TCP). 
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(16) Recipe 

Create a Set of Data in advance, to be used later on site. The user can Upload or 

Download the values between Xpanel and the Real device (PLC). 

 

 
 

 

(17) Data Bridge 

When one device cannot communicate with another device directly, Xpanel can 

serve as a bridge to exchange data between both devices. 
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(18) Animation Editor 

Users can create their own Animation Objects. After adding graphic files to the 

Animation Editor, the user can run a virtual Simulator.   

 

 
 

 

(19) Cross Reference 
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Search the Tags used in the Project, then  display where the Tags are used. 

 

 
 

(20) Multi Language Setup 

 

Enter multi-language text for each Column using the String Editor.  

 

※ To enter different languages in an Xpanel Page, use the  Windows Language 

Bar on the PC. 
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Chapter 3.  Edit Tags and Communication 

 

1. Create a new project 

1) Select New Project from the File menu. 

 

 

2) Enter the Project Name. 
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3)  Select the appropriate Xpanel Size. 

 

※ For XT07C-R(7.0”), the project display will be rotated by 90°. 

※ For XT10(10.4”), XT10C is a more recent version, with a higher resolution (800*600). 
 

4)  After you have stepped through the Project Configuration Wizard, a new page will 

appear.  
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2. Serial Communication with the CIMON PLC 

For communication between the PLC and Xpanel, Communication parameters must be 

configured. 

The first step is to configure or verify the PLC communication settings. If you are using a  CIMON 

PLC follow the steps below. If you are using a different brand of PLC please refer to its 

communication settings documentation.  

1) Cimon PLC Communication settings (CM3-MDT and CM3-SP02ERS) 

(a)  Check CICON's Communication parameters.  

- Select Connect from CICON's Online Menu 

 

 

If CICON connects to the PLC properly, you will see module information in the “Work 

space,” as shown below. 

 

To check the communication setup, double-click on the CM3-SP02ERS(RS232C/422/485) module. 
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As shown above, the PLC communication parameter settings are: 

Station No.: 0,  
Baud Rate: 9600,   
Parity: None 
Data Bit: 8 
Stop Bit: 1 
 

Xpanel's communication settings must match the PLC parameters settings. 
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2)  CIMON XPANEL Communication settings 

(1) I/O Device settings 

Select I/O Devices from the Tools menu. 

 

Communication parameters are set in I/O Devices.  

Select the PLC type and enter parameter settings that match the PLC communication 

parameter settings. 

(2)  I/O Device Name and Type 

Click on New Device and select the Device type. 

 

 

If Xpanel communicates with several PLCs, I/O Device Names will help to classify them. 
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Click “OK” to bring up the “Serial Communication Configuration” dialog box. 

(3)  Communication Port 

Enter the same parameter settings as those for the PLC. The communication type is RS232 

in this example. 

 

Click “Station” to move to the next step. 

(4) Station 

Click on Add Station to create a New Station. 
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(5) Station Configuration 

Enter a Station Name and select the Station Type (PLC type). 

 

The Station number must be the same as the CICON Station number. 

※ What is a Station number? 

 

The Station Number is used by the Master device (Xpanel) to identify the Slave device (PLC) 

during Serial Communication. This allows Xpanel to keep track of multiple PLCs. 
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Click on “OK” to save the configuration. 

 

As you can see, the PLC1 station has been added. 

The next step is to save the PLC address in XpanelDesigner.  

3. Database Configuration 

※ Xpanel recognizes two types of PLC address: Database Virtual and Real Address tags. 

For Database addressing, the Address must be saved to the Xpanel Database in advance. The 
Xpanel Database requires a name (TAG) for each address. 
 
1) Open a Database 

Select Database from the Tools menu.  
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2) Create a New Tag 

 

Click on the Tag icon in the left-upper corner. 

a)  Analog Tag 

Enter “OUTPUT” as the name and select Analog as the type. An Analog Tag is required for a 

PLC Word address. Select “Real Tag”, then select CIMON.PLC1 (the station that you had 

previously created) as the  I/O Device. Enter “D100” as the I/O Address and click “OK”. You 

will see the “OUTPUT” tag listed in the Database. 
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b) Digital Tag 

Enter “DIGITAL” as the name and select Digital as the type.  A Digital Tag is required for a PLC 

Bit address. Select “Real Tag”, then select CIMON.PLC1 (the station that you had previously 

created) as the  I/O Device. Enter “D100” as the I/O Address and click “OK”. You should now 

see both the analog and the digital tag in the database. This completes the communications 

settings. 

 

4. Dynamic Tag 

Select New Page form the File menu. 

 

 

Select Dynamic Tag from the Draw menu and click on the Dynamic Tag icon. Move the 

mouse to location on the page where you want to put the tag value. When you click on the 

page, the “Tag Value” window will appear, as shown below. Click on the icon shown in the 

red box to select the Tag. 
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Select the “OUTPUT” Tag and click on “OK” 

“OUTPUT” will appear as the Tagname. Click on “OK” to save the value. 

 

An object with question marks [????] will appear on the page. The question mark indicate 

that the connection between Xpanel and the Device (PLC) is not ready. When 

communication works properly, the question marks will disappear and the real device value 

will be displayed. 
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5. Entry Data 

The Entry Data setting in the Object Config dialog box is used to input or change the Tag Value.  

First, create a button for entering the Tag Value. 

Select Rectangle from the Draw menu.  

Find the cross mark on the page, then select it using the mouse left button and drag it. 

 

Click the Text icon or select Text from the Draw menu. Click inside the box, and enter “OUTPUT”. 

 

 Double-click on the Text Object to bring up the “Object Config” dialog box. 



 

Chapter 3. Edit Tags and Communication 60 

 

 

Click on EntryData, then select Tagname.  
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 Select the “OUTPUT” Tag and click “OK”. 

 

 

The Tagname field will display the “OUTPUT” Tag. Click “OK” to save the configuration. 
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6. ON/OFF button (Switch/Lamp) 

Switch/Lamp is used to create a button for changing lamp status when the tag value is turned On 

or Off. 

 

Click on the icon shown below or select Switch/Lamp from the Draw menu.  

 

 

 

Click on “Lamp” to select the lamp options. 
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Select “Use Lamp”, “Digital Tag” and other options as shown below. 

 

 

 

Click on “Tag 1”. Select “DIGITAL” for indicating ON/OFF status. 
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Click on “Shape Select” to choose a switch design. 

 

 

 

‘State 0’ is the image that will be displayed when the switch is OFF. ‘State 1’ is the image 

displayed when it is ON. Double click ‘State 0’ to select an image. Select one of the images 

in the Part Palette. 
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Select a Switch/Lamp Pattern. 

 

. 
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Double click ‘State 1’ and select an image, as shown above. Click ‘OK’ to save the switch 

image. 

 

 

Click on ‘Switch’, then click ‘Tag Name’. 
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Select the “DIGITAL” Tag. 

 

 

Select ‘Set’ as the “Function”, as shown below. 

 

● Set : The Digital tag is turned ON when you push the button. 
● Reset : The Digital tag is turned OFF when you push the button. 
● Toggle : The Digital tag changes ON to OFF or OFF to ON when you push the button. 
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Click on “Add” to add a switch feature which will be activated when the mouse button is down. 

 

Add one more button, with the “Reset” feature, then click on Add. 
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Click “OK” to display the Switch/Lamp Object one the page, as shown below. 
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7. Downloading a Project  

 

There are 3 options for downloading a project to Xpanel. 

1. USB mini (B) cable 

2. Ethernet cable 

3. USB/SD memory card 

 

   ► Downloading a project from a PC to Xpanel using a USB cable is covered in the next chapter. 
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Chapter 4.   Screen and Graphic Development 
 

 

 

1. New Project 
 

Select New Project from the File Menu. 

 

 
 

 

 

Select the Xpanel model. 

 
Click on Finish to create the new project. 

(For Hybrid Xpanel, Select XT07C, then select the Hybrid checkbox in the Options section of 

the dialog box.) 

※ The page size will be the same as the Xpanel screen size. 
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● Screen size & Resolution 

Resolution of the Xpanel screen 

XT04 480 X 272 262K Color 

XT07 800 X 480 262K Color 

XT08 800 X 600 262K Color 

XT10 800 X 600 262K Color 

XT12 800 X 600 262K Color 

XT15 1024 X 768 16.7M Color 

 

 

2. New Page 
 

1) Normal Page 

When you create new page, the default is Normal Page. The page size will be the same as 

the Xpanel screen size when you create a new project.  Page information will appear in the 

Workspace section, as shown below. 

 

 
 

 

 

 

2) Pop Up Page 

To create a Pop Up page, select Page Setup from the Tools menu, right-click on the page, 

then select Page Setup from the right context menu.  In the Page Properties dialog box, 

select Pop Up Page.   



 

73 Chapter 4. Screen and Graphic Development 

 

 
< Page type selection using the page's mouse right click menu > 

 

 

 

 
< Page type selection from the tools menu Tool Menu> 
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Enter the Size of the PopUp page. Its Position and Size are both measured in Pixels. After 

setting the Position and Size, click on Copy, then OK. 

 

 

 
 

 

 

※ Xpanel Size and Position Table  

 

Model Position 

XT04 

 

XT07 
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XT08 

 

XT10 

 

XT12 
 
 

 

 

 

 

XT15 
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3. Page Properties. 

 

1) Page Properties 

 

(1) Page Type (Shape) 

 

 

 
 

(a) Normal Page : This is the default page, with a size the same as the Xpanel 

device that you select when you create a New Project. 

(b) PopUp Page : This displays a PopUp page on Normal Page. 

(c) Keypad Page This displays a user-created Keypad Page. 

 

 

(2) Page Option 

 

(a) Fixed BackGround 

You can set an object as a fixed background for faster graphic processing.  However, if 

the Object has a function, such as Blink, Visible, Move etc., it will always be brought 

to  the foreground. 

For example, If the Orange object has function, Visible, and is beneath the Blue 

object, the Orange object will be brought in front of the Blue object. 
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Xpanel Designer Xpanel actual screen 

Fixed 

BackGround 

turned off 

 

 

 

 
Even if the Visible feature is SET, the Orange 

Object is still behind the Blue object, just 

like the XpanelDesigner screen. 

Fixed 

BackGround 

 

 

 

 
If the Visible feature is SET, the Orange 

Object is displayed in front of the Blue 

object. 

 

 

 

(b) Draw Changed Object Only 

This will speed up graphic processing. When an Object's status is changed, Xpanel 

recognizes only the changed object in order to speed up Page Refresh (Xpanel 

normally recognizes all objects displayed on the screen). In this case, the position 

of the object will be changed. 

※ Even if the Orange object is under the Blue object, the Orange object will be 

displayed in front of the Blue when the status of the Orange object is changed, as 

shown below. 
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To set the Visible feature on the Blue Object first, then on the Orange Object 

Xpanel Designer Xpanel actual screen 

Draw 

Changed 

Object Only 

(Disable) 

 

 

 

 

Draw 

Changed 

Object Only 

(Enable) 

 

 

 

 
If the Orange object is Visible, it will be 

displayed in front of the Blue object. 

 

 

(c) Using a 256 color Bitmap 

Change the image to a 256 color Bitmap automatically. This decreases color depth, 

in order to not take up as much Page capacity. 

 

 

(d) Display Touch Area 

When the user clicks on a button object, the button will be outlined, to confirm 

that it has been clicked. 

 

 
 

(e) Enable Multi Touch Action 

If two different objects are overlapped, both objects (Touch function) are 

activated when the user clicks the overlapped part. 
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(3) Security level 

Set up Security Levels, from 0 to 10. The maximum security level is 10. 

 

(4) Background 

Select the page Background color. 

 

 
 

2) Page Position 
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A. Edit Position 

Control the size and position of page. The default page size and position are 

automatically set when you create a project. If you create a page inside a frame, 

you can adjust the size of the page. When using a Popup Page, you need to set 

the page size and position in order to display it in the right location in Xpanel. 

 

※ For Size and Position, look at the (X,Y) Coordinate.  

 

 
 

B. Copy 

After setting the size and position of the page, click on Copy to apply the settings to the 

Xpanel device. 

 

C. Position in Frame 

If the Page is comprised of several frames, each frame must have a number 

designation. 

 

D. Run Position 

Test the position settings by displaying the page in Xpanel. 
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3) Action 

Execute a command when opening or closing a Page. 

Giving each page a different number allows the PLC to recognize the page currently opening 

during page transitions.  

 

 
 

4. Frame Editor 
 

Divide a page into several Pages. 
Dividing the Page into frames allows you to change each frame individually. For example, 

Frame#1 changes while Frame#2 and #3 are fixed. In this case, Xpanel only needs to refresh 

Frame #1. 

 

 
※ Default Frame : Frame with only one page in it. 
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1) Create a Page with a Number and Size. 

First, create each page for the #1, #2 and #3 locations. Each Page size can be controlled using 

the Edit Position tab of the Page Setup dialog box. Set each Page number using Position In 

Frame on the Edit Position tab. 

 

 

2) Frame Configuration (Frame Editor) 

A. Enter a FileName. 

B. Select a Border Type. 

C. Select a Frame Type. 

D. Select a page for each Frame, with the appropriate Width and Height. 

 

After Frame configuration is completed, a file will be created with the Extention *.FRX. 

 

 
 

 

※ To set the Xpanel Starting Page to be a Frame, select Xpanel Configuration from the 

Tools menu, then select the approrpriate frame file with the extension *.FRX.  
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3) Position in Frame (Page Setup) 

Pages are labeled Page1, Page2, Page3 or Page4 for the purpose of Frame Configuration 

(with a maximum of four pages). 

 

※ Page Transition in Frame 

To open a new page in a frame, use the function PageOpen. The Target Page must have the 

same Position in the Frame as the current Page. 

 

 

 File Types in an XpanelDesigner Project 

 

Extension Description Notice 

[Project Name].PRJ 
Default project properties are 

saved. 
 

*.PGX Page File 
File name modification or 

deletion is allowed. 

*.FRX Frame Configuration File 
File name modification or 

deletion is allowed. 

[Project Name].DBX Database File  

*.DVX I/O Device Configuration File  

[Project Name].LOX Database Configuration File  

[Project Name].SCX Script File  

[Project Name].SFX String File  

[Project Name].MBS 
MODBUS SLAVE Configuration 

File 
 

[Project Name].RXC Recipe Configuration File  

[Project Name].BRX Data Bridge File  
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 File Type in Xpanel Device 

 

Extension Description Notice 

[Project Name].XPR Project File  

*.XPG Page File  

*.RCP Recipe Configuration File  

*.DBF Data Bridge File  

*.LGR   

*.LGT Log Trend File  

*.SEC Security File  

*.MBS MODBUS Slave File  

*.XPR Frame Configuration File  

*.XED Project Upload File 

This file is created when the 
Download The Editing 

project feature is enabled 
while Downloading a 

Project. 

*.LGR Datalogging Configuration File  

*SIF Script File  

*.XSF String Table File  

*.XDV I/O Device Configuration File  

*.AIF Alarm Configuration File  

*.SCO Scope Trend File  

*.SPC SPC Trend File  

*.TRA ST Trend File  

*.XYT XY Trend File  
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Chapter 5.  How to Draw Objects 

 

1. Line 
 

1)  Drawing a Line 

 

Select Line from the Draw menu, or click on the line icon                                                             in the 

Drawing Toolbar. The process is the same as drawing a line in a standard graphics program:  

click on the starting point of the line, hold the left mouse button down while you draw the line, 

then release it at the end point of the line. 

 

 
 

2) Editing a Line 
 

(1) Line Direction/Length Control 

When you click on an end-point of a line, a Left-Right arrow will appear.  you can use the 

mouse to change the length and direction of the line. 

 

 
 

(2) Moving the Line Object 

Click between the end points of a line, and you will see a four-arrow cursor; move it to move 

the line. 
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(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 
 

 Position 

Set the line position by entering its coordinates. The X and Y value indicate the upper-

left corner of a rectangle for which the line would be the diagonal.  

 

 Size 

The Width is the horizontal distance between the two ends, and the Height is the 

vertical distance. 
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 Line 

Select the line style and thickness. 

 Fill 

Select the line color. 

 

 
 

 

2. Rectangle 
 

1) Drawing a Rectangle 

 
Select Rectangle from the Draw menu, or click on the rectangle icon 

in the Drawing Toolbar. The process is the same as drawing a rectangle in a standard graphics 

program:  click on a corner of the rectangle, hold the left mouse button down while you move it 

to the diagonally opposite corner, then release the mouse button. 
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2) Editing a Rectangle 
 

(1) Rectangle Size and Shape Control 
Select an edge or a corner of the rectangle, and the Left-Right arrow will appear.  Drag it to 

change the shape or size of the rectangle. 

 
 

(2) Moving the Rectangle Object 

Click in the center of the rectangle, and you will see a four-arrow cursor; move it to move 

the rectangle. 

 

 
 

(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the rectangle position by entering its coordinates. The X and Y value indicate the 

upper-left corner of the rectangle. 

 

 Size 

The width is the horizontal distance between two corners, and the height is the vertical 

distance. 
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 Line 

Select border thickness and style. 

 Fill 

 

A. Select the border color. 

B. Select the fill color. 

 

 
 

 Transparent Draw 

This makes the background transparent. 
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3. Ellipse 
 

1) Drawing an Ellipse 

Select Ellipse from the Draw menu, or click on the ellipse icon                                                             in the Drawing Toolbar. The process is the same as drawing an ellipse in a standard graphics program:  click on a point representing a corner of an invisible rectangle bounding the ellipse, move the mouse towards the opposite corner, then release it when 

the ellipse has the correct size and shape. 

 

 
 

2) Editing a Ellipse 
 

(1) Ellipse Size and Shape Control 
Select an area near the border of the ellipse, and the Left-Right arrow will appear.  Drag it to 

change the shape or size of the ellipse. 

 

 
 

 

(2) Moving the Ellipse Object 

Click in the center of the ellipse, and you will see a four-arrow cursor; move it to move the 

ellipse. 
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(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the ellipse position by entering its coordinates. The X and Y value indicate the upper-

left corner of the imaginary rectangle bounding the ellipse. 

 

 Size 

The width is the greatest horizontal distance across the ellipse, and the height is the 

greatest vertical distance. 

 

 

 

 

 

 

 

 

 

 

 

 Line 

Select border thickness and style. 

 Fill 

 

A. Select the border color. 

B. Select the fill color. 
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 Transparent Draw 

This makes the background transparent. 

 

 

4. Arc 
 

1) Drawing an Arc 

 
Select Arc from the Draw menu, or click on the arc icon                                            in the Drawing 

Toolbar. The process is the same as drawing an arc in a standard graphics program:  click on the 

starting point of the arc, hold the left mouse button down while you draw the arc, then release 

it at the end point of the arc. 
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2) Editing an Arc 
 

(1) Arc Size and Shape Control 
Click on the Arc Object and move the mouse cursor to the end of the imaginary rectangle 

containing it, then a Left-Right arrow will appear.  Drag it to change the shape or size of the 

arc. 

 

 
 

 

(2) Moving the Arc Object 

Click on the arc, and you will see a four-arrow cursor; move it to move the arc. 

 

 

 

(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the arc position by entering its coordinates. The X and Y value indicate the upper-left 

corner of a rectangle which would contain the arc. 

 

 Size 

The Width is the horizontal distance between the two ends, and the Height is the 

vertical distance. 
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 Line 

Select the arc's line style and thickness. 

 Fill 

Select the arc's line color. 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 



 

95 Chapter 5. How to Draw Objects  

 

5.  Sector 
 

1) Drawing a Sector 

 
Select Sector from the Draw menu, or click on the sector icon                                                             

in the Drawing Toolbar. The process is the same as drawing a sector in a standard graphics 

program:  click on the starting point of the sector, hold the left mouse button down while you 

draw the sector, then release it at the end point of the sector. 

 

 
 

2) Editing a Sector 

 

(1) Sector Size and Shape Control 
Click on the Sector Object and move the mouse cursor to the end of the imaginary rectangle 

containing it, then a Left-Right arrow will appear.  Drag it to change the shape or size of the 

sector. 

 

 
 

(2) Moving the Sector Object 

Click on the sector, and you will see a four-arrow cursor; move it to move the sector. 
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(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the sector position by entering its coordinates. The X and Y value indicate the upper-

left corner of a rectangle which would contain the sector. 

 Size 

The Width is the horizontal distance across the sector, and the Height is the vertical 

distance. 

 

 

 

 

 

 

 

 

 

 Line 

Select border thickness and style. 

 Fill 

 

A. Select the border color. 

B. Select the fill color. 
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 Transparent Draw 

This makes the background transparent. 

 

6. Chord 
 

1) Drawing a Chord 

 
Select Chord from the Draw menu, or click on the chord icon                                                 in the 

Drawing Toolbar. The process is the same as drawing a chord in a standard graphics program:  

click on the starting point of the chord, hold the left mouse button down while you draw the 

chord, then release it at the end point of the chord. 

 

 
 

2) Editing a Chord 
 

(1) Chord Size and Shape Control 

Click on the Chord Object and move the mouse cursor to the end of the imaginary rectangle 

containing it, then a Left-Right arrow will appear.  Drag it to change the shape or size of the 

chord. 

 
 

 

(2) Moving the Chord Object 

Click on the chord, and you will see a four-arrow cursor; move it to move the chord. 

 

(3) Position/Size & Line/Fill 
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※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the chord position by entering its coordinates. The X and Y value indicate the upper-

left corner of a rectangle which would contain the chord. 

 

 Size 

The Width is the horizontal distance across the chord, and the Height is the vertical 

distance. 

 

 

 

 

 

 

 

 

  

 

 Line 

Select border thickness and style. 

 Fill 

 

A. Select the border color. 

B. Select the fill color. 
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 Transparent Draw 

This makes the background transparent. 

 

7. Multiline 
 

1) Drawing a Multiline 

 
Select Multiline Object from the Draw menu, or click on the multiline icon  

in the Drawing Toolbar. The process is the same as drawing a similar object in a standard 

graphics program:  click on the starting point, hold the left mouse button down while you draw 

it, and then release it at the end point.  

 

 
 

2) Editing a Multiline 
 

(1) Multiline Size and Shape Control 
Click on the Multiline Object and move the mouse cursor to the end of the imaginary 

rectangle containing it, then a Left-Right arrow will appear.  Drag it to change the shape or 

size of the object. 

 

 
 

(2) Moving the Multiline Object 

Click on the multiline, and you will see a four-arrow cursor; move it to move the 

multiline. 
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(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the object's position by entering its coordinates. The X and Y value indicate the 

upper-left corner of a rectangle which would contain it. 

 

 Size 

The Width is the horizontal distance across, and the Height is the vertical distance. 

 

 

 

 

 

 

 

 

 

  

 Line 

Select the line style and thickness. 

 Fill 

Select the line color. 
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 Transparent Draw 

This makes the background transparent. 

 

 

8. Polygon 
 

1) Drawing a Polygon 

 
Select Polygon from the Draw menu, or click on the polygon icon in the 

Drawing Toolbar. The process is the same as drawing a similar object in a standard graphics 

program:  click on the starting point, hold the left mouse button down while you draw it, and 

then release it at the end point.  

 
 

2) Editing a Polygon 
 

(1) Polygon Size and Shape Control 
Click on the Polygon Object and move the mouse cursor to the end of the imaginary 

rectangle containing it, then a Left-Right arrow will appear.  Drag it to change the shape or 

size of the object. 
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(2) Moving the Polygon Object 

Click on the polygon, and you will see a four-arrow cursor; move it to move the object. 

 

 
 

(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 Position 

Set the object's position by entering its coordinates. The X and Y value indicate the 

upper-left corner of a rectangle which would contain it. 

 Size 

The Width is the horizontal distance across, and the Height is the vertical distance. 
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 Line 

Select border thickness and style. 

 Fill 

A. Select the border color. 

B. Select the fill color. 

 

 

 

 

 

 

 

 

 

 Transparent Draw 

This makes the background transparent. 

 

9. Text 
 

1) Writing Text 

 
Select Text from the Draw menu, or click on the text icon 

in the Drawing Toolbar. The process is the same as entering text in a standard graphics program:  

click on the location where you want to put the text, and a text-entry dialog box will appear.  

Enter the text in the dialog box. 
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2) Editing a Text 
 

(1) Text Object Size and Shape Control 
 

Click on the Text Object and move the mouse cursor to the end of the imaginary rectangle 

containing it, then a Left-Right arrow will appear.  Drag it to change the shape or size of the 

object. 

 

※ Text size changes by moving the Text object vertically. 

 

If you change the text size, it may become too large for the object. 

  

 
 

Click on either the left or right end of the Text Object, and drag it horizontally to display all 

of the Text. 

 

 
 

(2) Font  

Select Font Tool from the View menu. 
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1. Select the Font type. 

2. Select the Font size. 

3. Select Underline, Bold and Italic. 

4. Select the Alignment (Left,Center,Right). 

5. Select RTL language (Text is typed from right to left, as in Hebrew or Arabic)  

6. Select the column when displaying multiple strings. 

 

(3) Moving the Text Object. 

Click on the text object, and you will see a four-arrow cursor; move it to move the object. 

 
 

(4) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the object's position by entering its coordinates. The X and Y value indicate the 

upper-left corner of a rectangle which would contain it. 

 

 Size 

The Width is the horizontal distance across, and the Height is the vertical distance. 

 

 

 

 

 

 

 

 

 Line 

Not applicable 

 Fill 
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A. Select the text color. 

B. Select the fill color. 

 

 

 

 

 

 

 

 

 

 

 Transparent Draw 

This makes the background transparent. 

 
10.  Dynamic Tag 

 
1) Drawing Dynamic Tag 

 
Select Dynamic Tag from the Draw menu, or click on the Tag icon 

in the Drawing Toolbar. Click on the location where you want to put the tag, then select the tag 

from the list. 
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(1) Display Tag Value by Real Address. 

The tag value will be displayed by using its Real Address. Tag selection is not needed when 

using the Real Address. Select the Addr feature, and click on […] to open the Input Device 

Address dialog box. Select the data type (Digital, Analog, String), and enter the Device 

Address. 

 

A. Select Data Type and Device Address 

Choose Addr (Real Address), and select the Data type and I/O Device. Click on […] to 

bring up the Input Device Address dialog box. 

 

 

 

 

 

 

 

 

 

B. Input Device Address Dialog Box 
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i. Data Type: Select a Digital/Analog/String type. The detailed Option dialog box 

selections will depend on the type that you select. 

ii. I/O Device: Display all devices in the system. 

iii. Device Type: Device types are listed by I/O Device and Data type. 

iv. Address: Enter the Device Address. An error message will appear if the input 

value is out of range. 

v. Entry Key: You can click on the entry keys to enter the device address. 

vi. Clear: Delete the contents of the Address field. 

vii. Option: Bring up the detailed Option dialog box. 

 

C. Analog Tag Options 

 

 

 

 

 

 

 

 

 

i. Data Type  

- Select the Analog data type (UINT8, UINT16, UINT32, INT8, INT16, INT32, UBCD8, 

UBCD16, UBCD32, BCD8, BCD16, BCD32, or Float). 

ii.Raw Data / Internal (Xpanel) Data 

- PLC raw data will be scaled or changed to Xpanel Data for screen display.  

Ex) If the PLC takes analog input with a range of 0~16000, Xpanel will display PLC 

data using a range of 0~100. 
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iii. SCALE configuration 

The SCALE feature scales PLC data for Xpanel display. 

 Ex) If the PLC raw data is 256, Xpanel divides 256 by 10 and displays it as 25.6. 
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(2) Display Tag value by Tag 

To display a Tag value using a Tag from the Database. Select a Tag name, and click on […] to 

bring up the Database dialog box. 

 

 

 

 

 

 

 

 

 

 

Select the desired Tag, then click on OK. 

 

2) Editing Dynamic Tag 
 

(1) Size and Shape Control  
 

Click on the Dynamic Tag Object and move the mouse cursor to the end of the imaginary 

rectangle containing it, then a Left-Right arrow will appear.  Drag it to change the shape or 

size of the object. 
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(2) Moving the Dynamic Tag 

Click on the Dynamic Tag Object, and you will see a four-arrow cursor; move it to move 

the multiline. 

 

 
  

(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the object's position by entering its coordinates. The X and Y value indicate the 

upper-left corner of a rectangle which would contain it. 

 

 Size 

The Width is the horizontal distance across, and the Height is the vertical distance. 

 

 

 

 

 

 

 

 

  

 Line 

Not applicable. 

 

 Fill 
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A. Select the text color. 

B. Select the fill color. 

 

 
 

 Transparent Draw 

This makes the background transparent. 

 

 

11. Date/Time 
 

1) Drawing Date/Time Object 

 
Select Date/Time from the Draw menu, or click on the Date/Time icon 

in the Drawing Toolbar. Click on the location where you want to put the Date/Time Object. 

 

 
1) yy/mm/dd : Display the Date in ‘year/month/day’ format. 

2) hh/mm/ss : Display the Time in ‘hour/min/sec’ format. 

3) yy/mm/dd hh/mm/ss : Display the Date & Time in ‘year/month/day hour/min/sec’ 

format. 
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※ The Time & Date display os based on Windows information from Xpanel itself. 

※ You can create a different Time & Date format using Scripts and Functions (“NumToStr”, 

“GetTime”) 

 

 Ex) Display the Date format as dd/mm/yy using a Script and the String Tag (DATE). 

 

In the Script,  

 

DATE = NumToStr(GetTime(3),_UINT_,"02") + "/" + NumToStr(GetTime(2),_UINT_,"02") 

+ "/" +NumToStr(GetTime(1),_UINT_,"04"); 

 

 
 

2) Editing a Date/Time Object 

 

(1) Size and Shape Control  

Click on the Date/Time Object and move the mouse cursor to the end of the imaginary 

rectangle containing it, then a Left-Right arrow will appear.  Drag it to change the shape or 

size of the object. 

 

※ Text size changes by moving the Date/Time object vertically. 

 

If you change the text size, it may become too large for the object. 

 

 
 

Click on either the left or right end of the Date/Time Object, and drag it horizontally to display 

all of the Text. 
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(2) Font  

Select Font Tool from the View menu, and select the font and size. 

 

 
 

(3) Moving the Date/Time Object. 

Click on the Date/Time Object, and you will see a four-arrow cursor; move it to move the 

object. 

 

 
 

(4) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the object's position by entering its coordinates. The X and Y value indicate the 

upper-left corner of a rectangle which would contain it. 

 

 Size 

The Width is the horizontal distance across, and the Height is the vertical distance. 

 

 

 

 

 

 

 Line 
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Not applicable. 

 Fill 

A. Select the text color. 

B. Select the fill color. 

 Transparent Draw 

This makes the background transparent. 

 

 

 

 

 

 

 

 

 

 
 

12. String Value 
 

1) Drawing String Value Object 

 
Select String Value from the Draw menu, or click on the String Value 

icon in the Drawing Toolbar. Click on the location where you want to put the String Value Object. 
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(1) Addr: Enter the string by Real Address. 

(2) Tag: Use a String Tag from the Database. 

(3) String Group: Select a String Group. 

 

2) Editing a String Value Object 

 

(1) Size and Shape Control  

Click on the String Value Object and move the mouse cursor to the end of the imaginary 

rectangle containing it, then a Left-Right arrow will appear.  Drag it to change the shape or 

size of the object. 

 

 
 

※ Text size changes by moving the String Value object vertically. 

If you change the text size, it may become too large for the object. 

Click on either the left or right end of the String Value Object, and drag it horizontally to 

display all of the Text. 

(2) Font  

Select Font Tool from the View menu, and select the font and size. 

 

 
(3) Moving the String Value Object. 

Click on the String Value Object, and you will see a four-arrow cursor; move it to move the 

object. 
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(4) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the object's position by entering its coordinates. The X and Y value indicate the 

upper-left corner of a rectangle which would contain it. 

 

 Size 

The Width is the horizontal distance across, and the Height is the vertical distance. 

  

 Line 

Not applicable. 

 Fill 

A. Select the text color. 

B. Select the fill color. 
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 Transparent Draw 

This makes the background transparent. 

 

13. Multi Language String 
 

1) Drawing MultiString Object 
 

※ To use a Multi-Language String, you must already have set up the Multi Language 

Table.   
(See Chapter 19, Multiple Language for detailed information) 

 

Select Multi Language String from the Draw menu, or click on the 

Multi Language String icon in the Drawing Toolbar. Click on the location where you want to put 

the Multi Language String. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

1) String Group: Select the desired String Group. 

2) String Value: Select the desired String Value in the String Group. 

3) Preview: Display the selected String. 
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2) Editing the Multi Language String Object 

 

(1) Size and Shape Control  

Click on the Multi Language String Object and move the mouse cursor to the end of the 

imaginary rectangle conatining it, then Left-Right arrow will appear.  Drag it to change the 

shape or size of the object. 

 

 
 

※ The Vertical Object control changes both the Text and Object size. Click on either the left or 

right end of the Multi Language String Object, and drag it horizontally to display all of the Text. 

Because the String size is undefined, you will need to control the Multi String Object size using 

the Max. String length in the String Table. 

 

(2) Moving the Multi Language String Object. 

Click on the Multi Language String Object, and you will see a four-arrow cursor; move it to 

move the object. 

 

 
 

 

(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 
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 Position 

Set the object's position by entering its coordinates. The X and Y value indicate the 

upper-left corner of a rectangle which would contain it. 

 

 Size 

The Width is the horizontal distance across, and the Height is the vertical distance. 

 

 

 

 

 

 

 

 Line 

Not applicable. 

 Fill 

A. Select the text color. 

B. Select the fill color. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Transparent Draw 

This makes the background transparent. 
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(4) String Modification 

To modify a string, select String Editor from the Tool Menu. 

 

(5) Language Modification 

To modify the language setup, select Multi language Setup from the Tool Menu. 

 

 

14.  Key Input Window 
 

1) Where to use the Key Input Window 
The Key Input Window takes a Number or String as input when using a Keyboard. Input 
can be from either a real Keyboard connected to Xpanel or a Soft (Virtual) Keyboard. 
 

2) Applicable Tag Types 

 Digital/Analog Tag: Both Tag types take numbers as Input. 

 String Tag: The String Tag takes Strings as Input. 

 

3) Drawing Key Input Window 

 

Select Key Input Window from the Draw menu, or click on the Key Input 

Window icon in the Drawing Toolbar. Click on the location where you want to put the Key Input 

Window. 
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(1) Input Tag/Address: Select a Tag or Address to take input from the Key Input Window. 

(2) Action on Input: When Key input is complete, execute a Command Expression. 

(3) Option 

 

A. Display Digit: Enter the maximum number of digits.  0 = unlimited. 

B. End-Code(Hexa : Enter the hexadecimal code for ending Key Input.  The Default, 

‘OD’, is the ‘Enter’ key (see the ASCII Code Table for more information). 

C. Password Character: Key input will be displayed as an asterisk.  

D. Show Keyboard on Double Click : 

A double-click in the Key Input Window will bring up the Soft (Virtual) Keyboard.  

The Command Expression “Softkeyboard()” will also bring up the Soft keyboard. 

See Scripts for more detailed information. 

 

 
<Soft keyboard> 

 

E. Clear Window By Overflow: 

If the data input exceeds the Maximum Digit length, earlier input will be deleted 

as the new input is entered. 

 

(4) Using Max/Min Value 

- Set the Max/Min Analog Input values. 

 

(5) End-Code Action 

A. Cancel Select   

- This causes the mouse cursor to disappear from the Key Input Window. To 

enter Key Input again, click on the Key Input Window. 

B. Delete Content   

- When Key Input is entered, the previous content will be deleted. 

C. Move To Next Input  

- When using a multiple Key Input Window, the mouse cursor moves to the 

next Key Input Window after the first key Input is entered. 
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4) Editing the Key Input Window 
 

(1) Size and Shape Control  

Click on the Key Input Window Object and move the mouse cursor to the end of the 

imaginary rectangle containing it, then a Left-Right arrow will appear.  Drag it to change the 

shape or size of the object. 

 

 
 

※ For the Key Input Window, the Font size does not change along with the Object size change. 

To change the Font size in the Key Input Window, use the Font Tool. 

 

 
 

 

(2) Moving the Key Input Window Object. 

Click on the Key input Window Object, and you will see a four-arrow cursor; move it to move 

the object. 

 

 
 

 

(3) Position/Size & Line/Fill 

Not Applicable. 
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15.  Library 
 

1) Displaying Library Object 
 

Select Library from the Draw menu, or click on the Library icon in the 

Drawing Toolbar. 

The Library Dialog box will appear. Select the desired Object, and double click to draw it in the 

center of the Page.  

 

 
 

2) Editing Library Object 

(1) Size and Shape Control  

Click on the Library Object and move the mouse cursor to the end of the imaginary rectangle 

containing it, then a Left-Right arrow will appear.  Drag it to change the shape or size of the 

object. 
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(2) Moving the Library Object. 

Click on the Library Object, and you will see a four-arrow cursor; move it to move the 

object. 

 

 
  

(3) Position/Size & Line/Fill 

 

※The Reference Coordinate is in the upper left corner of the Page (X=0,Y= 0). 

 

 Position 

Set the object's position by entering its coordinates. The X and Y value indicate the 

upper-left corner of a rectangle which would contain it. 

 

 Size 

The Width is the horizontal distance across, and the Height is the vertical distance. 
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 Line 

Not applicable. 

 Fill 

Not applicable. 

 Transparent Draw 

This makes the background transparent. 

 

※ Library objects are Bitmaps. The user cannot change the Pen or Fill color. 
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Chapter 6.  How to Edit Pages or Screens 
 

1.  Page Editing 

 

1) Copy Object  

To copy an object, select it, then select Copy from the Edit menu or press Ctrl + C, or press 

Ctrl, then drag the object. 

 

 
 

 

2) Paste object  

To paste a copied object, use Paste from the Edit menu, or Ctrl + V. 
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3) Undo  

Undo the last change. 

Select Undo from the Edit menu, or press Ctrl + Z. 

 

4) Redo  

Reverse the Undo operation. 

Select Redo from the Edit menu, or press Ctrl + Y. 

 

5) Cut  

Remove an Object and copy it to the Clipboard. 

Select Cut from the Edit menu, or press Ctrl + X. 

 

6) Delete  

Remove an Object from the page. 

Select Delete from the Edit menu, or press Delete. 

 

7) Select All  

Select all objects on the page. 

Select “Select All” from the Edit menu, or press Ctrl + A. 

 

 
 

8) Find (Ctrl+F) 

Search for String Tag in  the Page or Database. 

Select Find from the Edit menu, or press Ctrl + F. 
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(1) Search for a String in the Active Page or in All Pages 

 

 Activate Page: Search for a String in the current active Page. 

 Selected Object: Search for a String in the selected object. 

 All Project Page: Search for a String in all Pages in the Project. 

 

 
 

 

(2) Search for a String in the Database 

Search for a String in the Database (Tag name, I/O device, Description and Address are 

included). 
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If the String is found, the corresponding Tag is automatically selected in the Database. 

 

 All in the Database:  Search for a String in all Tags. 

 Current Group:  Search for a String in the current group. 

 Selection:  Search for a String only in the selected Tags. 

 

 

9) Replace (Ctrl+H) 

Search for a String and Replace it with another String, either in the Page or Database. In a 

Database, this is useful for replacing a Virtual Tag with a Real Tag or vice versa. 

Select Replace from the Edit menu, or press Ctrl + H in the Page or Database. 

 

(1) Replace in the Database 

 
< Replace in the Database> 
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A. Find What  

Enter the target String. 

 

B. Replace With 

Enter the replacement String. 

 

C. Find by Item (in the Database) 

 

 
 

(2) Replace in a Page  

 

A. Active Page 

Search for a String and replace it in the current active Page. 

 

EX) To replace Button1~Button3 with Switch1~Switch3, enter ‘Button’ in ‘Find String’, 

enter ‘Switch’ in ‘Replace String’, then click on “All Replace” 

 
<All Object / All Replace> 
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B. All Project Page 

Search for and replace a string in all pages, including closed pages. 

 

C. Selected Object 

Search for and replace a string in the selected object only.  

 

2.  Arrange 

 

1) Group  

Group multiple objects into a single object. Select the Objects, then select Group from the 

Arrange menu, or from the right-click menu. 

 

 
 

※Note for the Group Feature 

 

When objects are grouped, each object continues to have its existing properties (functions 

such as Visible, Blink, Touch and etc.). This means that if you set another property for the 

group Object as a whole, that function will not work properly. 

For example, if Object 1 has the Touch operation property “PageOpen A”, and if Object 1 

and Object 2 are grouped and given the Touch operation property “PageOpen B”, then page 

A will be still opened.   

 

2) Ungroup 

Separate a grouped Object back into individual Objects. Select the grouped object, then 

select Ungroup from the Arrange menu, or from the right-click menu. 
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Ungrouping returns the properties of each object to their previous status. 

 

 

3)  Regroup 

Select previously grouped objects, then select Regroup from the Arrange menu, or from the 

right-click menu. 

 
 

Regrouping returns the properties of the group object to their previous status. 

 

4) Bring to Front 

Bring the selected object in front of other objects. 

Select object, then select Bring to Front from the Arrange menu, or from the right-click 

menu, or select the Bring to Front icon from the toolbar 
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5) Send to Back 

Send the selected object to the back of other objects. 

Select object, then select Send To Back from the Arrange menu, or from the right-click 

menu, or select the Send To Back icon from the toolbar 

 

 
 

 

6) One Step Forward 

Send the selected object one step forward when objects overlap each other. 

Select object, then select One Step Forward from the Arrange menu, or from the right-click 

menu, or select the One Step Forward icon from the toolbar 
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7) One Step Backward 

Send the selected object one step backward when objects overlap each other. 

Select object, then select One Step Backward from the Arrange menu, or from the right-

click menu, or select the One Step Backward icon from the toolbar 

 

 

 

 
 

 

8) Rotate 

To rotate an Object 90° clockwise.  

Select the object, then select Rotate / 90° Rotate Clockwise from the Arrange menu. 
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<90?Rotate Clockwise> 

 

 

 
<90°Rotate Counterclockwise> 

 

 

9) Flip 

 

(1) Horizontal Flip 

Select the object, then select Flip / Horizontal from the Arrange menu. 
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(2) Vertical Flip 

Select the object, then select Flip / Vertical from the Arrange menu. 

 
 

10) Grid Config 

Use Gridlines when arranging Objects. When you create or move an Object, it will be 

aligned to the gridline automatically. The gridline is only visible in XpanelDesinger, but not 

in the XPANEL itself. 

Select Grid Config from the Arrange menu. 

 
 

(1) Enable Snap 

Snap objects to the gridlines when they move close to them.. 
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(2) Grid Shape 

 

 No: Gridlines are not displayed; objects will still be snapped to the grid. 

 Line: The grid is shown by solid lines. 

 Dot: The grid is shown by dots. 

 

(3) Color 

To select the color of Gridline. 

 

(4) Grid Interval 

Set the width and height of the gridline. 

 

(5) Display Grid Interval (1/Grid) 

Set the width and height of the grid display as a fraction of the actual grid interval. 

 

 

11) Align 

Align the selected objects. 

Select Align from the Arrange menu, or click on the Align icon.                                

 

 

 
 

 

Ex) Vertical  Center 
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12) Distribute Horizontally 

Evenly distribute the selected objects horizontally. 

Click the Horizontal Distribution Icon  

 

 

13) Distribute Vertically 

Evenly distribute the selected objects vertically. 

Click the Vertical Distribution Icon 
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Chapter 7.   Communication Configuration 
 

1. Communication Configuration 

 

1) I/O Devices 

Set up communication between Xpanel and other devices, users must create a New Device 

using the I/O Device menu option. All Drivers and Protocols are listed in I/O Device 

Configuration. 

 

Select I/O Devices from the Tools menu or click on the I/O icon.  

Select New Device. Select the Ethernet or Serial Device type, then enter the I/O Device 

name. 
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2) Serial Communication Configuration 

 

(1) Communication Port 

 
 

 Device Type: Select a Protocol. 

 Comm. Port 

Select a Serial Communication port for each Xpanel. The Port will vary depending on 

the Xpanel model. 

 

 XT04 XT07 XT08 XT10 XT12 XT15 

COM1 RS232 RS232 RS232 RS422/485 RS422/485 RS422/485 

COM2 RS422/485 RS422/485 RS422/485 RS232 RS232 RS232 

COM3 None None None RS232 RS232 RS232 

<Communication Port > 
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 Communication options 

 Baud Rate: 300 ~ 115200bps is supported. 

 Parity: Select the same Parity (None, Even, Odd) as the Device. 

 Data Bits: Select the same Data Bit setting (5,6,7,8) as the Device. 

 Stop Bit: Select the same Bit setting (1Bit or 2Bit) as the Device. 

 RTS/CTS: Select the proper signal control typefor the Device. 

 Comm. Type: Select the same Comm. type (RS232 or RS422/485) as the Device.  

Please check to see if the Xpanel Com Port supportsthe Comm. Type. 

 Retry Number: Set the number of retries for sending a frame when 

communication fails. 

 Time Out: The maximum time to wait with no response before assuming a 

communication failure. 

 Using Transmission Delay: TSet a delay time before sending data. 

 Initialize the Tx Frame When Timeout Occurs: Initialize the sending frame when 

a Time Out occurs.  

 

(2) Station 

 

 
 

 Station Name: Enter the station name for the I/O Device.  

 Station Type: Select the Device model or CPU which will be connected to Xpanel. 

 Station Number: Set the station number. 

 Options 

 16Bit Data Swap: Swap between the upper and lower Bytes in a Word. 

Ex) 0x1234 -> 0x3412 

 32Bit Data Swap: Swap between the upper and lower Words in a Double 

Word. 

Ex) 0x12345678 -> 0x56781234 
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 String Data Swap : Swap the Bytes of String Word Data (applies to limited 

Comm. Driver only) 

 Using CheckSum: Use a CheckSum in Comm. Protocol. 

 Comm. Error Message Pop Up:  Use a Pop-up message when a Comm. error 

occurs. 

 

 

 

 

 

 

 

 

 

 

(3) Ethernet Communication Configuration 

 

A. Communication Port 

 

 
 

 Device Type: Select the Comm. Protocol. 

 Protocol: Select UDP or TCP.  

 Network ID: Enter the Network ID, if required. 

 Node ID: Enter the Node ID, if required. 

 Time Out: The maximum time to wait with no response before assuming a 

communication failure. 

 Retry Number: Set the number of retries for sending a frame when communication 

fails. 
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 Initialize the Tx Frame When Timeout Occurs: Initialize the sending frame when a 

Time Out occurs. 

 

B. Station  

 

 
 

 Station Name: Enter the station name for the I/O Device.  

 Station Type: Select the Device model or CPU which will be connected to Xpanel. 

 Network ID: Enter the Network ID, if required. 

 Node ID: Enter the Node ID, if required. 

 Unit ID: Enter the Unit ID, if required. 

 IP Address: Enter the IP address for connecting to Xpanel. 

 Socket Port No. : Enter the socket port number of the device which will be 

connected to Xpanel.  

 Options 

 16Bit Data Swap: Swap between the upper and lower Bytes in a Word. 

Ex) 0x1234 -> 0x3412 

 32Bit Data Swap: Swap between the upper and lower Words in a Double 

Word. 

Ex) 0x12345678 -> 0x56781234 

 String Data Swap: Swap the Bytes of String Word Data (applies to limited 

Comm. Driver only) 

  Comm. Error Message Pop Up:  Use a Pop-up message when a Comm. error 

occurs. 
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 Fixed XPANEL Socket Port:  Use a Fixed socket port for Xpanel. 

 Xpanel Socket Port Number: If Fixed XPANEL Socket Port is checked, select the 

socket port number that Xpanel will send. 
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Chapter 8.   Database 
 

1.  Database outline 

 

1)  Database Concepts 

The Xpanel Database is used to manage Tags, which are in turn used to communicate with 

other devices.  

 

 
 

※ The Database supports two communication methods (Tag or Real Address).  

Using a Real Address allows communication to be established without Tags.  

 

 

2) Tags in the Database 

In general, Xpanel designates a Tag name for the Address of the Device which will be used 

for I/O, and saves the Tag in the Database. Xpanel will use tags for objects in the project. 

Users can also create Virtual Tags for their own purposes. 

 

 

3) Xpanel Communication  

Xpanel communicates with devices using the tags from the currently opened Page, so 

neither the number of tags in the project nor the number of pages affects communication 

speed.  The number of tags used by the current page, however, can affect communication 

speed. 

 

 

4)  Tags in the Database 

The Xpanel Database supports several types of Tags, for processing different types of data. 

 

 The Digital Tag has a Bit address value, with a status of 0 or 1.  

 Analog Tag data can be in Word or Double Word format.  

 The String Tag takes text input in consecutive Word Address format. 

 The Group Tag creates a Group folder in the Database. The user can save new tags in the 

folder   --   the Tag name will be in the format [Group name].[Tag name]. 
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2. Building a Tag Database  

 

1)  Create a New Tag 

 

Select Database from the Tools menu, or click on the Database icon.  

 

 

 
 

(1) General 

 

A. New Tag, Edit Tag : Create a New Tag or edit a Tag. When you click on the Icon, the Edit 

Tag Window will appear. 

B. Name: Enter the Tag name. Below are the rules for naming a Tag. 

 

 Special characters are not allowed, except “_”. 

 There must be no spaces between words. 

 Numbers can be used in Tag names, but not as the first character. 

 Tag names must be less than 50 characters. 

 If a Group Tag is used, the full Tag name is in the format Group name.Tag name. 

 

C. Type  

Select Digital, Analog or String. 

 

※ The Real String Tag type is not supported by some I/O Devices (See “Driver list for 

Supporting a String Tag”). 
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D. Real Tag, Virtual Tag  

 

 Real Tag: Xpanel will communicate with an actual I/O device and exchange data with 

it. 

 Virtual Tag:  Xpanel will read data from/write data to a space in memory. 

 

E. I/O Device, I/O Address  

This becomes available when you select “\Real Tag”\. Select the I/O device and enter the 

device Address.  

 I/O Device  

From the drop-down menu, Select an existing I/O 

Device from the list. 

※ SYSTEM MEMORY is an area of Xpanel memory used for scripts or recipes. 

 I/O Address  

Enter the Address which will be used by the Device. If you enter ‘D001’, the ‘00’ is 

automatically filtered out. As a result, both ‘D001’ and ‘D0001’ will be recognized as 

the same Address. 

 

F. Description  

Enter a description of the Tag. 

 

G. Save Last Status When Closing  

This is used by Virtual Tags only. The last Tag value is stored after Xpanel is turned 

off,then restored when Xpanel is turn ON. 

 

(2) Advanced 

 

A. Digital Tag  

The user can enter an Initial value for a Virtual Tag. 

 

B. Analog Tag 
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 Initial Value  

This is used for Virtual Tags only. The initial Value is set as the tag value when Xpanel 

starts.  

 Data Type 

In order to correctly display PLC data, the Xpanel Data type must be the same as the PLC 

data type. 

 

 Most Common Data Types 

 

Type Size Display Range 

UINT8 1 Byte 0 ~ 255 

UINT16 2 Byte(1Word) 0 ~ 65535 

UINT32 4 Byte(2Word) 0 ~ 4294967296 

INT8 1 Byte -128 ~ 127 

INT16 2 Byte(1Word) -32768 ~ 32767 

INT32 4 Byte(2Word) -2147483648 ~ 2147483647 

FLOAT 4 Byte(2Word) 
-3.40282346638529e+038 ~ 

3.40282346638529e+038 

 

 BCD Data Types (less frequently used) 

 

Type Size Display Range 

BCD8 1 Byte -79 ~ 79 

BCD16 2 Byte(1Word) -7999 ~ 7999 

BCD32 4 Byte(2Word) -79999999 ~ 79999999 

UBCD8 1 Byte 0 ~ 99 

UBCD16 2 Byte(1Word) 0 ~ 9999 

UBCD32 4 Byte(2Word) 0 ~ 99999999 

 

 CIMON (Engineering) Data/PLC (Raw) Data 

Set the display range for Xpanel (Engineering) Data, which is converted from PLC (raw) 

data. The Min. and Max. values of the PLC (raw) data are converted to the Min. and Max 

values of the Engineering (Xpanel) data. 

 

For example, the PLC takes an Analog input of 0~16000, and Xpanel displays data with 

the range of 0~100 (Note that the real data is not changed). 

 
< PLC (Raw data)  XPANEL (Eng. Data) > 

※ Scale/Offset and Max/Min value Conversion cannot both be applied at the same time.  
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 Scale & Offset 

For performing arithmetic operations on PLC data and displaying the results on the 

Xpanel screen. 

 

 
 

 

 
  

※ Scale/Offset and Max/Min value Conversion cannot both be applied at the same time. 

C. String Tag 

The initial Value can be set (Max 22); this applies to Virtual Tags only. 
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 Driver list for Supporting String Tags 

 

Device Name Communication Type 

KDT SYSTEMS CIMON-PLC Ethernet 

KDT SYSTEMS Xpanel Ethernet 

KDT SYSTEMS CIMON-PLC HMI Serial 

KDT SYSTEMS CIMON-PLC Loader Serial 

Allen Bradley DF1 Serial 

FUJI Micrex SX Ethernet 

LSIS Master-K S-Series Enet Ethernet 

LSIS Master-K S-Series PLC Cnet Serial 

LSIS XGT Series FEnet Ethernet 

LSIS XGT/XGB Series PLC Cnet Serial 

LSIS Inverter Starvert -Series Serial 

LSIS RFID Reader Serial 

MITSUBISHI MELSEC 1E Ethernet 

MITSUBISHI MELSEC 3E Ethernet 

MITSUBISHI MELSEC 3E(ASCII) Serial 

MITSUBISHI MELSEC 1C (AnA/AnU CPU) Serial 

MITSUBISHI MELSEC 1C (ACPU) Serial 

MITSUBISHI MELSEC FX Serial 

MITSUBISHI MELSEC-Q Loader(Q00/01) Serial 

MITSUBISHI MELSEC-Q Loader(Q02/06/12/25) Ethernet 

MODBUS TCP Ethernet 

MODBUS ASCII Protocol Serial 

MODBUS RTU Protocol Serial 

NTBank LT100A Serial 

SAIA S-BUS Serial 

SIEMENS S7 Ethernet  Ethernet 

SIEMENS S7 MPI Serial 

SIEMENS S7 PPI Direct Serial 
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Chapter 9.  Object Properties 

 

1.  Object Configuration 
 

How To Configure Objects 
 

Object Configuration sets Object properties, including Touch operations. When an Object is 

double-clicked, the Object Configuration window will appear. In the Database, Tags and Real 

Addresses are used to store object data. 

 

  Tag Name 

 To open a tag for use, click on the  button, then select the Tag. 

 

 

 
 

  Real Address 

You can enter the PLC Address directly into the Xpanel Database directly, rather than using a tag. 
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※ Either Tags or Real Addresses produce the same results. 

 
(1)  Visible 

Display or hide the Object, based on the condition. 

This operation is controlled by a Digital Tag.  

 When the condition is ON and the Tag value is 1 (ON), the Object is displayed on the 

Screen.  

 When the Condition is ON and the Tag value is 0 (OFF), the Object is not displayed. 
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Click on the Visible option button in the Object Config dialog box, then select the tag 

and set the Visible Condition.  

 

 
<At Visible Condition is ON> 

 

 

(2)  Blink 

The Object blinks, based on the condition. 

This operation is controlled by a Digital Tag.  

 When the condition is ON and the Tag value is 1 (ON), the Object blinks.  

 When the Condition is ON and the Tag value is 0 (OFF), the Object does not blink. 

 

 
 

 

Click on the Blink option button in the Object Config dialog box, then select the tag and 

set the Blink Condition.  The blink Interval unit is 100 ms.  

 

Ex)  With the Interval set to 10, the Object blinks at a 1000 ms (1 sec) interval. 
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(3) V-Size(Vertical Size Change) 

 

A. Vertical Change 

The vertical size of the object changes, based on the Data value. 

 

 
 

Click on the V-Size option button in the Object Config dialog box, then select the tag and 

set the Max. and Min. Data Range values.  

When the Tag value is the minimum as set in the Data Range, the Object will be 

displayed at its minimum size. When the tag value is at the maximum, it will be 

displayed at its maximum size.  Between the minimum and the maximum, its size will 

change proportionally. 

 

 
<Base Position = Bottom> 
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 B. Base Position 

You must set the base position for vertical size change. With the Bottom as the Base 

Position, the Object becomes taller as its tag value increases. 

 

(4) H-Size (Horizontal Size Change) 

 

A. Horizontal Change 

The horizontal size of the object changes, based on the Data value. 

  
 

Click on the H-Size option button in the Object Config dialog box, then select the tag and 

set the Max. and Min. Data Range values.  

When the Tag value is the minimum as set in the Data Range, the Object will be 

displayed at its minimum size. When the tag value is at the maximum, it will be 

displayed at its maximum size.  Between the minimum and the maximum, its size will 

change proportionally. 
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 B. Base Position 

 

You must set the base position for horizontal size change. With the left as the Base 

Position, the Object grows toward the right as its tag value increases. 

  

(5) V-Move (Vertical Move) 
 

A. Feature 

Move the object up or down based on the Data value. 

 

 Base Position 

The Base Position can be set to either the Top or Bottom. 

 

 Distance 

The distance is set in Pixels (Units). A distance of ‘100’ moves the Object by 100 

Pixels on the Xpanel Screen, based on the Xpanel Screen Resolution. If the 

Object moves out of the display range, it will disappear form the screen.  

 

 

 

 

 

 

 

 

 

 

 

 

< Resolution and Coordinates of XT 10> 

 
B. Vertical Move 

Click on the V-Move option button in the Object Config dialog box, then select the tag 

and set the Max. and Min. Data Range values. 
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When the Tag value is the minimum as set in the Data Range, the Object will be in its 

original position (the Base Position). When the tag value is at the maximum, it will move 

the maximum Distance in Pixels. 

 

(6) H-Move (Horizontal Move) 

 

A. Feature 

Move the object left or right based on the Data value. 
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 Base Position 

The Base Position can be set to either the Left or Right. 

 

 Distance 

The distance is set in Pixels (Units). A distance of ‘100’ moves the Object by 100 

Pixels on the Xpanel Screen, based on the Xpanel Screen Resolution. If the 

Object moves out of the display range, it will disappear from the screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

B. Horizontal Move 

Click on the H-Move option button in the Object Config dialog box, then select the tag 

and set the Max. and Min. Data Range values. 
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When the Tag value is the minimum as set in the Data Range, the Object will be in its 

original position (the Base Position). When the tag value is at the maximum, it will move 

the maximum Distance in Pixels. 

 

(7)   Color 

An Object's Color can be changed based on tag data value. Click on the Color option button 

in the Object Config dialog box, then select the tag. Enter up to eight increasing tag values, 

and assign a color to each. For example, Color 1 < Color2 < Color3…. 

 

 
 
(8) Rotate 

 The object will rotate based on the Analog Tag value. 
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  A. Rotate 

   

 Max. Rotate Angle 

Enter the maximum rotation angle for the Object. 

 Rotate Direction 

Enter the rotation direction: CW (Clock-wise) or CCW (Counter Clock-wise). 

 Center Point 

Set the center point for rotation. 

   

To set the rotation Center Point, select Position/Size from the Style menu, and note the object's 

Position and Size. For example, if the Position is (60,122) and Object's size is (L:68, W:8), the 

user defined Center Point might be ( 60+68, 122+4)   (128,126). 

  

※ The X and Y coordinate values of the Position indicate the left-upper vertex of an imaginary 

rectangle containing the Object. 

 
B.  Rotation 
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 Tag Name / Address 

The Tag or Address providing the data used to control the rotation angle. 

 

   Data Range 

Enter the Data Range values.  At the maximum value, the object will have rotated to its 

maximum angle, as set in Rotate. 

 

 

   

 

 

 

(9) Touch 
 

This sets all Xpanel touch functions except EntryData (for entering Analog Data). 

 

●  Action Script 

  

 Operation 

 Xpanel supports 8 Touch operations. 

  

Operation Description 

Open Page Open a page. 

Close Page Close a Pop-up or Keypad page. 

Write Tag Value Write a pre-set value into a Tag when the Object is touched. 

Write Digital Value Write 1 or 0 into a Tag when the object is touched.  

Write Momentary Write in a pre-set value when the object is touched, and reset 

when the touch is released. 

Command Expression Use Script Commands. 

Key Input Execute a Key Input. 

Open Keypad Page Open a Keypad page. 

 

 Condition 

 The User sets the condition for executing an operation when the Xpanel screen is 

touched.  

Logical Comparison Operations are used to set the conditions. 

Ex1) Comparison Operation  

Execute “Write Digital value” operation when “Bit1” Tag = 1. 
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Comparison Operators can be used to set Conditions. Instructions for using Conditions 

are given below. 

   

   
 

※ Applicable Comparison Operator 

 

Comparison Operator Description Example 

== Equal A == B 

>= or => Bigger or Equal A >= B 

> Bigger A > B 

<= or =< Smaller or Equal A <= B 

< Smaller A < B 

!= Different A != B 

 

  Ex2) Both Comparison and Logical Operation  

When “Bit” Tag = 1 and “WORD0” Tag > 1000, execute the “OpenPage” Operation. 

(BIT0 == 1) && (WORD0 > 1000) 
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※ Applicable Logical Operators 

 

Logical Operator Description Example 

&& And A && B 

|| Or A || B 

! Reverse !A 

 

A. Open Page 

Move from one page to another. This closes the currently opened page automatically, 

and opens a new page. 

 

 
 

Click on the Touch button, select Open Page as the Action, then enter a Page Name and 

extension. 

You can also click on the button, then select a page. 

 

 

  

 

 

 

 

 

      <Current Page>                                                           <New Page> 
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B.  Close Page 

Close the current page.  This is generally used for  Pop-up and Keypad pages.  Normal 

pages usually close automatically when Open Page”is executed. 

 

 

 
 

Click on the Touch button, select Close Page as the Action, then enter a Page Name and 

extension. 

You can also click on the button, then select a page. 

 

   

C.  Write Tag Value 

  Write a preset Analog data value to an Analog Tag using a Touch operation. 
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Click on the Touch button, select Write Tag Value as the Action, then enter a Tag Name 

or Address. 

You can also click on the button, then select a tag. 

 

In the Value field, enter the value that will be written to the tag as a result of the touc 

operation. 

 

 

 

 

 

 

                     <Before the Touch Operation>                                             <After the Touch Operation> 

 

D.  Write Digital Value  

  Write a value of 0 or 1 to a Digital Tag using a Touch operation. 

 

 
Click on the Touch button, select Write Digital Value as the Action, then enter a Tag 

Name or Address. 

You can also click on the button, then select a tag. 

 

 Set 

Write a Digital Value of ‘1’(ON). 
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 Reset 

Write a Digital Value of ‘0’(OFF). 

 

 Toggle 

Change the Digital Tag or Address value. That is, the value changes from 10 or 01 as 

a result of the Touch operation. 

 

E. Write Momentary 

Write a value when the Object is touched, then return it to the original status when the 

Touch operation is released. 

 

  
 

Click on the Touch button, select Write Momentary as the Action, then enter a Tag 

Name or Address. 

You can also click on the button, then select a tag. 

 

 

  Down – Written Value 

The value to be written to the tag when the object is touched. 

 

 Up – Written Value 

The value to be written to the tag when the object is released. 
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F.  Command Expression 

Execute a simple Script Command as the result of a Touch operation. Command 

expression use is described below. 

 

 Xpanel commands include simple Operational and Conditional Scripts based 

on the C-Language. 

 Command Expressions are not Case-sensitive. 

 Basic Script command can be used 

 Xpanel can call a pre-written Script. 

 

 

Command Expressions have the highest priority in operation; other Object operations 

will wait until the Command Expression is finished. A Command Expression also can call  

a Script, which will have the same priority as the Command Expression. 

 

A Simple Script created using Command Expressions can be called; it will create a new 

independent process. This process will operate separately from the current Command 

Expression. The Runscript command is used to call a Script, as shown below: 

 

 ‘Runscript [Script Name]();’ 

 

  Examples of Command Expressions 

 

Example Description 

Runscript SupplyCount(); Call the script “SupplyCount”. 

WORD0 = 100; Change the ‘WORD0’Tag value to 100. 

WORD0 = 100; 

PageOpen(“Main”); 

Change the ‘WORD0’Tag value to 100, and 

Open a page named ‘Main’. 

WORD0 = WORD0 + 1; Increase value of the ‘WORD0’Tag by 1. 

WORD0 = 100; 

BIT0 = 1; 

RunScript SupplyCount(); 

WORD1 = 200; 

To change the ‘WORD0’Tag value ito 100, and change the 

‘BIT0’Tag value ito 1. 

Then run the ‘SupplyCount()’ Script. 

Whether or not the ‘SupplyCount()’ Script is finished, change the 

‘WORD1’ value to 200. 

※A script called using the ‘Runscript’ feature runs separately 

from the Command Expression. 
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G.  Key Input 

Create a Keyboard button for entering a number or character using a touch operation. 

83 Keyboard buttons are supported.  

Click on the Touch button, select Key Input as the Action, then select the Key type. Key 

types are the same as on a keyboard 

Key Input cannot be used alone; it must be used with Key Input Window.  

 

 
<Key Input in the Database> 

 
<Key Input Window in the Draw Menu> 
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<Key Input Example> 

 

When the focus is on the key Input Window, a character will be entered if the user 

clicks on the Key button. 

 

H.  Open Keypad Page 

Open a Keypad page. 

Without using EntryData to enter Analog data, the user can create a Data Entry window.  

A keypad page must be opened using the Keypad Page Action. 

 

 
 

Click on the Touch button, select Open Keypad Page as the Action. 
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  Tag Name or Address 

 Enter the Tag or Address which will receive input from the Keypad. 

 H Scale/V Scale 

Set the location of the Keypad page. Based on the resolution of the Xpanel 

model. 

 Max/Min 

Set the Maximum or Minimum input values.  

 Page Name 

Enter the Keypad Page name. Click on the button to bring up the page 

list. 

 
 

I.  Security 

Security controls access to Touch Operations. Security Levels are from 0 ~10. Level 10 is 

the highest. If the user's Security Level is lower than the Security Level of the Touch 

operation, the Touch operation is not executed. 

(Please see Chapter. 18, Security) 
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Click on the Touch button, select Security as the Action.  Level 0 is the lowest, and Level 

10 is the highest security. The default Security Level is 0. 

 

 

 

 

  

 

 

 

 

   < When the user's security level is low> 

 

J.   Data Entry 

Enter Data in a Word Address. There are two types of word address data: Analog 

numeric and String data. The keypad is used to enter numeric data. The string keypad is 

used to enter a string. 

 

   Analog Data Entry 

To enter Analog data, click on the EntryData button, select Numeric as the 

Action. 

 

 
  

a.  Action: Numeric 

 Enter Analog data, rather than String data. 
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b.  Numeric DataEntry 

 Select the Tag or Address for Data Entry. 

  

c.  Max/Min 

 Set the Max. and Min. value for Data Entry 

 

d.     Display Type 

 ● Window Style 1 (7”) : Create a keypad window for a 7” screen. 

 ● Window Style 2 (10”) : Create a keypad window for a 10” screen. 

● Window Style 3 (4”) : Create a keypad window for a 4” screen. 

 

e.  Title / Comment 

Enter a Title and Comment to be displayed in the Keypad window. 

 

 

 

 

 

                                                                          

 

 

                             <Window Style 1> 

 

f.  Position Offset 

Enter the coordinates where the Data Entry window will be located on the 

screen. 

 

  String Data Entry 

  To enter String data, click on the EntryData button, select Text as the Action. 

a.  Action: Text 

  Enter String data, rather than Analog data. 

 

b.  String Data Entry 

 Select the Tag or Address for Data Entry. 
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c.  Password 

 To protect password input, it will be displayed as [•••••]. 

 

d. Display Type 

● Window Style 1 (7”) : Create a string entry window for a 7” screen. 

● Window Style 2 (10”) : Create a string entry window for a 10” screen. 

● Window Style 3 (4”) : Create a string entry window for a 4” screen. 

 

e. Title / Comment 

Enter a Title and Comment to be displayed in the string entry window. 

 

  

 

 

 

 

 

 

<Window Style 2> 

f.  Position Offset 

Enter the coordinates where the Data Entry window will be located on the 

screen. 
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Chapter 10.  Project Download 

 

1.  Downloading a Project 

 

Xpanel supports three methods of downloading a project. 

 

 1. USB Cables 

 2. Ethernet 

 3. USB/SD Portable Storage Devices 

 

1) Download a Project From a PC to Xpanel using a USB Cable 

 

(1) Requirements for Downloading 

A USB-Mini(B) type cable is required. To use a USB cable, Xpanel must be synchronized with 

the PC. Either ActiveSync or the Mobile Device Center must be used for synchronization, 

depending on the version of Windows being used. 

 

USB Cable Type Environment Requirement 

USB-Mini(B) 

Windows XP  ActiveSync  

Windows 

Vista/Win7/Win8 

32 Bit : Mobile Device Center 32bit 

64 Bit : Mobile Device Center 64bit 

※ ActiveSync and Mobile Device Center can be downloaded from Microsoft. 

(www.microsoft.com) 

 

 

http://www.microsoft.com/
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(2) Connecting To Xpanel from Windows XP  

 

A. Install the latest XpanelDesigner (available from the CIMON web site). 

B. Download ActiveSync, from Microsoft and install it. 

C. After installing ActiveSync, connect a USB cable to Xpanel. Select No in the New 

Hardware Search Wizard. 

 
 

D. Search for a Driver. Select Advanced. 

 
 

E. Default Installation Path for the Driver 

   

   ● Ver 2.31 : C\Xpanel\USB_Driver\XT04SyncDrv\ 

   ● Ver 2.30 or earlier :  C\ProgramFiles\Xpanel\USB_Driver\XT04SyncDrv\ 
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F.  Installation is Complete 

 

(3) Connecting to Xpanel from Window 7 

 

A. Install the latest XpanelDesigner (available from the CIMON web site). 

B. Download the Mobile Device Center, from Microsoft and install it. 

C. After installation, connect a USB cable to Xpanel. 

D. With an Internet connection, the Device Manager will synchronize with Xpanel 

automatically (Internet access is required). 

E. Installation is complete. 

 

 
< Windows Mobile Device Center> 
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2)  Download a Project From XpanelDesigner to Xpanel By USB Cable 

  

(1)  Select a ConnectionType 

 Go to the Menu tab, and select [Online][Setup Link][USB]. 

 

 
 

(2) Convert To a Runtime Project 

For USB, select [Online][Download To Xpanel]. When the Converting To Runtime Project 

dialog appears, click on YES. 

  

 
 

(3)  Download a Project from XpanelDesigner (PC) To Xpanel 

 

A.  First Time Download  

 

 
  For the initial download, the download dialog box will appear, as shown above. 
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   RunTime Project Size 

  Display the size of the project download in Bytes. 

   

Model Max. Project Size  Built in Flash Size 

XT04CD/XT07CD/HP07CD/XT08CD Up to 80 MB  128 MB 

XT10CD/XT12CD/XT15/CD Up to 50 MB  128 MB 

※The Max. project size  may be lower if Xpanel's internal memory is being used 

by other operations, such as a Screen Capture. Additionally, an OS or 

XpanelDesigner version upgrade can reduce Xpanel's Internal memory. Flash 

memory size can be modified by manufacturers for performance improvement 

without any official notice. 

 

 Font Data Size 

If the Download The Font File option is selected, the Font File size will be 

displayed. 

 

 Download The Editing Project 

The Editing project is required when uploading a project from Xpanel to the PC. 

With Download The Editing Project feature unchecked, uploading a project 

from Xpanel to the PC will not be possible. 

 

 Download The Font File 

The project's Text Font will be used by Xpanel. If the Download The Font File 

feature is unchecked, Text is displayed in Xpanel's default Font. The Default 

Font is Tahoma for Xpanel's Windows CE installation (English version) and ‘굴림’ 

for Windows CE (Korean version). 
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B. Redownload 

When a project is modified, then downloaded again, you can download only the 

modified part of the project in order to save time. 

 

 
 

 Full Download / Modification Download 

Select either Full project or modified part only. Using Modification Download 

will reduce the download time. 

 

 Downloading Data Size 

The Downloading Data Size will be displayed. 

 

 Font Data Size 

If the Download The Font File option is selected, the Font File size will be 

displayed. 

 

 Connected Xpanel Info 

The Xpanel IP address is displayed. 

 

 (4) Project Download Process 

 The steps of the project download process are as follows: 

 

  A.  The existing project in Xpanel is deleted, and the new project downloaded.  

B.  Check the Xpanel Application Program version, and install the current version if the 

installed version is older. 
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 (5) Run the  Xpanel Application Program 

 After downloading is completed, the Xpanel  Application Program will be executed. 

 

 
  

Rather than running the Xpanel  Application Program immediately, the user can double-click on 

the Xpanel icon on the Xpanel Desktop in order to run it. 

 

 

3)  Download Project By Ethernet 

 

Projects can also be downloaded to Xpanel by Ethernet (the Xpanel Ethernet option required). 

The Ethernet Loader (a built-in program) is used for downloading by Ethernet. The Ethernet 

Loader must be running throughout the download process.   If the Ethernet Loader is forced to 

quit, the download will be interrupted.  You will then have to either run the Ethernet Loader 

again, or restart Xpanel. 

 

 

(1)   Setting the Xpanel IP address 

 

A.  Using an Ethernet Loader 

 

a.  Terminate the Xpanel Application Program (Active Project) 
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If you touch the three corners of the Xpanel display in the order shown below, the 

Xpanel Config Dialog box will appear. Click on Exit to shut down the Xpanel Application 

Program and bring up the Desktop. 

  

 

b.  Checking the Ethernet Loader   

The Ethernet Loader should always be running. If the Ethernet Loader is forced to quit, 

the download will be interrupted.  if this happens, the Ethernet Loader must be started 

again.  To do this, go to [My Device]  [Xpanel], and click on “Eldr.exe”. 

 

c.  Apply the IP setting To Xpanel. 

Enter the Xpanel IP address, Subnet Mask and Gate Way then click on Apply this new 

setting to restart Xpanel (the modified setting will be applied only after restarting). 

 

 

 

 

 

 

 

 

 

 

 

 

B. Using Xpanel Config  

 

a.  Open the Xpanel Config Dialog box 

If you touch the three corners of the Xpanel display in the order shown below, the 

Xpanel Config Dialog box will appear.  Click on Comm Config to bring up the IP setting 

dialog box. 
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b.  Communication Setup 

Select Ethernet from the Drop-Down menu. Enter the IP address for Xpanel and click on 

OK to execute a System Shutdown. After the System Shutdown, the modified IP setting 

will be applied to Xpanel.  

 

 

 

 

 

 

 

 

 

 

 

 

(2)  Download a Project From XpanelDesigner By Ethernet 

 

A. Select a Connection Type 

  Select [Online]  [Setup Link][Ethernet]. 

 

 
B. Select and Search for Xpanel 

  Click on Select Xpanel to bring up the list of Xpanel IPs currently connected to the PC 

  (by Ethernet).  

 Select the desired Xpanel IP and click on OK. 
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  Refresh 

 Refresh the Xpanel IP list for a new selection. 

 

  Test 

 Test the selected Xpanel IP connection to see if it can be used for downloading. 

 

  Insert 

 Enter an Xpanel IP manually. 

 

  Delete 

 Delete the selected Xpanel IP from the list. 

 

※ Ethernet Connection Notes 

 If Auto is displayed in the Search field, the status of the target Xpanel is download-

ready (Local Network). 

 If Manual is displayed in the Search field, the target Xpanel is on a different 

Network from the PC. 

 If multiple XpanelDesigners are currently open, the PC might not find the target 

Xpanel. You should have only one XpanelDesigner open when connecting to Xpanel 

by Ethernet. 

    

C. Download To Xpanel 

  Select [Online] [Download To Xpanel]. 

The project is converted to an Editing Project, and the rest of the the download 

procedure is the same as it is for Download by USB Cable. 
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 (See Download by USB Cable for the detailed information about downloading) 

 

4) Download a Project To Xpanel using USB/SD/MMC 

 

(1) Preparing for USB/SD/MMC  

 

(2)  Download a project to a USB/SD/MMC Device. 

 

A.  Download a project into USB/SD/MMC memory. 

Select [Online]  [Copy Project to Removable Memory]. Convert the project to a Runtime 

Project. 

 

 
 

B.  Select the Target USB/SD/MMC Device 

Enter the location of the target USB/SD/MMC device; it must be in the Root Folder 

(Directory). Xpanel cannot recognize Subfolders (Subdirectories). 

Click on OK to download the project to Xpanel. 
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C.  Writing a project to a USB/SD/MMC Device 

 

D.  Plug the Portable Memory Device into Xpanel 

 

E.  Close Xpanel Application Program 

If you touch the three corners of the Xpanel display in the order shown below, the Xpanel 

Config Dialog box will appear. Click on Exit to shut down the Xpanel Application Program 

and bring up the Windows CE Desktop. 
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F.  Writing a Project into Xpanel by Ethernet Loader 

On the Windows CE Desktop, the Ethernet Loader will normally be running. The Ethernet 

Loader supports not only project Up/downloading via Ethernet, but also project 

Up/downloading via Removable Storage Device. 

 

 

 

 

 

 

 

 

 

 

  Select [Removable Storage  Xpanel] on the Ethernet Loader. 

 

 

2.  Uploading a Project from Xpanel To a PC 

 

Users can upload a project from a Xpanel to PC. Three types of uploading are supported. For a 

successful upload, the Download the Editing Project feature must have been enabled when 

previously downloading a project into Xpanel. 
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 3 Ways to Upload Project From Xpanel to a PC 

 

1. By USB mini port cable 

2. By Ethernet 

3. By USB/SD Removable Storage Device 

 

 

1)  Uploading a project While Xpanel is connected to a PC 

 

(1) Connection (Link) Type 

Either a USB mini cable or Ethernet can be used to connect Xpanel to a PC. 

(See Download Project for detailed information) 

 

(2) Upload a Project from Xpanel to a PC using XpanelDesigner 

Go to [Online]  [Upload From Xpanel(XpanelPC)]. 

 

 
 Source Folder : Select the project folder to upload from. The default location is Xpanel 

Main Memory. 

 Upload A Logged Data : The logged data can be uploaded with the project. 

 

(3) Select the Destination 

Next, select the location to upload to. When the upload is complete, the current project will 

be closed and the uploaded project will be opened. 
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2)  Uploading a Project by using a Removable Storage Device (XpanelPC). 

 

(1) Plug the USB/SD/MMC Device into Xpanel 

 

(2) Close the current Xpanel Application Program 

 

If you touch the three corners of the Xpanel display in the order shown below, the Xpanel 

Config Dialog box will appear. Click on Exit to shut down the Xpanel Application Program 

and bring up the Windows CE Desktop. 

 

 

 

 

 

 

 

 

 

(3) Copy the project from Xpanel to Removable Storage using the Ethernet Loader. 

Select [Removable Storage  Xpanel] in the Xpanel Ethernet Loader. 

 

 Select the desired Removable Storage device, then click on Project Upload. 

 Once uploading is complete, the Success to copy upload data message appears. 
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(4) Copy the project from Removable Storage to a PC 

 

After copying a project from Xpanel to Removable Storage, plug the device into the PC. 
In XpanelDesigner, go to [Online] [Upload From Storage(StoragePC)]. 
 

 
 

 Editing Project Path 

Set the project path for the Removable Storage device; it must be in the Root Folder 

(Directory). Xpanel cannot recognize Subfolders (Subdirectories). 

Ex) D:\, E:\, F:\ 

 

 Project List 

Select the desired project on the Removable Storage device. 
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(5) Choose the destination on the PC 

Next, select the location on the PC to upload to. 

 

 
 

 

3)  Executing a Project Directly from Removable Storage Device. 

 

Xpanel supports running a project directly from Removable Storage. This is useful when the 

Project is too large to download to Xpanel memory.  

 

※ A Project in Removable Storage Device has a higher priority than a project in Xpanel's 

internal memory. 

 

When Xpanel starts (is turned on), it scans for projects in Removable Storage Devices first. If no 

project file is found in any Removable Storage Device, then Xpanel will run the project in its 

internal memory. 

 

(1) Save a project to a Removable Storage Device 

Select [Online]  [Make Executing Removable Memory]. Select the target folder (Root 

path) where the project will be saved. 
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(2) Execute the project directly from Removable Storage Device 

Plug the Removable Storage Device into Xpanel, and then restart it. You can also close the 

currently running Xpanel Application program, then double click on the Xpanel Application 

program on the Desktop. 
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Chapter 11.  Useful Functions 

 
 

1.  Cross Reference 

 

This is used to search for Tags or Address by Page or Module. Users can find where a tag is used 

and move to that page to edit the Tag. Because Tag Batch Conversion is supported, the user can 

convert multiple Tags to different Tag formats all at once. Tag Search results can be saved as a 

CSV file, which can be opened in Excel.   

 

 
 

1) Subject / Classification 

 

 All: Search for all Tags in project. 

 Module: Search for Tags in functional modules of Xpanel. Select the module in 

“Classification”. 

 

2) Tag Search 

Search for a Tag by Tag name.  

 

3) Replace 

Use Tag Batch (multiple) Conversion to replace Tags. This applies to the whole project. 
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4) Conversion To CSV File 

Convert the Tag list in the Cross Reference window to a CSV file. 

 

2.  Project Workspace 

 

The Project Workspace is a convenient tool for configuring and editing project functions.  It 

displays project features in Tree view. Double-click on an item to configure it.  The changes will 

be reflected in the tree view after you save them. 

 

 
 

3.  Tag View Tool 

 

Display the Tag name or Address of an Object.The  Background and Font color can be changed. 

 

 
 

 BG color / Font color 

Change the background color or the font color of a Tag. 

 

 [N], [A], [X]  

 

[N] : Display the Tag name. 

[A] : Display the Address. 

[X] : No Tag name or Address is displayed. 
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4.  Object Window 

 

Display Object properties in the Tree view. If the user clicks on a function, the corresponding 

Object Config window will appear.  

 

 
 

5.  Tag Screen 

 

Display all the Name, Type, and Address of each Tag used on a page. If you double click on a Tag, 

the Object Config window dialog box will appear, allowing you to edit Tag settings directly.  
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6.  Find / Replace 

 

1) Find / Replace in Project ([Edit]  [Find]/[Replace]) 

Search for a String in a page or in the whole project. The string can be an Object name, 

Tag name, Script, etc. 

 

 Find (Shortcut Key: Ctrl+F) 

Find a String. Click on the Next button to find the next matching string. 

 

 
 

 Replace (Shortcut key : Ctrl+H) 

Find and replace a string. This operation can be applied to the current active page, or to 

all project pages.   (Active Page/All Project Page). 

 

 
 

 Find String 

Enter the search string. 

 Replace String 

Enter the replacement string. 
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2) Find / Replace in Database ([Edit]  [Find] or [Replace]) 

Search for a tag and replace it based on a Tag property (name, Description, Real/Virtual, 

I/O Device and I/O Address). In order to use this function, you must first open the 

Database, then select [Edit]  [Find] or [Replace]. 

 

 Find (Short key : Ctrl+F) 

Search for a String in the Database. 

 

 
 

(1) All 

Search for a Tag in all Databases. 

(2) Name 

Search for a String (Tag) by Name. 

(3) Description  

Search for a String (Tag) by Description. 

(4) Real / Virtual 

Enter “1” to search Real Tags. Enter “0” to search Virtual Tags. 

(5) I/O Device 

Search for a String in I/O Devices. 

(6) I/O Address 

Search for a String in I/O Addresses. 

 

 Replace (Shortcut key : Ctrl+H) 

Search for String in Database, and replace with another String. You can search for the 

String in all Databases or in a selected Group. Click on Find Next to search for the next 

instance of the string. 



 

Chapter 11. Useful Functions 198 

 

 

 
 

 Find What 

Enter the search string. 

 Replace With 

Enter the replacement string. 

 Find By Item 

 

All – Search and replace in all tag fields. 

Name - Search and replace in the Name field. 

Description - Search and replace in the Description field. 

Real/Virtual Tag - Enter “1” to search Real Tags. Enter “0” to search Virtual 

Tags. Enter “1” in “Find What” and “0” in “Replace With” to change Real Tags 

into Virtual Tags. 

I/O Device – Search and replace Strings in I/O Devices. 

I/O Address – Search Strings in I/O Addresses 

 

7.  Editing Database in Excel 

 

Database can be modified using Microsoft Excel. 

 

1) Tag editing with Excel 

 

 

 

 

 

 

 



 

199 Chapter 11. Useful Functions  

 

 

 Tag Properties in Excel 

 

Rows Digital Tag Analog Tag String Tag Description 

A Tag name Tag name Tag name  

B Tag type(1) Tag type (2) Tag type (3)  

C Description Description Description  

D Real/Virtual tag Real/Virtual tag Real/Virtual tag 
Real Tag = 1 

Virtual Tag = 0 

E I/O Device I/O Device I/O Device  

F I/O Address I/O Address I/O Address  

G Initial value Initial value Initial value  

H     

I  

Data type 

0 : INT8 

1 : INT16 

2 : INT32 

3 : UNIT8 

4 : UNIT16 

5 : UNIT32 

6 : BCD8 

7 : BCD16 

8 : BCD32 

9 : UBCD8 

10 : UBCD16 

11 : UBCD32 

12 : Float 

Length of String  

J     

K     

L     

M  Scale  
Use Scale = 1 

Not use Scale  = 0 

N  Min. value of Eng. Data   

O  Max. value of Eng. Data   

P  
Min. value of Raw Data 

or Scale value 
 

Scale Value when 

“Use Scale” is 

enabled 

Q  
Max. value of Raw Data 

or Offset value 
 

Offset Value when 

“use Scale” is 

disabled 

R 
Save last status 

when closing 

Save the last status 

when closing 

Save last status 

when closing 

Use = 1 

Not use = 0 

 

 



 

Chapter 11. Useful Functions 200 

 

 

If you copy (Ctrl+C) a Tag from the Xpanel Database and paste (Ctrl+V) it into Excel, the data 

will be  displayed as shown below. 

 

 
 

EX) Create Multiple Tags in Excel 

 

(1) Create a Tag with a Tag name that ends with a number, and copy it into Excel (WORD0). 

(2) Create consecutive Tag Names. 

Click on “WORD0”, and drag it downward (Ex: WORD0 ~ WORD10). 

 

 
 

(3) Click on all data columns except column A (Tag Name), and drag them downward.  

 

 
※ All data will be the same except in column A.  

 

(4)  Copy the Tags from Excel into the Xpanel Database 

After the Tags have been created, select all Columns and rows, and copy them as shown 

below.   
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Paste them into the Xpanel Database. 

 
The names and properties of the copied tags will be saved in the Xpanel Database. 

 

8.  Converting the Project Model (the Screen Size of the Project) 

 

Convert the current project screen to another size. For example, if the current project is for XT04 

(4” screen size), you can convert it to XT07 (7” screen size). The monitor size will be converted 

automatically (if the user zooms-in on the BMP image object, it will be displayed at lower 

resolution). 

 

1) Converting the Screen Size of a Project. 

 

(1) Go to [Tools]  [Project]  [Convert] 
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(2) Select the Desired Model(Screen Size) 

 

 
 

 Select the Model 

Select the model (Screen Size) that you want to convert to. 

 

 Back Up Project Name 

Back up the current Project file. You can change the project name.  

Enable the Back Up feature before entering the Project Name. 

 

 Back Up Project Path 

Enter the Back-up file location. 

Click on Convert to convert the project.  

All pages and objects will be converted and displayed in XpanelDesigner. 

 

※ Some Objects may be distorted in size. Please check each Object's size after 

conversion. 

 

9.  Communication Monitoring 
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Comm Monitor is used to monitor the Communication status between Xpanel and the Device 

(PLC). This allows the Comm. frame, Comm status and quality to be monitored. Generally, both 

Xpanel and the PLC exchange [TX] and [RX] frames. If there is no [RX] response to a [TX], the [TX] 

frame is sent back to the PLC after the Retry Time. If there is still no [RX] response to a series of 

[TX] requests, it may constitute a Communication Failure. 

 

1) How To Monitor Communication Status 

 

(1) Open “Xpanel Config” feature on Xpanel Device 

 

If you touch the three corners of the Xpanel display in the order shown below, the 

Xpanel Config Dialog box will appear. Click on Comm Monitor. 

 

 
 

 

(2) Start Monitoring 

 

Select the desired I/O Device, then click Start to monitor the Comm. frame. If 

communication is normal, [TX] and [RX] frames will be shown alternating with each 

other. In case of a Communication Failure, only [TX] frames will be displayed (See the 

PLC protocol manual for the exact Communication Status). 
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Chapter 12.  Simulator 

 

1.  Simulator 

The Simulator is used to test projects currently under development by running them in a virtual 

environment. This allows rapid, efficient testing without using Xpanel or a PLC. 

 (1) Configuration of Simulator 

The Simulator runs on a PC, and does not need Xpanel or a PLC. It uses Virtual Tags. Tag value 

can be modified randomly by using the Simulator function. The Simulator operates exactly like 

Xpanel, with a few exceptions. 

(2)  Run Simulator (Shortcut Key F5 or F6) 

Click [Tools]  [Run Simulator] or press “F5” to run the simulator with the starting page. 

Click [Tools]  [Run Simulator with active page] or press “F6” to run the simulator with the 

current page. 
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When the Simulator is run, the Simulator window appears on the left side, and the page screen 

runs on the right side. Use the mouse to interact with the page screen. The Simulator window 

displays Tags which are used both in the current page and in other areas (Script, Alarm and etc.). 

(3) Virtual Control by Simulator Remote Control 

• Changing Analog Tag values (Address value) 

 

Enter the desired value into the [Set Value] field of the Simulator. [Tag Value] displays the 

current Tag value. 

• Changing Digital Tag values (Address value) 

 

 

 

 

Select 0 or 1 by clicking on the [Set Value] Combo Box in the Simulator. 

• Changing String values (Address 

value) 

 

 

Enter the desired String into the [Set Value] field of the Simulator.  

[Tag Value] displays the current String value. 

When entering an Address directly in the Database, the Tag name is displayed as 

[IO_’DeviceName’.ST_’StationName’.’Address’]. 
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(4) Limitations of the Simulator 

Some functions of Xpanel do not operate on the Simulator. 

The Trend, Alarm History, Scroll Message, Recipe and Data Logging functions are not displayed 

on the Simulator.  

Those functions work with real tags after, the project file is downloaded to Xpanel. 
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Chapter 13.  Switch/Lamp 

 

1.   Switch/Lamp 

Switch/Lamp is a convenient feature for creating switches and lamps using a library, and for adding 

commands to a switch function. 

1) Create a Switch/ Lamp 

(1) Switch/Lamp Selection 

  Click [Draw]  [Switch/Lamp]. Click on the page where the Switch/Lamp will be placed. 

The Switch/Lamp Configuration dialog box will appear. 
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2) Switch/Lamp Settings 

(1)  Shape Select (without using the Lamp feature) 

 

Select Shape can work in two different ways, depending on whether the Lamp feature is 

disabled or enabled When the Lamp feature is disabled, only the Switch Shape will be 

selected. A complementary color is used to indicate that the Switch has been pressed.  

(When the Lamp feature is enabled, the user can select images to display to indicate the 

status.) 

 

(2) Switch Function 

 Touch-Down  

The function that is activated when the Switch is pressed down. 

 Touch-Up 

The function that is activated when the Switch is released. 
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A. Bit Switch 

 Set 

The Bit Tag or Address value is 1 (ON) 

 Reset 

The Bit Tag or Address value is 0 (OFF) 

 

B.  Word Switch 

 

 Switch Operation 

1. Write Analog Value 

Write an Analog value to a Tag or Address.  
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a. Address/Tag name 

Select a Tag or Address  

 

b. Value 

Hexa :  Write a Tag value in Hex format. 

Using Tag: Use the value of another Tags or Address as the Write Value. 

 

2. Tag Operation 

 
       

Write value or operation results from other tags or addresses to the assigned tag. 

  +, -, AND, OR, XOR Operators are supported. 

 

a.   Page  

Move other pages, or open Popup and Keypad pages. 

   

b.   Special Function 

Write Commands, Key Inputs and Momentary values by means of the 

Switch function. 
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(3) Switch Common 

 

 
 

 Use Touch 

Logical Operations can be used to control touch features. When the result of a Logical 

Operation is True, the touch feature operates; otherwise it doesn't. 

 

 Use Security Function 

The Security Level can be set for the Touch feature. The Security Level has a range from 1 to 

10. Level 1 has the lowest authority, and Level 10 has the highest authority. 

 

(4) Lamp 
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Change the lamp appearance based on a condition. 

If Enable Lamp is not selected, Xpanel will only show switch designs. 

 

A. Enable Lamp 

Click [Enable Lamp] to activate the Lamp configuration lists. 

 

B. Tag Type 

Select a Tag type to control the Lamp State. 

 

C. Number of State  

Set the number of Lamp States that will be displayed on the page. 

 

D. Condition of State 

Select the type of data that will control the lamp state. 

(Data Input or Bit value) 

 

E. Shape Select 

Select the Lamp Shape and State. 
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  (A) For a Digital Tag 

 

 State Change by Data Input 

 

Each digit of a Binary number is set by the contents of a Bit Tag or Tag Address.  The 

Lamp State is set by the resulting Binary value.  

 
Since a Digital Tag has two states, 0 and 1, 3 tags are needed to display 8 states (2X2X2 = 

8). In the example shown above, the bit from Tag Name1 will be placed at the 20 

position, the Tag Name2 bit will be at the 21 position, the Tag Name3 bit will be at the 

22 position and the Tag Name 4 bit will be at the 23 position. This allows each Digital Tag 

to set a digit of the Binary number. 

Ex)  Setting Tag Name1 = 0, Tag Name2 =1 and Tag Name3 =1, the combined of Binary 

value of 0110 is 6 in decimal. This displays State 6 on the Screen. 
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 State Change by Bit Value 

 

The state of the device is set by the combined contents of the Bit Tags or Tag Addresses. 

When all Tags are 0, State 0 is displayed. State 1 is displayed when Tag Name 1 = 1, Tag 

Name 2 =1 and Tag name 3 = 1. If both Tag Name 1 and Tag Name 2 are 1, the lower 

State takes priority, so State 1 will be displayed. 

 

 
 

(B) For an Analog Tag 

 

 State selection by Data Input 

 

States can be displayed based on an Analog Tag or Address value. This process takes a 

single Analog tag, and displays up to 256 States. 

 

 State Selection by Bit Change 

 

States can be selected based on an Analog Tag or Address value. Since Analog data 

consists of a single word, a total of 16 Bits can be used to display States. When all Bits 

are 0, State 0 is displayed. Each state requires 16 bits; a total of 17 States can be 

displayed. At least one Bit must be ON; the lower Bit will be displayed if multiple Bits are 

ON. 
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(5) Label 

 

Enter a name to be used for the Switch, based on its state. 

 

 
 

A. State Select 

Select the state in order to display the label. 

 

B.  Direct Input 

Enter the name which will be displayed for the selected State. 

 

C.  Input type 
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 Direct Input:  Enter the name (word) directly 

 String Table:  Select a word (string) from the String Table. 

  

D.  String Table Setup 

 

 This feature is available when String Table is selected as the [Input Type]. 

Strings must have already been saved in the String Table.  

When a String Group and String are selected for the the State, the String will be 

displayed in [Preview]. 

 

E.  Font Set 

  

Fonts can be configured for Font type, size, color etc.  

 

F.  Apply Label To All State 

 

The current Label setting will be applied to all States. 

 

G.  Apply Font To All State 

 

The current Font setting will be applied to all States. 
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Chapter 14.  Alarms 
 

1. Alarms 

 

Alarms are used to monitor tags or address and display warning messages or information about 

specific operating conditions. Alarm messages can be displayed in the Alarm summary or as 

Scroll messages.  

2.  Alarm Configuration 

Select [Tools]  [Alarm] or click on the Alarm icon in the Drawing Toolbar.  

You can set alarm conditions and actions in Alarm Configuration. 

 

1) Alarm Group 

Alarms can be organized into groups based on the types of alarms. There is no limit to the 

number of alarms that can be registered in one group. 

2) Alarm Option 

(1)  Alarm Description 

Enter a Description for each Alarm.  The maximum number of characters is 16. 

(2)  Using String Table 
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To use a String Table to display Alarm messages, select “Using String Table” 

(3)  Save Alarm 

Maximum 500 Alarm History entries can be kept and displayed again when Xpanel device is 

turned Off  On.  If the number exceeds 500, the oldest item is deleted and current item is 

saved.  To save an Alarm History, it must be converted to CSV format and saved (either to 

Xpanel's Main memory, SD memory or USB memory). 

3) Edit Alarm Registration 

Click [Tools]  [Alarms] to edit an Alarm. You can copy alarms and paste them to Excel, or copy 

Excel data and paste it to Alarm feature back, in much the same way as you can copy and paste 

Tag in Database. 

 Add 

Add an alarm. 

 



 

219 Chapter 14. Alarms  

 

(1)  Tag Registration 

Enter the alarm condition. When a Tag or Address meets the alarm condition, the Alarm 

will be ON. Available operators (condition) are ‘=’,  ‘>’  and ‘<’. 

(2)  Alarm Description (Content) 

Enter the warning message which will be displayed when the Alarm occurs. Alarm 

Descriptions can be seen in the Alarm Summary or the Scroll Message. 

(3)  Action Option on Alarm 

When an alarm is generated, two types of action are possible: 

 Open Page 

Open the designated Page when the alarm occurs.  Without needing to use a command 

Script such as “PageOpen()”, the user can just add a page name from the page list. Just 

enter the page name without any extension. 

Ex) In case of “ALARM.PGX”, write “ALARM”. 

 Command Script (Expression) 

When the Alarm is generated, a Command Expression is executed. 

(4)  Action Parameter 

Enter the Command Expression to be run when the Alarm is ON. 

(5)  Executed Command by Alarm Off (Command Expression) 

When the Alarm is off, Command Expression is executed. 

(6)  Executed Command by Alarm On (Command Expression) 

Enter the Command Expression to be run when the alarm is ON. This functions is related 

to the Alarm Summary; Run Specified Action On Double Click in the Alarm Summary 

must be selected in order for it to operate. 
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Click on [ACK] on the Alarm Summary page, or double-click the Alarm message in order 

to run the Command. 
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(7)  Apply Scroll Messages 

When the Alarm is On, Scroll messages will be displayed on the screen.  If this feature is 

applied to alarms for all pages, Alarm contents can be viewed without looking at the 

Alarm Summary window.  

 How to use Scroll Messages 

A.  Select Apply Scroll Messages  

Select the Alarm and click on Apply Scroll Messages. 
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B.  The Using Scroll Messages option 

In order to use Scroll Messages on the Xpanel device, You must select Using Scroll 

Messages in [XPANEL Configuration].  

Click [Tools]  [XPANEL Configuration]. 

 

When you select Using Scroll Messages, it brings up the [Scroll Message] Tab. 
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  C.  Scroll Message 

  The Scroll Message will be displayed as shown below. 

 

 

3.   Alarm Summary 

The Alarm Summary displays a summary of all Alarm information on the page.  The Alarm Summary 

Object displays it on the screen. Up to 500 Alarm messages entries can be displayed.  If the number 

exceeds 500, the oldest item is deleted and current item is displayed. 

Click [Draw] [Alarm Summary] then click on the page, and the Alarm Summary Configuration 

window will appear. 
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1) Alarm Setting 

 

  (1)  Alarm Group 

Select the Alarm Group to be displayed; only alarms from that group will appear in the 

summary window.   

 

(2)   Color Setting of Alarm Summary 

Select the colors to be used in Alarm Summary window functions, such as Background, 

Ack (Acknowledgment), Occur (Alarm On), and Release (Alarm OFF). 
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(3)  Alarm Status 

Select the Alarm statuses which will be displayed in the Alarm Summary. 

 Occur (Alarm On): When the Alarm is ON, “Warning” will be displayed in red 

(default) on the screen. 

 Release (Alarm OFF): When the Alarm is Off, “Clear” will be displayed in green 

(default) on the screen.  

 Ack (Alarm Acknowledge): The user acknowledges the Alarm by clicking on the Ack 

button or double clicking on the Alarm Message. The message color changes to 

blue (default), but the Alarm status doesn't change. 

 Display Active Alarm Only: Display only messages for alarms that are currently ON. 

When an Alarm is Off, its Alarm Messages will not be shown on the screen. 

(4) Display  

Select the items which will be displayed in the Summary Window  

 Buttons: these are used to control alarms; they appear at the bottom of the 

summary window.  

 

  A.  Stop :  Stop displaying messages. 

  B.  Stamp : Record the time when the alarm was viewed. 

 

   

 

< Alarm Summary Window> 

C.  ACK: Check the Alarm information. If Run Specified Action on Double Click is selected, 

the specified Command expression will run. 

D.  Delete: Delete the alarm message from the Alarm Summary Window.  

※ Alarm status will be maintained even if the Alarm Message is deleted. 
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E.  Setup 

 

  F.  Config : Open the Xpanel Config window. 

 

 
 

  

2) Alarm Summary Object 

  

After you have finished the Alarm Summary Configuration, the Alarm Summary Object will 

appear on the page.  

You can adjust the size of the Alarm Summary Object. 
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The alarms will be displayed in a window of the selected size. 

 

4.  Script Functions for Alarms 

1) AlarmCsvWr(R1, S2, R3, R4, R5) 

 This script converts an Alarm history to a CSV file. 

R1  :  Alarm Group number (1~10) 

S2  :  The name of the CSV file to which the alarms will be saved (the Extension and Save 

location are not required) 

R3  :  Date and Time format (See HELP for detailed information) 

R4  :  Output option (See HELP for detailed information) 

R5  :  Location where the CSV file will be saved 

  

0  :  Xpanel's Local Memory 

1  :  SD/MMC Memory 

2  :  USB Memory 

 

Example)  AlarmCsVWr(1, “Alarm”, 0, _ALMPRT_ALL_,2); 

 

Save all Alarm history from Group 0 in the format (YYYY/MM/DD HH:MM:SS) to USB memory. 
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2) AlarmPrint(R1, R2,  R3, R4, R5) 

 

Print out the Alarm history. 

 

R1  :  Alarm Group number (1~10) 

R2  :  Number of Alarm history entries to be printed out (0~500, all current Alarm history is 

printed out  if R2 is 0) 

R3  :  Date and Time format (See HELP for detailed information) 

R4  :  Font Size 

R5  :  Output option (See HELP for detailed information) 

 

Example)  AlarmPrint(1, 10, 1, 10, _ALMPRT_ALL_); 

 

The most recent 10 Alarms from Group 1 are printed out in font size 10 with the format 

(DD/MM/YYYY HH:MM:SS). 

 

3) ClearAlarmLog(R1) 

 

Delete all Alarm history entries for Group R1. 

 

Example)  ClearAlarmLog(1); 

 

Deletes all Alarm history entries for Group 1. 
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Chapter 15.  Data logging 

 

1.  Data logging 

Data logging is used to save a log of Xpanel Tag or Address Data. The collected data can be displayed 

on the screen, and it can be saved to a CSV file. Using Scope Trend, you can also view data as a 

graph. 

 

1)  Data logging Block 

To use the Data logging feature, you must first understand Data logging Blocks. Logging Blocks are 

the units that Xpanel uses internally for saving and administering logged data. Because of Xpanel's 

limited memory capacity, data is divided into blocks to be saved. 

 

The maximum number of blocks is 32, and a maximum of 2048 units of data can be saved to a block. 

Currently incoming Data is saved in Block 0, and the most recently completed Block is Block 1. 

Once a Block is created, Data logging actions are based on the Logging Option settings.  The Start Option 

settings control the creation of Blocks, and Data writing and saving are controlled by Logging Options. 

Since the Maximum Block is 32, the oldest Block (number 31) will be deleted when all 32 Blocks are full. 

In this way, the 32 Blocks are recycled. To store data permanently, you need to convert it to CSV format 

and save it before all 32 Blocks are used. 
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2)  DATA LOGGING Configuration 

Select [Tools]  [Data logging] or click on the Data logging icon in the Standard 

Toolbar. 

 

 

  

(1) Logging Model Name 

Enter the name which will be used to identify the Data Logging Model.  
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(2) Start Option 

 

Start Option determines how a new Data Block will be created. A Block is a space for saving Data.  

Data is saved to a Block based on the Logging Option settings (Tag Value or Periodic). 

When a Block is full, a new Block must be created, based on the Start Option settings. When the 

Start Option conditions are met, even if current block is not full, Xpanel will start saving data in a 

new block. 

A. Periodic 

 

Xpanel creates a new Block periodically, based on the Start Time interval. At the Start 

time, it closes the current block and starts saving data in a. 

 Start Time 
Enter the interval for creating a new Logging Block. 
 

Example) 0 hour and 5 minute 

New Blocks are created every 5 minutes ( 5min, 10min, 15min…55min). 
 

Example) 1 hour and 7 min, 
New Blocks are created every 1 hour and 7 minutes ( 00:00, 01:07, 02:14, 
03:21 ... 10:20, 11:27). 
 

 Delay 
When a Block is created, Xpanel will wait for the delay period before saving data 
to it. 
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B. Enable Tag 

     

 
When the Enable Tag or Address value is ON, a new Logging Block is created. When 

Enable Tag or Address value is OFF, the Block is closed and Data logging stops. If Enable 

Tag or Address value is turned ON again, Data logging begins with a new Block. 

If the Type is Enable Tag and the tag is ON, Xpanel will save the maximum amount of 

data to a block. When each Block is full it will create a new block. 

 

C. Trigger Tag 

 

 

 

 

 

A New Block is created when the Trigger Tag or Address value is changed from OFF to 

ON. 

 

   

 

 

   

When the Trigger Tag changes its status from OFF to ON, a new Block is created. Even  if 

the Trigger Tag returns to OFF status, Data will still be logged. 
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Here are the differences between Enable Tag and Trigger Tag operation: 

a. An Enable Tag can create or close a Block based on its ON or OFF status. A 

Trigger Tag can only create a Block. 

b. If the Enable Tag is ON, it can create a new Block automatically whenever the 

amount of data being logged exceeds the Maximum Logging Data. However in 

Trigger Tag mode, the user must change the Trigger Tag status from OFFON 

when a Block is full. 

c. If Xpanel begins operation with the Enable Tag ON, a Data Block is created 

and Data logging starts. But, if Xpanel begins operation with the Trigger Tag ON, 

a Data Block is not created, because condition is not OFFON, so Data logging 

does not start. 

 

D. Called (By Script or Command Expression) 

 

Called starts Data logging in response to the internal function Datalog() in a Script or 

Command Expression. 

-  How to use DataLog() 

 DataLog(S1, R1); 
S1 : the Logging Model Name 

R2 : 1 or 0  - create a Logging Block, or close it. 

Example) Datalog(“Log”, 1);   : Create a new Block and starts Data logging. 

Datalog(“Log”,0);   : Close a Block and terminate Data logging. 
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E. On Time (Once a Day) 

 

Create and save data to a single block per day. Since only one block is created per day, 

Data logging is terminated when the maximum amount of data is saved in that Block. If 

you use this potion, you should set the Maximum Log number Per Block under Block 

Option based on the expected data logging requirements for a single day. 

 

(3) Logging Option 

 

Logging Option controls the way that data is written to a Block. Data can be saved based on the 

Logging Option settings only when the Block is created in advance. 

There are two Type selections: Periodic and Tag Value. Periodic periodically saves data after a 

set interval, or Period. Tag Value saves data whenever the Tag Value is changed.  

A. Periodic 

 

Data is written to the Block after a set interval, or Period.  The Logging Block must be 

created in advance. 
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B. Tag Value 

 

Data is written to the Block when the Tag or Address value changes from 0 to 1, any 

other value except 0.  This functions very much like the Trigger operation. 

 

(4) Block Option and Logging Tag Setup 

A Block is Xpanel memory space used for Data logging, as explained above. The maximum 

number of blocks is 32, and a maximum of 2048 units of data can be saved to a block.  The 2048 

Maximum Data means that a maximum of 2048 units of data per tag can be written to a log. If 

the user has 10 Tags to log, 2048 units of Data can be saved for each Tag. 

 

 

2. Scripts for Data logging 

1) DataLog(S1, R2) : A Data logging block is created and closed regardless of the Start Option 

setting. 

 S1 : Logging Model Name 

 R2 : Logging Block Control (0 : Stop creating Block, 1 : Create new Block) 

 Example) 
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DataLog(“Log”, 1) : Create a new Block and start Data logging. 

DataLog(“Log”, 0) : Close a Block and terminate Data logging. 

 

2) MakeCsv(S1, R2) : The Data Block is converted to a  CSV file and saved to SD/MMC memory. 

S1 : Logging Model Name 

 R2 : Block Number (0~31) 

 Example)  

MakeCsv(“Log”, 10) : Block number 10 of the “Log” logging Model is converted to a CSV 

file and saved into SD/MMC memory. 

 

3) MakeLogCsv(S1, R2, R3) : The Data Block is converted to a CSV file and saved to a designated 

location. 

 S1 : Logging Model Name 

 R2 : Block Number (0~31) 

 R3 : Save location (0: Local, 1 : SD/MMC, 2 :  USB) 

 Example)  

MakeLogCsv(“Log”, 10, 2) : Block number 10 of the “Log” logging Model is converted to  

a CSV file and saved to USB memory. 

 

4) MakeLogCsvEx(S1, S2, R3, R4) : The Data Block is converted to a CSV file and saved to a 

designated location.  The header name is saved in the A1 cell of the CSV file. 

 S1 : Header Name 

 S2 : Logging Model Name 

 R3 : Block Number (0~31) 

 R4 : Save location (0: Local, 1 : SD/MMC, 2 :  USB) 

 Example) 

 MakeLogCsvEx(“Header”, “Log”, 10, 2); 
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Block number 10 of the “Log” logging Model is converted to a CSV file and saved to USB 

memory.  The Header string "Header" is saved in the A1 cell of the CSV file, as shown 

below. 

  

 

3. Notes for Data Logging 

1) The Block must be created before Data logging starts, since Data must be saved to an existing 

Block. 

2) A New Block must be created for saving new Data when the quantity of of saved data in the block 

exceeds the Maximum Data per Block quantity. 

3) Available block numbers are from 0 to 31 (total 32). The oldest Block, 31, will be removed and a 

new Block is created when all 32 Blocks have been used. 

4) When saving a CSV file locally (i Xpanel), make sure that Xpanel has enough available memory. If 

the available memory in Xpanel is not sufficient, consider saving the Data in USB or SD memory. 

5) Earlier log files (Blocks) will be deleted if the user downloads a project after modifying the Data 

logging Model configuration (CSV files are not deleted). Therefore, you should back up important 

files before downloading a project. 

※The location in Xpanel where logged files are saved is as follows:  

(\Xpanel\Log\“Logging Model Name”\)  
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Chapter 16.  Recipes 

Recipe 

The Recipe feature allows you to select one of many settings in a Model, and transfer it to the 
PLC. You can simultaneously send settings to several PLCs based on their Model types. This is a 
useful feature when you need to change settings frequently for many model types. 

 

1. Principal of Recipe Operation 

After you save a Recipe Setting file, the Recipe feature sends the Recipe Model's Setting Group to 
the target PLC. The Recipe feature requires consecutive Addresses, since each setting value is 
written in consecutive Addresses.  Additionally, the Block Write feature must be supported, in order 
to transfer consecutive Addresses rapidly. This means that some PLCs may not support the Recipe 
feature (see the PLC list below). Models and group setting values can be modified while Xpanel is 
operating, but adding a model or group is not allowed. 

2. Recipe Feature Settings 

Select [Tools] [Recipe] or click on the Recipe icon          from the Standard Toolbar. 
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1)  Add a Recipe Model 

 Click on the  icon to create a Recipe Model . 

 Enter the Recipe Model Name. 

 

 

 

(1) Recipe Area Start Position 

A. Starting Address 

Recipes use consecutive Addresses for PLCs. Enter starting Addresses in the Recipe Area Start 
Position. Direct Addresses or Tag names can be used. The Tag Address is set as the Starting 
Address if the Tag name is used. The Address or Tag data must be in WORD or DWORD (INT16, 
UINT16, INT32, UINT32, Float) format. All Address or Tag data must be of the same type. 
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B. Data Number & Group Number 

                                                                                        Group Number 

 

                              

  Data Number 

 

 The Data Number is the number of Data items used in each Group. It should be 
sufficient for the number of settings per group. 

The Consecutive Address count begins with the Starting Address, and goes up to the  
Data Number. If the Starting Address is in WORD format starting from D0000 and the 
Data Number is 5, the addresses will be from D0000 to D0004. If the Starting Address is 
in DWORD format ( INT32, UINT32, Float), the addresses would be from D0000 to D0009.  
The Group Number does not affect the Consecutive address. 

 

 The Group Number is the unit for saving Settings data. A single group can include many 
Data items, and each Group comprises different settings. A Group is modified when the 
overall settings are changed. 

 

(2) Handshake 

Note:  The Xpanel Recipe system takes care of the Handshake process automatically. Unless you 
know that you have a specific reason to change handshake settings, you should leave them as-is.   

 A. WORD 

Xpanel uses a Word Address or Tag for Recipes. This feature is used to control uploading and 
downloading. A WORD address can be either WORD or DWORD type; no Scale setting is needed. 

 Bit 0 : This bit is Set when Xpanel downloads group data. When the operation is 
complete, the 0 Bit is reset automatically. 

 Bit 1 :  This bit is Set when Xpanel uploads group data from the PLC. When the operation 
complete, the 1 Bit is reset automatically. 
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 Bit 8 : This bit is Set when the Device (PLC) requests that Xpanel download. The 0 Bit is 
not Set, and is automatically Reset when the operation is complete. 

 Bit 9 : This bit is Set when the Device (PLC) requests that Xpanel upload. The 1 Bit is not 
Set, and is automatically Reset when the operation is complete. 

 

B. BIT 

BIT is used to check the status of the current Download or Upload. BIT must be a Digital Tag or 
Address.  Its status is shown as Set during the upload or download operation. 

 

 C. Group Number 

When the PLC requests a Recipe operation, the Tag Name or Address of Group Number is used 
to Upload or Download. After the Group Number is set, Xpanel starts the operation, and the 
HandShake BIT is SET if Bit 8 or Bit 9 of the Handshake WORD is Set. When the operation 
complete, both the HandShake WORD and BIT are Reset automatically. 

 

<Recipe HandShake Timing for PLC request > 

 

 

<Recipe HandShake Timing for Xpanel request > 

※The HandShake Group No. is not used for Xpanel requests. 
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(3) Post Processing For Uploaded Data 

 A. Automatic File Store For a PLC Managed Upload 

If you change and upload downloaded Group data from a PLC, the Recipe Group settings 
are changed. As long as Xpanel Power is On, changes to the group data will remain in 
memory; they will disappear when power is turned off. This means that modified setting 
should be saved to the Recipe Setting file in order to keep the changes. 

If this feature is used, changes to PLC group data will be uploaded and saved to a file 
automatically. 

3. Script for Recipe 

Recipe scripts operate as follows: 

The Recipe Model, including Groups and Data, must be defined first. While Xpanel is running only 
Group data can be modified. Adding or deleting Recipe Models, Groups, or Data is not allowed. 

(See Script in XpanelDesigner Help for more information on Recipe Scripts)  
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 1) RcpConfig() 

This script brings up the Data Manipulation Window (DMW). In the DMW, you can select the 
Recipe Model and Group, and use the Recipe control buttons. Recipe Group data can be 
modified using the Digit Keypad. 

 

<Data Manipulation Window (DMW)> 

 (1) Model 

 Change the current Model. 

 (2) Group 

 Change the current group to another group. 

 (3) Group Data 

 You can change the Data name and value by double-clicking on the screen. 

 (4) Control Button 

 Download 

Transfer Recipe Mode Group Data to the PLC. 

This is the same as the RcpmemDown () script. 

 Upload 

Read Data from the PLC, and save it in Recipe Model Group Data. 

This is the same as the RcpmemUp() script. 

 Save 

The modified Recipe Model Group Data is saved in a Recipe File (*.rcx). 

This is the same as the RcpFileStore() script. 



 

Chapter 16. Recipes 244 

 

 Close 

Close the RcpConfig window (DMW). 

  (5) Keypad 

The Keypad can be used to change Recipe Data values.  

 

 2) RcpFileRead(S1, R2) : Read Group Data from a Recipe File. 

  S1 :  Recipe Model name 

  R2 :  Model Group number 

  Ex) RcpFileRead(“ICE_CREAM”, 1); 

To read Group1 Data of the “ICE_CREAM” Model saved in the Recipe File in Xpanel 
internal Memory. 

 3) RcpFileStore(S1, R2) : Save Model Group Data in a  Recipe File. 

S1 :  Recipe Model name 

  R2 :  Model Group number 

  Ex) RcpFileStore(“ICE_CREAM”, 1); 

To save “ICE_CREAM” Model Group1 data from Xpanel internal Memory to a file. 

 

 4) RcpMemDown(S1) : To transfer a Group Data in Xpanel internal memory to a PLC. 

The Recipe group data must be saved in XpanelDesigner internal memory before 
RcpMemDown is executed. 

   
S1 :  Recipe Model name 

  Ex) RcpMemDown(“ICE_CREAM”); 

Transfer “ICE_CREAM” Group Data from Xpanel internal memory to the PLC. Before 
using this script, Group Data must be saved in Xpanel internal Memory using 
RcpFileRead() or  RcpMemUp().  It is also possible to execute RcpMemDown() after 
selecting a Group in RcpConfig().  
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 5) RcpMemUp(S1) : Upload PLC Data to Xpanel internal Memory. 

S1 :  Recipe Model name 

Ex) RepMemUp(“ICE_CREAM”) 

Upload ICE_CREAM group data from the PLC to Xpanel internal memory before 
executing RcpMemDown() or RcpFileStore(). 

 

6) RcpDownLoad(S1, R2) : Read a Recipe File's Model Group Data and transfer it to the PLC 
immediately. 

 S1: Recipe Model name 

 R2: Group number (0~n) 

 Ex) RcpDownLoad(“ICE_CREAM”, 0) 

Read the ICE_CREAM “0 Group” and transfer it to the PLC. This is the same as using  
RcpFileRead() and RcpMemDown() in sequence. 

 

7) RcpUpLoad(S1, R2) : Read PLC Data and save it to the Recipe File. 

S1 :  Recipe Model name 

  R2 :  Group number (0~n) 

  Ex) RcpUpLoad(“ICE_CREAM”, 0); 

Upload Data from the PLC and save it to Group 0 of the  “ICE_CREAM” Model in the 
Recipe File. This is the same as using two RcpMemUp() and RcpFileStore() consecutively. 

8) RcpCsvRd(S1, S2, R3) : Read Recipe Model Group Data saved in a CSV file and save it in Xpanel 
internal memory. 

S1 :  Recipe Model name 

 S2 :  CSV file name 

 R3 :  CSV file location( 0 : Local, 1 : SD/MMC, 2 : USB) 

 Ex) RcpCsvRd(“ICE_CREAM”, “Recipe”, 2); 
Read “ICE_CREAM” model group data from the “Recipe.CSV” file saved in USB storage, 
and save it in Xpanel internal Recipe Memory. 
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9) RcpCsvWr(S1, S2, R3) : Save Group Data saved in Xpanel internal Recipe Memory as a CSV file. 
 

S1 :  Recipe Model name 

 S2 :  CSV file name 

 R3 :  CSV file location( 0 : Local, 1 : SD/MMC, 2 : USB) 

Ex) RcpCsvWr(“ICE_CREAM”, “Recipe”, 2); 
Save Group Data which was uploaded from Xpanel internal memory to the “Recipe.CSV” 
file.  

 
<CSV File Output Result> 

 

10) RcpGetSysMem : Copy one block of System Memory to Xpanel internal Recipe Memory. 

S1 :  Recipe Model name 

 R2 :  System Memory Address 

 Ex) RcpGetSysMem(“ICE_CREAM”, 100); 
Copy Data starting from System Memory 100 and the size of the Data  used by 
“ICE_CREAM” into Xpanel internal Recipe Memory. 

 

 11) RcpSetSysMem : Copy Data from Xpanel internal Recipe Memory to System Memory. 

S1 :  Recipe Model name 

 R2 :  System Memory Address 
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Chapter 17.  Trend Graphs 

 

17.1  Trend Graphs 

The Trend feature displays Address or Tag data that is being monitored on Xpanel as Trend Graphs. 

It consists of 6 types. 

1) YT Trend : Display a general Trend Graph based on Time. 

2) Scope Trend : Display all data saved either in the PLC or by the Datalogging feature. 

3) SPC Trend : Display data saved in the  PLC by XY Coordinates. 

4) ST Trend : ST Trend allows comparison between a Reference Graph and Real-Time Trends. The 

Reference Graph is based on a sequence of saved data. Real-Time data is displayed along with 

the Reference Trends.  

5) Log Trend : Data is logged (collected) and displayed as Trends in real time. Multi-channel data 

acquisition is supported.   Datalogging can be Period or Trigger. The logged data can be easily 

exported to a CSV file. 

6) XY Trend : Data is logged (collected) and displayed as Trends in XY Coordinates in real time. The 

ifference between Log Trend and XY Trend is that XY Trend has an XY Coordinate data. 

 

※ Log Trend and XY Trend data is logged separately from Xpanel Datalogging. 

 

Type 
Real-Time 
Monitor 

Historical Feature 
CSV File 

Conversion 
Feature 

YT Trend O O Δ  

SCOPE Trend   Δ 
Datalogging Model 
used 

SPC Trend     

ST Trend    
Reference Graph 
used 

LOG Trend O  O 
MultiChannel used,  
CSV File Conversion 

XY Trend O O   
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17.1.1 YT Trend 

The YT Trend graph displays a general Trend with the X-axis representing Time and the Y-axis 

representing Data.  

 

 

1. Draw a YT Trend 

Select [Draw] [ Trend Graph]. The Trend Config dialog box will appear. 

  

1) Trend Configuration : General (YT) 
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 Trend Type 

Select General (YT). 

 

 Display Base (Direction) 

Select the data progress direction for the X-axis. 

 

A. Display Base – Left 

 

 

B. Display Base – Right 

 

 

 Display Time 

Display Time is the time range of the X-axis. A long Display Time is useful for showing a 

long period of operation. A short Display Time is useful for analyzing a dynamic situation 

during a short period of time. 
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 Sampling Time 

Data is displayed on a Trend Graph using an interval. A smaller Sampling Time allows 

more detail to be displayed. 

The Sampling Time Unit is 100 ms.  

 

Ex) A sampling time of 1 equals 0.1 sec.  

      A sampling time of 10 equals 1 sec. 

 

 File Saving 

File Saving is used to support the Historical feature. Past Trend Graphs are available only 

if the data is saved to a file. The maximum storage capacity for a Tag is 5000 units of 

data. If the sampling time is 1 sec, Historical Trends up to a maximum of 5000 seconds 

can be viewed.  The storage location can be internal Memory, SD Memory, USB 

Memory.   If stored data exceeds 5000 units, the oldest data is deleted. 

If the File Saving feature is disabled, only fresh trend data will be used whenever Xpanel 

is restarted. 
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 File Saving 

To convert the saved data to a CSV file, a Script function is used (this applies to the 
YT Trend only). 
 

Ex1)  TrendCsvWr(S1, R2); 
 S1 : Trend Name 

 R2 : CSV file location (0: Local, 1: SD/MMC, 2: USB) 
 

Ex2)  TrendCsvWr(“YT_Trend”, 2); 
  Convert the saved file to a CSV file on a USB memory stick. 

  

2) Object Style 

 

  

Object Style changes the external Background Color. Below are some examples. 
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< External Background Color > 

   

 

3) Trend Area Style 
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Trend Area Style changes the internal Background Color of the Graph. Below are some 

examples. 

 

(1) Initial Drawing Type 

The Initial Drawing Type can be Fixed Pen or Moving Pen. This affects the initial appearance 

of the graph, but eventually, the difference will no longer be apparent. 

A. Fixed Pen 

-The latest Data is updated on the Display Base axis. 
B. Moving Pen 

- The latest Data is updated at the end of the Pen. 

 

             < Fixed Pen >             < Moving Pen > 
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4) Pen  
 The Pen Settings select the Tags or Real Addresses to be monitored. 

 

 Pen Setting 

Select Pen number from Pen Settings to select the Tag or Address. 

 

 
 

A. Address or Tag 

A Real Address or Tag can be selected for each Pen. 

B. Comment 

The comment will be used instead of the Tag name when displaying the Tag value. 
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C. Max/Min value 

Set the Max. and Min. values on the Y-axis of the Trend graph. The Max/Min value 

of each Pen will be used on the Trend Graph, but only the #1 Pen's Max/Min value 

will be displayed on the Y-axis. If the Max/Min Value is not set in the Pen Settings, 

the Max/Min Value from the Engineering Data [CIMON] in the Xpanel Database will 

be used. 

(With Addresses, the Max/Min value depends on then Data Type). 

 

  Only the # 1 Pen is displayed on Y-axis  

 

D. Pen Color 

Select the Pen color.  Click on the color to bring up the color palatte. 
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5) Control Button 

The Control Button is used to control the Trend Graph. This feature is used to bring up Historical 
Data in Historical Mode. It also supports Zoom-In, Zoom-out and Pen Color. 
 

 

 

Control Button Description 

 
Switch from Real-Time to Historical Mode. 

 
Switch from Historical to Real-Time Mode. 

 
Move forward or backward by Display Time in Historical mode. 

 

One click will decrease Display Time by 50%.  
Zoom-in resolution cannot be less than the Sampling Time. 

 

One click will increase Display Time by 50%.  
Zoom-out resolution cannot be greater than the Sampling Time X 5000. 

 
Change the Pen which displays the Max/Min value. 
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6) Legend 

 

 

 Show Tag Value 

Display the Tag or Address value set in the Pen Settings. The Comment from the Pen 
Settings will be displayed rather than the Tag Name. 

 

 

Open the Trend Setting Window. Standard Time, Time Width and the 
Display Pen can be set. 
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 Show Date 

Display a Date above the Graph. 

 

7) Grid Settings 

A Grid can be included in a Trend Graph. You can set the Number of Grid lines on the X or Y Axis 
up to a Maximum of 99, and select the Grid color.  

 



 

259 Chapter 17. Trend Graph 

 

 Display Grid 

When the Display Grid feature is enabled, the Grid Number and Color can be set. 
 

8) Y-Axis Legend 

Display the Max/Min values on the Y-axis. 
 

 
 

9) X-Axis Legend 

Display Time information on the X-axis. 
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※ Notes 

 

 When using the Control Button (Key Input), only one Trend Graph Object can be included 
on a Page. 

 Using more than 2 Trend Graphs with the Alarm Summary, Data logging, and Key Input 
Object may cause a Trend Graph error. 

 

 
  

17.1.2 Scope Trend 

The Scope Trend displays an aggregate of previously saved Data. This requires the Xpanel Data 

logging feature. If Xpanel Data logging is not used, consecutive address from the PLC or Device can 

be read and displayed on the Trend Graph. 

 

 

 

 



 

261 Chapter 17. Trend Graph 

 

 

 

 

 

 

 

 

1. Draw Scope Trend 

Select [Draw] [ Trend Graph]. The Trend Config dialog box will appear. 
 

1) Trend Configuration : Scope 

 

 Trend Type  

Select Scope. 

 

 Display Base 

Select the data progress direction for the X-axis. 
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2) Object Style 

Object Style changes the Background Color. Below are some examples. 
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3) Line Color 
Line color changes the color of the graph outline. 

 
 

4) Pen 

The Pen Settings select the Tags or Real Addresses to be monitored. 
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 With Using Data logging Enabled 

The data that is logged is read and displayed on the Graph. 
With this feature enabled, Pen configuration is linked automatically to the Tag or 
Address of the Datalog Model. The Maximum number of pens is 8. If the Datalog 
Model contains more than 8 Tags or Addresses, Scope Trend can display only the 
first 8 Pens. 
 

 With Using Data logging Disabled 

A Real Address or Tag can be selected for each Pen. The Maximum number of pens 
is 8. 

 

 
< Pen Address Setting > 

 

When you enter pen address settings, you must take into account the amount of data 
represented by each pen. 
 

Ex)  #1 Pen represents 10 Data units at address D0, and #2 Pen is at address D8  
(No. of Data units = 10, Address Gap = 8). 

  ► The Scope Trend graph does not display correctly. 

  ※ Note 
  The Address is determined by the Pen data type.  

 
  Ex) #1 Pen's data type is INT32, and its Data Count is 10 data units. 

Those 10 Data units are INT32, so the Address is determined by 10 units of INT32 data.  

 

 
< Pen Configuration> 
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 Address or Tag 

Select the Address or Tag for each Pen. 

 Comment 
The comment will be used instead of the Tag name when displaying the Tag value. 

 Max/Min Value 

Not Applicable. 

The Scope Trend feature controls the Max/Min value. 

 Pen Color 

Select the Pen color.  Click on the color to bring up the color palette. 

5) Grid Setting 

A Grid can be included in a Trend Graph. You can set the Number of Grid lines on the X 
or Y Axis up to a Maximum of 99, and select the Grid color. 
 

6) Y-Axis Legend 

 Max/Min Value 

Display the Max/Min values on the Y-axis. 
 

 Legend Size 

Set the size for the Y-Axis Legend. 
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7) X-Axis Legend 

Display first and last X-Axis data numbers. 
 

 

 
< X-Axis Legend > 

 

8)  Scope Option 

 Data Point 
Data is displayed as Points on the Trend Graph, connected by the graph lines. The 
point size unit is Pixels. 

 

 Draw Border 
An exterior Border is drawn around the graph.   
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< Scope Option > 

9) Scope Tag 

 

 
 

 

 Control Bit  
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Xpanel uses the Control Bit either Tag or Real Address) for its internal purposes. The 
Control Bit is Set automatically when Xpanel read data from the PLC.  The user does 
not need to change it. 

 

※ Leave the Control Bit blank when the Datalog Model is used. 

※ The Control Bit must be a Real Digital Tag when reading real device (PLC) 
memory. A Virtual Tag cannot be used for a Control Bit. 

 
 Screen Control  
Screen Control is used to update or delete the Trend Graph. A Real Address or Tag 
must be selected. Screen Control values and operation are shown below. 
 

Screen Control Operation 

2 Clear a Trend Graph 

3 Update a new Trend Graph 

 

 Data Count 
Data Count is the number of units of of data that each pen will display on the Trend 
Graph. The Maximum Data Count is 2048.  Data Count is not used with Datalogging. 
 

 Min/Max Value 

Select a Tag or Real Address for displaying the Min. or Max. value on the  Y-axis. 
 

 Block Number 
Data logging only --   select the number of the Data logging Block that will provide 
the data used on the Graph. All data from the Data Block will be displayed.  The 
Maximum number of pens is 8. If the Datalog Model contains more than 8 Tags or 
Addresses, Scope Trend can display only the first 8 Pens. 

 

※ When using  data from a PLC or the Device's memory, the Block Number is not 
used. 
 

 

10) User Control Button  
To control the Trend Graph, you can create your own control button. The Scope Trend 
Graph does itself not include any Control Buttons. 

 

 Control Button(Key Input) 
 

Create a button object, then go to [Touch][Key input]. Select Up, Down, Left, 
Right or Home. 
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 Key Input Type 

 

Key Input 
type Operation 

UP 
Zoom in on the X-axis. The range of data shown is decreased by 50%. 

The maximum Zoom-in is 1000% 

DOWN 
Zoom out on the X-axis. The range of data shown is increased by 50%. 

The maximum Zoom-out is 1000% 

LEFT Move back one screen. 

RIGHT Move forward one screen. 

HOME Return to the initial Trend Graph view (No Zoom-in or Zoom-out) . 

 

  

※ Note 

 

 When the Scope Trend page is in the process of being opened or is already opened, the 
Scope Trend can be updated by changing the Control Tag Value to 3. 

 During the time that the Scope Trend is being updated, reading the trend data will have 
priority as far as communication goes. This means that Tag operations, such as PageOpen, 
Write Tag Value, etc., may be delayed momentarily. Please wait until after the Scope Trend 
update to execute any touch operations. 
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17.1.3 SPC Trend 

The SPC Trend displays a simultaneous aggregate of Data. The main difference is that the Scope 

Trend displays data sequentially, but the SPC Trend displays it using X,Y-coordinates.  

 

※ After the X,Y coordinates are set, all data is displayed simultaneously on the SPC Trend.  

 

 
  

  Difference between the SPC and Scope Trends 

1) X-axis Data is graphed. 

2) The Data logging feature is not used. 

3) A Moving Point is part of the display. 
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1. Draw a SPC Trend 

Select [Draw] [ Trend Graph]. The Trend Config dialog box will appear. 
 

4) Trend Configuration : SPC 

 

 Trend Type  

Select SPC. 

 

 Display Base 

The origin of the X-axis is the Display Base. 

Ex) To display data at (X=3, Y=500), the Trend Graph would look like this: 
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5) Object Style 

Object Style changes the Background Color. Below are some examples. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6) Line Color 
Line color changes the color of the graph outline. 
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7) Pen 

The Pen Settings select the Tags or Real Addresses to be monitored. 
 

 
 

 
< Pen Address Setting > 

 

When you enter pen address settings, you must take into account the amount of data 
represented by each pen. 
 

Ex)  #1 Pen represents 10 Data units at address D0, and #2 Pen is at address D8  
(No. of Data units = 10, Address Gap = 8). 

  ► The Scope Trend graph does not display correctly. 

  ※ Note 
  The Address is determined by the Pen data type.  

 
  Ex) #1 Pen's data type is INT32, and its Data Count is 10 data units. 

Those 10 Data units are INT32, so the Address is determined by 10 units of INT32 data. 
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< Pen Configuration> 

 

 Address or Tag 

Select the Address or Tag for each Pen. 

 Comment 
The comment will be used instead of the Tag name when displaying the Tag value. 

 Max/Min Value 

Not Applicable. 

The SPC feature controls the Max/Min value. 

 Pen Color 

Select the Pen color.  Click on the color to bring up the color palette. 

 

8) Grid Setting 

A Grid can be included in a Trend Graph. You can set the Number of Grid lines on the X 
or Y Axis up to a Maximum of 99, and select the Grid color. 

 

9) Y-Axis Legend 

 Max/Min Value 

Display the Max/Min values on the Y-axis. 
 

 Legend Size 

Set the size for the Y-Axis Legend. 
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< Y-Axis Legend > 

 

 

10) X-Axis Legend 

Display the X-axis Data range. The data range is set by the SPC Tag Data Count. The 
minimum and maximum values will appear at the far points of the X-axis. If the data has 
greater X value than the Maximum, only data up to the Maximum value will be 
displayed. 
 

Ex) The X-axis Data range is from 1 to 10. 
If there is a Data point with the coordinates (X=30,Y=100), then (X=10,Y=100) will be 
displayed. 
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11) SPC Option 

 

 
 

 Using the Moving Point 
Besides the Data Pen, Moving points can be used to display moving data on 
Graphs. The Maximum number of Moving Points is 800. 
When Moving Point Trace is enabled, Moving points are supported only with a 
pre-drawn Graph. When Moving Point Trace is disabled, Moving Point can be 
drawn without a pre-drawn Graph. 
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A. Color 
Select the Moving Point Color. 
B. Size (Pixels) 
Enter the Moving Point size in pixels. 
 

 

 Using Moving Point Trace 

With this feature enabled, Moving Points can be connected by a Polyline. When this 
feature is disabled, only one point will be displayed. 
 

 
 

 Using Fixed Trace Value 

 

● Fixed Trace Value Enabled 

A maximum of 800 Trace Points can be used. If the number of Trace point 
exceeds the Max. number, additional Trace Points will not be drawn. 

 

 ● Fixed Trace Value disabled 

A maximum of 800 Tags or Real Addresses can be used to set the Trace number. 
When using Tags or Real Addresses, the maximum Trace number can be 
changed during operation. 

 

 Update Trace When X-axis Data Changed 

When the Control Tag value is 4, the Moving Point display is changed when the 
Moving point X value is changed. 

 

 Update Trace When Y-axis Data Changed 

When the Control Tag value is 4, the Moving Point display is changed when the 
Moving point Y value is changed. 
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 Data Point 
Data is displayed as Points on the Trend Graph, connected by the graph lines. The 
point size unit is Pixels. 

 

 Draw Border 
An exterior Border is drawn around the graph.   
 

 Data Connection 

Data is shown either by dots or a polyline. 
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12) SPC Tag 

 

 
 

 

 Screen Control 
This controls Trend Graph updates. A Real Address or Tag can be used.  This 
operation is executed only when the Screen Control value is changed. For example, 
the Graph is not re-drawn if the Screen Control value stays at 3. The Screen Control 
value must be changed to another value, then changed back to 3 to update the 
Graph. The table below shows Screen Control values and operations. 
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Screen Control 
Value 

Operation 

1 

Keep the current Graphs, and add a new graph. 

 
 

2 

 Delete the current Graph. 
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3 

Delete the current Graph, and redraw the Graph. 

 

4 Start Moving Point Trace (applicable only when the Moving Point Trace 
feature is enabled). 
Moving Point Trace is executed automatically by changing the X or Y 
value (applicable only when the  Update Trace option enabled). 
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5 pause Moving Point Trace (applicable only when the Moving Point Trace 
feature is enabled). 

6 Stop Moving Point Trace (applicable only when the Moving Point Trace 
feature is enabled). 

 

 Data Count 
When you enter pen settings, you must take into account the amount of data 
represented by each pen. 
 

Ex)  #1 Pen represents 10 Data units at address D0, and #2 Pen is at address D8  
(No. of Data units = 10, Address Gap = 8). 

  ► The Scope Trend graph does not display correctly. 
 

  ※ Note 
  The Address is determined by the Pen data type.  

 
  Ex) #1 Pen's data type is INT32, and its Data Count is 10 data units. 

Those 10 Data units are INT32, so the Address is determined by 10 units of INT32 data. 

 
 

 X-Axis Start Address 

The PLC Address sets the starting point of the X-axis. From that point, Addresses (of 
the same data type as the start address, and indicating the X value of each point) 
are in sequence, ending with the Data Count Number.  
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 X-axis Minimum 

This sets the minimum X-axis display value. 
 X-axis Maximum 

This sets the maximum X-axis display value. 
 Y-axis Minimum 

This sets the minimum Y-axis display value. 
 Y-axis Maximum 

This sets the maximum Y-axis display value.. 
 

 

 

 
 
 X- coordinate of Moving Point 
Set the Tag or Real Address of the Moving Point's X value. 
 Y- coordinate of Moving Point 
Set the Tag or Real Address of the Moving Point's Y value. 

 

※ Notes 

 

 When the SPC Trend page is in the process of being opened or is already opened, the SPC 
Trend can be updated by changing the Control Tag Value to 1 or 3. 

 During the time that the SPC Trend is being updated, reading the trend data will have 
priority as far as communication goes. This means that Tag operations, such as PageOpen, 
Write Tag Value, etc., may be delayed momentarily. Please wait until after the SPC Trend 
update to execute any touch operations. 
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17.1.4 ST Trend 

The ST Trend allows comparison between a Reference Graph and Real-Time Trends. The reference 

Graph is based on a sequence of data saved by the device (PLC). Real-Time data is displayed along 

with the Reference Trend.  

 

1) Draw a ST Trend 

Select [Draw] [ Trend Graph]. The Trend Config dialog box will appear. 
 

 

1) Trend Configuration : ST 
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 Trend Type  

Select ST. 

 

 Display Base 

The origin of the X-axis is the Display Base. 

Ex) To display data at (X=3, Y=500), the Trend Graph would look like this: 

 
 
 Sampling Time 
Enter the sampling time for the Pen data. 

 

 
2) Object Style 

Object Style changes the Background Color. Below are some examples. 
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3) Line Color 
Line color changes the color of the graph outline. 
 

 
 

 

4) Pen 

Enter the pen settings for the Reference Graph.  Pen numbers represent consecutive 
addresses with offsets, all the way up to the Data Count. The Tag type must be Real. 
The Reference Graph has X,Y coordinates. This means that pen addresses consist of two 
Words. Address configuration is shown below. 

 

 
< Pen Address > 
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The Pen number that you select in Pen Configuration represents a Tag or Address. 
 

 
 

 
< Pen Configuration> 

 

 Address or Tag 

Select an Address or Tag for each Pen. 

 Comment 
The comment will be used instead of the Tag name when displaying the Tag value. 

 Max/Min Value 

Not Applicable. 
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The ST feature controls the Max/Min value. 

 Pen Color 

Select the Pen color.  Click on the color to bring up the color palette. 

5) Data Count Tag 

The Data Count Tag defines the consecutive Address numbers for each pen. The 
number of Data Count Tags increases as the number of Pens increases. If 4 Pens are 
used, then 4 Data Count Tags are used.  
The consecutive address number of each Pen is based on the value of the Data Count 
Tag. The Tag or Address must have an even value. This is because each Pen's data has 
both an X and Y value. If the Tag or Address value is odd, “value -1” will be displayed on 
the Graph. 

 

 

 

6) Grid Setting 

A Grid can be included in a Trend Graph. You can set the Number of Grid lines on the X 
or Y Axis up to a Maximum of 99, and select the Grid color. 

 

7) Y-Axis Legend 

 Max/Min Value 

Display the Max/Min values on the Y-axis. 
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 Legend Size 

Set the size for the Y-Axis Legend. 
 

 

 

 

 

 

 

 

 

 

 

< Y-Axis Legend > 
 

8) X-Axis Legend 

Display Time information on the X-axis. A variety of formats are supported.  
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9) ST Option 

 

  Trace Point 

 Color: Select the Trace Point color. 

 Size (Pixels) : Select the Trace Point size. 
 

  Data Point 

 Size (Pixels) : Select the Data Point size. 
 

 Draw Border 
Draw a border around the graph.   

 

 
10) ST Tag 
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 Control Bit  
Xpanel uses the Control Bit either Tag or Real Address) for its internal purposes. The 
Control Bit is Set automatically when Xpanel read data from the PLC.  The user does 
not need to change it. 

 

※ Leave the Control Bit blank when the Datalog Model is used. 

※ The Control Bit must be a Real Digital Tag when reading real device (PLC) 
memory. A Virtual Tag cannot be used for a Control Bit. 

  
 ST- Control  
Update or delete the Trend Graph. A Real Address or Tag is selected. The Screen 
Control codes are shown below: 
 

Control Value Operation 

2 Clear the Trend Graph and initialize the Trace Graph. 

3 Update a new Trend Graph and initialize the Trace Graph. 

4 
Start a Trend Graph. If the Reference Graph has not been 
drawn, the Trace Graph will not start. 

5 Pause a Trace Graph (cumulative data is kept). 

6 Finish a Trace Graph (cumulative data is deleted). 

 

 ST-Trace Point 
Select a Trace Point Tag or Address. 

 
 ST-Minimum  
Select a Tag or Address to set the minimum value of the Graph.  A fixed minimum 
value can be used. 

 
 ST-Maximum  
Select a Tag or Address to set the maximum value of the Graph.  A fixed minimum 
value can be used. 

 
 ST-Trace Display Time 
Select a Tag or Address to set the maximum time on the X-axis. 

 

※ Note 

 

 When the ST Trend page is in the process of being opened or is already opened, the ST 
Trend can be updated by changing the Control Tag Value to 3. 

 During the time that the ST Trend is being updated, reading the trend data will have priority 
as far as communication goes. This means that Tag operations, such as PageOpen, Write 
Tag Value, etc., may be delayed momentarily. Please wait until after the ST Trend update to 
execute any touch operations. 
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17.1.5 LOG Trend 

Real-time data is logged and displayed on a Trend graph as it comes in. Each pen can support 

multiple channels, and Data logging can be Period or Trigger. The logged data can easily be exported 

as a CSV file.  The LOG Trend graph is useful when both the Data logging and Trend features are 

needed. 

※ However, the LOG Trend graph does not support Historical Mode for Data logging. Pre-logged 

data cannot be read and displayed using the LOG Trend graph. 

 

The LOG Trend graph support a maximum of 16 Pens. The maximum amount of sampling data 

for each pen is 800, so only the most recent 800 units of data will be displayed. 
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 A maximum of 16 channels is supported.  

 
Ex)  With 4 pens used,  
The Y axis is divided into 4 areas. The first pen uses the region at the top. 

 

※ A Control Tag is used to update LOG Trend sampling data. 

 

 

 
1. Draw a LOG Trend 

Select [Draw] [ Trend Graph]. The Trend Config dialog box will appear. 

 
1) Trend Configuration : Log 

 

 Trend Type  

Select Log. 

 

 Display Base 

The origin of the X-axis is the Display Base. 
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A. Display Base – Left 

 

B. Display Base – Right 

 

 File Saving 

When File Saving is enabled, the logged data is automatically saved as a CSV file. 

One CSV file can save around 30000 units of data. If the data exceed 30000 units, a 

new CSV file will be created. If storage space is insufficient, the oldest CSV file is 

deleted and the newest file is saved. The storage options are Internal memory, SD 

Memory, and USB Memory. 

2) Object Style 

Object Style changes the Background Color. Below are some examples. 
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3) Line color changes the color of the graph outline. 
 

 



 

297 Chapter 17. Trend Graph 

 

 Initial Drawing Type 

The Initial Drawing Type can be Fixed Pen or Moving Pen. This affects the initial appearance 

of the graph, but eventually, the difference will no longer be apparent. 

A. Fixed Pen 

-The latest Data is updated on the Display Base axis. 
B. Moving Pen 

- The latest Data is updated at the end of the Pen. 

 

 

4) Pen 
 The Pen Settings select the Tags or Real Addresses to be monitored. 

 

 Pen Setting 

Select Pen number from Pen Settings to select the Tag or Address. 
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A. Address or Tag 

 

A Real Address or Tag can be selected for each Pen. 

B. Comment 

The comment will be used instead of the Tag name when displaying the Tag 

value. 

C. Max/Min value 

Set the Max. and Min. value of the Trend graph's Y-axis. 

 For a Single Channel  

The Max/Min value of each Pen is used in the Trend Graph, but not for the Y-

axis display. Only the #1 Pen displays its Max/Min value on the Y-axis.  

 For Multiple Channel 

The Max/Min value is displayed on each channel. if the Max/Min Value is not set 

in the Tag type setting, the Max/Min Value from  Engineering Data [CIMON] in  

the Database will be used (For Addresses, the Max/Min value is based on the 

Data Type). 

D. Pen Color 

Select the Pen color.  Click on the color to bring up the color palette. 
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4) Grid Setting 

A Grid can be included in a Trend Graph. You can set the Number of Grid lines on the X 
or Y Axis up to a Maximum of 99, and select the Grid color. 

 

 
 

 Display Grid 

With the Display Grid feature enabled, the Grid Number and Color can be changed. 
5) Y-Axis Legend (Max/Min Value) 
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6) X-Axis Legend 

The Log Trend graph displays the Number of Data units on the X-axis, rather than time. 

 

 

7) Log Option 
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 Buffer Size 

This sets the number of Sampling Data units. The Trend Graph displays data based 
on the Buffer size.   
 

 Sampling Type 

 

(1) Periodic 

Data is sampled and displayed periodically. 

 

(2) By Trigger 
Each time that the Trigger Tag status changes from Off ON, data is logged and 
displayed on the graph. 
 

 
 

 

 

 Control Tag 

The Control Tag is used to control (Start,Stop,initialize) the Graph. A Real Address or 
Tag is used for the Control Tag. 
 

Control Tag Value Operation 

0 Start Data logging & drawing a Trend Graph. 

1 Stop Data logging & drawing a Trend Graph. 

2 

Initialize Data logging & drawing a Trend Graph. Once 
initialization is executed, Data logging & Drawing the Graph 
stop. 

 

 

 Data Point 
Data is displayed as Points on the Trend Graph, connected by the graph lines. The 
point size unit is Pixels. 
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 Using Multi-Channel 
Each Pen can be monitored separately using the Multi-Channel feature. 
 

 
  

 Draw Border 
Draw a border around the graph.   
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※ Notes 

 

 When there is too much data (Pen＊Buffer size) to display on the Screen, the Trend Screen 
Update can be slowed down. 

 The Min/Max value of each Pen can overlap when using many pens with multiple channels. 

 

17.1.6 XY Trend 

Real-time data is logged and displayed using XY coordinates on a Trend graph as it comes in. The 

difference between Log Trend and The XY Trend Graph is that The XY Trend Graph includes X 

coordinate information. The XY Trend Graph supports Historical Mode by means of the File Saving 

feature; it can read and display previously waved data. The Zoom In/Out feature is not supported. 

 

To display logged data on a Trend Graph, an X coordinate must be set in the XY Trend Graph. 
This means that the logged data is on the Y coordinate. Data is displayed on the Trend Graph 
using two methods: Trigger and Periodic.  
 

The Buffer sets the maximum number of data units to be displayed on the Trend Graph for 
each pen. The maximum Buffer size is 800 units of data. After the amount of data exceed 800 
units, the oldest data is deleted. 
 

 



 

Chapter 17. Trend Graph 304 

 

1. Draw a XY Trend 

Select [Draw] [ Trend Graph]. The Trend Config dialog box will appear. 

1) Trend Configuration : XY 

 

 Trend Type  

Select XY. 
 

 File Saving 

When File Saving enabled, the logged data is saved as a Binary file, providing 

support for Historical Mode.  In Historical Mode, previously saved data is read and 

displayed on the Trend Graph. One Binary file can save up to 10000 samples of data. 

If the number of samples 10000, a new Binary file is created. If storage space is 

insufficient, the oldest file will be deleted and a new file created. 

 

※XY Trend does not support saving data as a CSV file. 
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2) Object Style 

Object Style changes the Background Color. Below are some examples. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3) Line Color 
 Line color changes the color of the graph outline. 
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4) Pen  
  The Pen Settings select the Tags or Real Addresses to be monitored. 

 Pen Setting 

Select the Pen number, then the Tag or Real Address. 

 

 
 

A. Address or Tag 

Select the Real Address or Tag for each Pen. 

B. Comment 

The comment will be used instead of the Tag name when displaying the Tag 

value. 
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C. Max/Min value 

Set the Max. and Min. values on the Y-axis of the Trend graph. The Max/Min 

value of each Pen will be used on the Trend Graph, but only the #1 Pen's 

Max/Min value will be displayed on the Y-axis. If the Max/Min Value is not set in 

the Pen Settings, the Max/Min Value from the Engineering Data [CIMON] in the 

Xpanel Database will be used. 

(With Addresses, the Max/Min value depends on then Data Type). 

D. Pen Color 

Select the Pen color.  Click on the color to bring up the color palette. 

 

 

5) Grid Setting 

A Grid can be included in a Trend Graph. You can set the Number of Grid lines on the X 
or Y Axis up to a Maximum of 99, and select the Grid color. 

 

6) Y-Axis Legend 

 Max/Min Value 

Display the Max/Min value on the Y-Axis. 
 

 Legend Size 

Control the size of the Y-Axis Legend. 
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7) X-Axis Legend 

  Display the Max/Min value on the X-axis. 

 



 

309 Chapter 17. Trend Graph 

 

8) XY Option 

 

 

 Buffer Size 

The Buffer memory is used for logging data. The Maximum Buffer size is 800 units of 

data, and a maximum 800 data units can be displayed on one graph. If the data 

exceeds that limit, the oldest data is deleted. 

 Sampling Type 

 

(1) Periodic 

Data is sampled and displayed periodically. 

 

(2) By Trigger 
Each time that the Trigger Tag status changes from Off ON, data is logged and 
displayed on the graph. 
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 Control Tag 

The Control Tag is used to control (Start,Stop,initialize) the Graph. A Real Address or 
Tag is used for the Control Tag. 
 

Control Tag Value Operation 

0 Start Data logging & drawing a Trend Graph. 

1 Stop Data logging & drawing a Trend Graph. 

2 
Initialize Data logging & drawing a Trend Graph. Once 
initialization is executed, Data logging & Drawing the Graph 
stop. 

 

 X-Axis Data Tag 

Designate a Tag or Address for data logging (collecting) data on the X-axis. 

 

 
 

 Data Point 
Set the Data point size. 
 

 
 Draw Border 

Draw a border around the graph.   
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 Data Connection 

 

 

 Display Time 

Display Time information at the top of the Graph. 
 

 
 

 

9) XY Min/Max 

 

 Min/Max value on X-axis 

Set the minimum and maximum values of the X coordinate. 

 

(1) Using Fixed Value 

Set the maximum and minimum X coordinates as Fixed values. 
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(2) Tag or Address 

To set a Tag or Address as the Min/Max X coordinate. The Min/Max value can 
be changed during an operation. 
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10) Historical Mode 

Historical Mode is supported by means of the Control Button. 
 

 

 Creating a Control Button 

 

Create a button Object, and configure the [Touch][Key input] operation. Select Up, 
Down, Left, Right, or Home as the Key Type. 

 

 
 

 

 Key Input Type 

 

Key Input type Operation 

Tab Change between Real-Time and Historical Modes. 

Right Move back one screen. 

Left Move forward one screen. 

 

 

※ Notes 
 

 When there is too much data (Pen＊Buffer size) to display on the Screen, the Trend Screen 
Update can be slowed down. 

 When using the Control Button (Key Input), only one Trend Graph Object can be included 
on a Page. 

 Using more than 2 Trend Graphs with the Alarm Summary, Data logging, and Key Input 
Object may cause a Trend Graph error. 
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Chapter 18.  Security Configuration 

 

Security 

 

The security system is used to give each logged-in user a security level, and to limit access to 

control and monitoring functions which require a higher security level than the user has.  

 

 
 

Security feature applies to all Pages and Touch operations. When a user changes pages or 

performs a Touch operation, Xpanel compares the Security level of the logged-in user and of the 

operation. If the Security level of the logged-in user is lower than that of the operation, the 

operation is not executed. 

 

 

18. 1. 1   

 

Select [Tools]  [Security] or click on the icon                                       in the Drawing Toolbar.  

Security configuration allows you to set the USER, Security Level, Password and Log ON/OFF 

Action features. 

 

 1. Enter a New User 

 Select New User in Security Configuration to enter a new user. 
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 (1) User ID 

 Enter the User ID. Duplicate IDs are not allowed. 

 

(2) Level 

Select the security level. Level 10 has the highest (greatest) authorization, and Level 0 has the 

lowest. 

 

(3) Password 

Enter the password. 

 

(4) Description 

Descriptive information regarding the user. 

 

(5) Log On Action Script 

You can enter a Command Expression to be executed when the user logs on. 

 

Ex)  PageOpen(“Main”); 

The Main page will be opened when the user logs on. 

 

(6) Log Off Action Script 

You can enter a Command Expression to be executed when the user logs off. 

Ex) PageOpen(“LogOn”); 

The LogOn page will be opened when the user logs on. 
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18.1.2 User Log On/Off 

 

The Script Function ‘LogOn’ is required in order for users to log on. There are two types of 

“LogOn” function. 

 1. “LogOnWin” script. 

 

With the Script Function “LogOnWin”, the user enters a User ID and Password directly 

into the LogOn window to log on. 

 

   1) User Registration 

  Register a new ID in Security Configuration. 

 

2) Run Command Expression 

 

Create a button to run a Command Expression or use a Script Function 

“LogOnWin()”. 

 

Ex) Create a button by means of a Command Expression 

 

(1) LogOn button by Command Expression. 

 

Draw a rectangle object (Log On button) and double click on it. 

Select [Touch] and [Command Expression] as the Actions.  

Enter the script “LogOnWin()”  in the Command window, as shown below. 
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(2) Execute LogOn Button 

When you click on the Log On button, the Security window pops up. 

 

 

 

 

 

 

 

  

  

    User ID 

Select the User ID. 

 

 Password 

   Enter the password. 

   If the password is incorrect, the following message will appear: 

 

     
   

If the log on process is successful, all features with a security level lower than 

that of the user will be available. 
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  2.  “LogOn” script 

The LogOn() Command Expression can be used for entering the User ID and Password 

directly. 

 

(1) Create a Button for the Command Expression 

 

Draw a rectangle object (Log On button) and double click on it. 

Select [Touch] and [Command Expression] as the Actions. 

Enter the script “LogOn(“Manager”, “1234”);”  in the Command window, as 

shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the log on process is successful, all features with a security level lower than 

that of the user will be available. 

 

● Without User ID 
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   ● With Invalid Password 

 
 

  3. Log off using the “LogOff()” script. 

 

The “LogOff()” script must be used to log off the user. When the status changes to log-

off, security returns to Level 0.  

 

(1) Create a Button For “LogOff()” 

 

Draw a rectangle object (Log On button) and double click on it. 

Select [Touch] and [Command Expression] as the Actions.  

Enter the script “LogOff()”  in the Command window. 

 

 

  

18.1.3 Security Level Settings 

 

 1. Configuring the Page Security Level 

  

Each page of Xpanel can have its own Security level. When executing a Page Transition,  

a User with a lower Security Level will not be able to open a page with a higher Security 

Level. 

 

  1) Modify Page Security Level 

 

Select [Tools]  [Page Setup] or select Page Properties from the right-mouse-

click menu. 

Select a Security level from 0 to 10. 
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 2) Touch and Entry Data Security Configuration 

 

Security levels can be set for any object which has the Touch or Entry Data 

property. User with a lower Security level cannot use an object with a higher 

Security level.  

 

Select Touch or Entry Data at the Object Configuration. 

 

 
    

Select the [Security] tab and set the Security Level. 
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The following Error message will appear if the Security Level of the User is lower 

than that of the Touch Object. 
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Chapter 19.  Multiple Language 

 

19. 1  Multi-Language Support 

 

Xpanel Supports multiple languages, and multiple languages can be used on a single page. 

 

 

 

19.1.1 How to enter multiple languages on a page 

 

1. Using the IME 

 

To use multiple languages in Window, you must first add each language in the Region and 

Language Control Panel. 

 1) How to add a language (based on Win7) 

Select the language to be added from [Control Panel] [Clock, Language and 

Region][Region and Language][Keyboards and Languages][Change Keyboards]. 
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Select the Language and Keyboard to be used under Add Input Language. 
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2) Select the Language  

Select one of the language from the Language bar as shown below. 

 

 

3) Select a Font in XpanelDesigner 

To use multiple languages, each language font must be installed. Without the installed 

language font, characters will not display properly. 

Select the appropriate font in the Font Tool's Font setting. 

 

 
 

 

19.1.2 The Multiple Language Table 
 

 1) Multiple Language Settings 

  

To use the Multiple Language Table, Fonts must be installed in advance. 

 Select [Tools][Multiple Language Setup] and select the language and font. 
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 2)  Create a Multiple Language Table 

 

  (1)  Column Language Settings 

   

The Multiple Language Table uses the Multiple Column String Table. 

Select [Tools]  [String Editor] and select the language for each column. 
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  (2) Column  

 

Click Add String Group, then Multiple Column; a String Group for multiple columns will 

be created. 

 

 

Enter words in the target language using the appropriate font in each Column. 

 

 (3) Using a Multiple Language String 

 To use a Multiple Language Table, select [Draw][Multi String]. 
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Select a Multiple Language String Group, then choose the appropriate String value. Each 

string has a string value. 

 

 

 

 

 

 

  To select a Column, use a tag from [Multi Language Setup]. 

 



 

Chapter 20. Data Bridge 328 

 

Chapter 20.  Data Bridge 

 

20. 1   Data Bridge 

 

Xpanel serves as Data Transfer Bridge between two devices when there is no direct communication 

between them. To use the Data Bridge feature, both Devices must communicate with Xpanel at the 

same time. The Source sends Data, and the Destination receives the Data. If Xpanel is communicating 

with the Source by RS232C, then Xpanel must communicate with the Destination by RS232C, RS422/485 

or Ethernet.  

 

 
 

20.1.1 Use Data Bridge 

 

Select [Tools][Data Bridge] or click on Data Bridge icon  from Main Toolbar. 

 

  

1.   Adding a Data Bridge Model 

 

Go to Data Bridge Configuration, and select [Add Data Bridge Model]   to add a new 

model. 
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Icon Menu Description 

 
Add Data Bridge Model Add a new Data Bridge Model. 

 
Edit Data Bridge Model Edit the selected Data Bridge Model. 

 Delete Data Bridge Model Delete the selected Data Bridge Model. 

 
Add Data Bridge Tag 

For a Tag-based Model, enter the Tag or Address 
for the Source and Destination. 

 Edit Data Bridge Tag 
For a Tag-based Model, edit the Tag or Address 
for the Source and Destination. 

 
Delete Data Bridge Tag Delete the selected Data Bridge Tag. 

 

1) Create a Tag-based Data Bridge 

Select The Tags or Addresses to be synchronized directly with each other and save the 

settings. 

 (This is useful when there isn't much Data to be synchronized) 

After you configure the Model, you must enter the Tag or Address of the Source and 

Destination. 
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(1) Model Name 

 

   Enter the Data Bridge Model name. 

 

   (2) Model Type 

 

    Tag Base –   Select Tag based Data for synchronizing. 

 

   (3) Synchronizing Property 

 Always – Source and destination values are synchronized immediately when 

the Tag or Address Data is changed. 

 

 Trigger - Source and destination values are synchronized when a Trigger Tag 

or Address changes from OFFON. 

 

 Periodical - Source and destination values are synchronized periodically. 

 

(4) Edit Bridge Tags 

 

Set the Original tag and the Target tag to match. 

 

 
 

The Tag or Address of the Original Device is transferred to the Target Device, 

and both are synchronized. 
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2) Create a Block-Based Data Bridge 

 

Set the data to be synchronized by Block. With a Block based Model, Blocks (consisting 

of consecutive Addresses) can be transferred in bulk. This is useful for Data 

synchronization in bulk. 

 

 

 

 

 

 

 

 

 

 

 

  

    

(1) Model Name 

    

   Enter the Data Bridge Model name. 

 

   (2) Model Type 

 

    Block Base –   Data is synchronized by Block. 

 

   (3) Synchronizing Property 

 

 Trigger - Source and destination values are synchronized when a Trigger Tag 

or Address changes from OFFON. 

 

 Periodical - Source and destination values are synchronized periodically. 
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(4) Block Properties 

 

 Block Size 

Enter the consecutive Address size (Block Size) for the Block. This address size 

will be based on the data type at the beginning of the block. If the Block starts 

with a DWORD (INT32, Float), the address size will be counted as DWORD. This 

means that a size of 100 for a block beginning with DWORD data would be the 

equivalent of a 200 WORD block. 

 

 Source Block Start 

Enter the Start Tag or Address of the consecutively-addressed Block. 

 

 Source Handshake 

 

 
 

Source Handshake is a Data Bit which is used internally when Xpanel transfers 

Data. The I/O Device and Digital Tag must handshake properly with the Source. 

(Before reading the Source Block Data, the Data Bit is set as 1. After the reading 

process, the Data Bit is changed to its initial state, 0) 

 

 Destination Block Start 

 

 
 

Enter the Destination Start Tag or Address for receiving Block Data from the 

Source. 
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 Destination Handshake 

 

 
Destination Handshake is a Data Bit which is used internally when Xpanel writes 

Data. The I/O Device and Digital Tag must handshake properly with the 

Destination. 

(Before reading the Destination Block Data, the Data Bit is set as 1. After the 

writing process, the Data Bit is changed to its initial state, 0) 

 

  3)  Data Bridge For Uploading Device Data To System Memory. 

 

Uploading Data to Sys-Mem reads Data from another Device (Source) to Xpanel's 

System memory and Synchronizes it. System Memory becomes the Destination and 

receives the Data. 
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(1) Model Name 

    

   Enter the Data Bridge Model name. 

 

   (2) Model Type 

 

 Upload Data to System Memory –    Read data from a PLC or other Device to 

Xpanel's System Memory and synchronize it. 

   (3) Synchronizing Property 

 

 Trigger - Source and destination values are synchronized when a Trigger Tag 

or Address changes from OFFON. 

 

 Periodical - Source and destination values are synchronized periodically. 

    

(4) Block Property 

 

 Block Size 

Enter the consecutive Address size (Block Size) for the Block. This address size 

will be based on the data type at the beginning of the block. If the Block starts 

with a DWORD (INT32, Float), the address size will be counted as DWORD. This 

means that a size of 100 for a block beginning with DWORD data would be the 

equivalent of a 200 WORD block. 

 

 Source Block Start 

Enter the Start Tag or Address of the consecutively-addressed Block. 

 

 Source Handshake 

 

 
 

Source Handshake is a Data Bit which is used internally when Xpanel transfers 

Data. The I/O Device and Digital Tag must handshake properly with the Source. 

(Before reading the Source Block Data, the Data Bit is set as 1. After the reading 

process, the Data Bit is changed to its initial state, 0) 
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 System Memory Start Address 

 

 
Data is transferred to Xpanel's System Memory and synchronized, beginning 

with the Start Address of System memory and ending at a location determined 

by the Block size.  

 

 

 

  

4)  Data Bridge for Downloading (Writing) from System Memory to a Device or PLC 

 

The Data Bridge makes it possible to write System memory data to other Devices or 

PLCs. 

Download Data From Sys-Mem writes or transfers Data from System Memory to a 

Destination such as a Device or PLC and synchronizes it. System Memory becomes a 

Source and writes Data to the destination device. 

 

 

 



 

Chapter 20. Data Bridge 336 

 

(1) Model Name 

    

   Enter the Data Bridge Model name. 

 

   (2) Model Type 

 

 Download Data From System Memory –    Transfer data from Xpanel's system 

Memory to a PLC or other Device. 

 

   (3) Synchronizing Property 

 

 Trigger - Source and destination values are synchronized when a Trigger Tag 

or Address changes from OFFON. 

 Periodical - Source and destination values are synchronized periodically. 

    

(4) Block Property 

 

 Block Size 

Enter the consecutive Address size (Block Size) for the Block. This address size 

will be based on the data type at the beginning of the block. If the Block starts 

with a DWORD (INT32, Float), the address size will be counted as DWORD. This 

means that a size of 100 for a block beginning with DWORD data would be the 

equivalent of a 200 WORD block. 

 

 Destination Block Start Address 

Enter the Start Address of the PLC.  

The PLC (Destination Block) receives Data from Xpanel's System Memory. 

 

 
 

 Destination Handshake 
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Destination Handshake is a Data Bit which is used internally when Xpanel writes 

Data. The I/O Device and Digital Tag must handshake properly with the 

Destination. 

(Before reading the Destination Block Data, the Data Bit is set as 1. After the 

writing process, the Data Bit is changed to its initial state, 0) 

 

 System Memory Start Address 

 

Data is transferred to the Destination and synchronized, beginning with the 

Start Address of System memory and ending at a location determined by the 

Block size.  
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Chapter 21.  VNC (Remote Control) 

 

21. 1   VNC 
 

The VNC feature makes it possible to remotely control and monitor Xpanel using an Ethernet Network. 

If a Public IP is assigned to Xpanel, the User can monitor and control Xpanel using a Smart Phone or PC 

via Wi-Fi, 3G and LTE. 

 

 

21. 1. 1   Using the VNC Feature 

 
 1.  VNC Network Configuration 

  

The VNC feature requires connection to an Ethernet Network. VNC allows only one device to 
have a remote connection to Xpanel at s time. This means that only one PC or Smart Phone can 
access Xpanel (1:1). If more than one Smart Phone or PC is connected to Xpanel at the same 
time, only one of them will be able to access Xpanel. 
 

 1) Local Ethernet Network 
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A Local Ethernet Network uses its own Ethernet Network locally without using the 
Internet. This allows a Smart Phone or PC to be connected to Xpanel through a wireless 
Router using the same Network IP. 

 

2) Public IP Ethernet Network 

 

If a Public IP (THIS IS NOT RECOMNNEDED) is assigned to Xpanel, a PC can access 
Xpanel anywhere using the Internet. Using Wi-Fi or 3G or LTE, a Smart Phone can 
access Xpanel. A portable wireless device (Smart phone or tablet) can access Xpanel 
using 3G, LTE or Wi-Fi service. 
 

3) The VNC feature on a Smart Phone 

   

The VNC feature provided by XpanelDesigner can be used on a PC without requiring any 
special program. For a Smart Phone or tablet, however, the VNC application must be 
installed to connect to Xpanel. The user can download the VNC Applications from the 
Apps Store, either for IPhone or an Android Phone (Paid or Free). With free Apps, most 
VNC features will be supported. 
 

 

 2.  VNC Network Configuration 

 

 1) Run VNC Server  

 

Xpanel's VNC Server must be running in order to access Xpanel. There are two methods of 
running VNC server. 

 

  (1) Run VNC Server on XpanelDesigner 
 

   Click [Online]  [Setup Link]. 
 

 

 

Select Ethernet, and click on [Select Xpanel].  
Select the Xpanel IP address for connecting. 
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   Click [Online]  [Run Remote Control Server]. 
 

 
 

  (2) Run the VNC Server on Xpanel 
 

   Run Xpanel Config 

 

   
The Xpanel Config window appears when you touch three corners of the screen in the 
sequence shown above. 
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  Click on the [Exit] button to bring up the Xpanel Desktop. 
 

  

   Run Ethernet Loader Config 

 

 
  Click on the [Config] button in the Ethernet Loader Configuration dialog box. 
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  Select [Run VNC Server] to run the VNC server. 
If [VNC activates as Ethernet Loader starts] is selected, the VNC Server runs 
automatically when Xpanel is turned on. 

 

 

 2) Run VNC Viewer 
 

  Click [Online]  [Run Remote Control Viewer]. 
 

 

 

 

 

 Enter the Xpanel IP address that the VNC server is using. 
Once connection is successfully established, Xpanel can be controlled and monitored from a PC. 

  

 
<VNC Connection> 

 

 

21. 1. 2   VNC Viewer Application Settings 

 

Xpanel Remote control is possible when you install a general-purpose VNC Viewer App on a 
Smart Phone (Pocket Cloud, etc). This is because Xpanel supports ‘VNC’(Universal Remote 
Access Interface). Both Android and iOS have VNC viewer applications.  There are different 
types of VNC viewer applications, and network settings will be different for each one. 
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 <Example of VNC App Configuration>  

  

XpanelDesigner does not support the “Password” function.  
Therefore, just click “OK” to connect to the Xpanel VNC Server. 
 

 
<VNC Viewer Connected> 
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  Applicable VNC Applications 

  

All Smart Phone Apps with the Universal Remote Access Interface can access Xpanel.  Xpanel 
does not recommend any special Apps. Some Android VNC Applications, however, do not 
support 16 Bit Color, which can cause problems. 
 

These Free Applications have been tested for compatibility: 
 

 IPhone : Pocket Cloud 

 Android : Mocha VNC Lite 

 

 

21. 1. 3   VNC Notes  
 
 1. Security 

  

Users must be careful about VNC Security in Xpanel. It is recommended that VNC access 
permission be set up on Xpanel. Create a ‘VNC Sever ON/OFF’ button object with 
[Touch][ Command Expression] property.  Using this button, the user can run/close the VNC 
server from Xpanel. If permission is given to access Xpanel from the outside, the VNC server will 
run. Without permission, the VNC server will close. 
 

 Script (in Command Expression) to close the VNC Server 
RunApp(“Xpanel\Bin”\XVncClose.exe”,””) 
 

 Script (in Command Expression)  to run the VNC Server 
RunApp(“Xpanel\Bin”\XVncServer.exe”,””) 

  
 

2. Remote Control 
 

The principle of VNC is Remote Control. Remote Control of Xpanel is identical to on-site control. 
If the user executes a Page Transition or Button Operation from a remote location, the result 
will be the same as performing the same operation on site.. 
 

3. 1:1 Access 

 

Only one local device is allowed to access the Xpanel VNC Server at a time. If a user logs in  to 
the VNC Server from one location, all other access to VNC Server is denied. Accordingly, the VNC 
Viewer must be shut down in order to allow any other access.   
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Chapter 22.  System Memory 

 

22. 1   System Memory 

 

System Memory is virtual memory that consists of consecutive Address. System Memory is set up like a 

Real Tag, but operates like a Virtual Tag. Up to 10000 consecutive addresses can be used. 

 

22.1.1 System Memory Settings 

 

 1. System Memory Size Settings 

  

 System Memory size can be varied. 

 Click [Tools]  [Project] to set System Memory Size. 

 

 
 

 2. Create a System Memory Tag in the Database 

  

 A Tag must be saved in the Database in order to set the System Memory data value.  
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(1) Type 

System Memory uses two types of Tag (Analog and Digital). 

 

  Digital Tag 

 A Digital Tag becomes 1 when the Address value is greater than 0. 

 

  Analog Tag 

 An Analog Tag has the same data type as a general Analog Tag. 

 

(2) Real Tag 

The Tag type can be set as Real Tag even though System Memory uses internal and 

virtual memory. 

 

  I/O Device 

Select ‘System Memory’ for the I/O Device.  System Memory is listed as the 

default. 

 

    I/O Address 

An Address is assigned between 0~9999 (Address range can be vary depending 

on System Memory Size Configuration). 
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22.1.1 How to use System Memory  

 

System Memory can be used by itself, but it can be used for a variety of purposes by means of Script 

Functions. 

 

 1. Usage as Recipe Data 

System Memory can be used for Recipe Data. This will allow you to edit Recipe Data more 

flexibly. In order to edit Recipe Group Data in a Recipe Configuration file, you would otherwise 

use the Configuration Dialog box Function. But Recipe Group Data editing is possible by 

modifying the Tag data for the corresponding Address in System Memory.  

 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

You can use Script Functions to control System Memory; this does not require the Recipe Configuration 

File. To use System Memory for Recipe data, divide consecutive Addresses into Groups. Addresses can 

then be assigned based on the number of units of data in each group. Data can consist of Tags, which 

makes data management convenient, since Tag values are easy to change. Additionally, Recipe Group 

data is backed up. 
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1) Script Functions for using System Memory for Recipes 

  RcpGetSysMem(S1, R2) : Copy one block of System Memory to Xpanel's internal Recipe 

Memory. The number of data units to be transferred is equal to the Data Number setting from 

the Recipe Model Configuration dialog box. 

S1 :  Recipe Model name 

 R2 :  System Memory Address 

 Ex) RcpGetSysMem(“ICECREAM”, 100); 

Copy a block of Data into Xpanel's internal Recipe Memory starting from System 

Memory address 100, with the block size defined by the Data Number setting in 

“ICECREAM”. 

  RcpSetSysMem(S1, R2) : Copy one block of Xpanel's internal Recipe Memory to System 

Memory. The number of data units to be transferred is equal to the Data Number setting from 

the Recipe Model Configuration dialog box. 

S1 :  Recipe Model name 

 R2 :  System Memory Address 

  

 2. System Memory Related Functions 

1) SysMemMove(R1, R2, R3) : Copy data from one area of system memory to another. 

R1 : Starting Address of System Memory to be copied from 

R2 : Starting Address of System Memory to be copied to 

R3 : Number of Data 

Ex) SysMemMove(100, 200, 50) : 

Copy 50 units of data (100~149) of System Memory from Address 100 to Address 200. 

 

2)  SysMemFill(R1, R2, R3) : Write a value to the specified range of System Memory. 

 

R1 : Starting Address of System Memory 

R2 : Writing Value 

R3 : Number of Data 

Ex) SysMemFill(100, 0 100) :  

Write the value (0) to System Memory from Address 100 to 199.   

 

3)  GetSysMem(R1) : Return the data value saved in the specified address of System 

Memory. 

 

  R1 : System Memory Address 

  Ex) Rtn = GetSysMem(100) 
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  Return the data value in System Memory Address 100. 

  4)  SetSysMem(R1, R2) : Write a value into System Memory. 

   

R1 : System Memory Address 

R2 : Writing Value 

Ex) SetSysMem(100, 100) 

Write the value (100) to System Memory Address 100. 

 

5)  MakeSysMemCsv(S1, R2, R3, R4, R5) : Save System Memory to a CSV file. 

 

S1 : File header name (S1_Date and Time) 

R2 : Starting Address of System Memory  

R3 : Number of units of Data to be saved 

R4 : The number of rows in the CSV file. 

R5 : Saving location (0: Local, 1: SD/MMC, 2 :USB) 

Ex) MakeSysMemCsv(“SYS”, 100, 50. 5. 0);  

Copy Xpanel System Memory Data from Address 100 to 149 to a CSV file in internal 

Memory. Data is arranged into 5 rows. The file name consists of Header+ Date/Time. 

 

 

22.2.1 Indirect Address 

 

An Indirect Address is used to read or write data values at a noncontiguous address.   The distance 

between the Tag Address and noncontiguous (Indirect) address is the Offset. Values can be Read or 

Written using an Indirect Address even if the address is not associated with a Tag. 
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 1. How to use an Indirect Address 

 

Using an Indirect Address requires two Tags. One tag contains the Start Address, and the other contains 

the Offset. 

 

The method for using an Indirect Address is shown below. 

If the Offset Tag value is less than 0, it will be ignored. If the Offset Tag value includes a decimal point, it 

will be rounded down. 

  

 

 

 

 

  1) How to display a Tag Value (Dynamic Tag) 

   

 Start Tag Name :  WORD0 

 Offset Tag Name : OFFSET 

 Indirect Address : WORD0#OFFSET 

   

 
This makes it possible to retrieve data from the Address at the Offset distance from the 

WORD0 Tag's Address.  

 

 

 

 

Indirect Address = [Start Tag]#[Offset Tag] 
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2) Indirect Address in Command Expressions 

 

 (1) Writing a Tag Value into Indirect Address 

 

  
Write the Tag Value of DATA1 to the Address at the Offset distance from the WORD0 

Tag's Address.  

 

(2) Obtaining a Tag value from an Indirect Address 

 

 
Write the data value from the Offset address to the DATA1 Tag.  

 

2. I/O Device list for Indirect Address 

 

Indirect Addressing supports a variety of I/O Devices, as shown below. If a device is not in the 

list, Indirect Addressing is not applicable.   

 

Company I/O DEVICE Serial Ethernet 

CIMON 

CIMON-PLC  O 

CIMON-PLC HMI O  

CIMON-PLC loader O  

CIMON XPANEL  O 

Allen Bradley Allen Bradley DF1 O  

DELTA DELTA TAU PMAC Drive O  

FUJI FUJI Micrex SX O  

KEYENCE KEYENCE PLC (KV mode) O  

KOYO KOYO DirectNet O  

LSIS 

LSIS GLOFA PLC Cnet O  

LSIS GLOFA PLC Enet  O 

LSIS Master-K S-Series Enet  O 

LSIS Master-K H-Series PLC Cnet O  

LSIS Master-K S-Series PLC Cnet O  

LSIS Master-K S-Series PLC loader O  

LSIS XGT/XGB -Series PLC Cnet O  

LSIS XGT Series FEnet  O 
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MITSUBISHI 

MITSUBISHI MELSEC A Loader O  

MITSUBISHI MELSEC 1C (AnA/Anu CPU) O  

MITSUBISHI MELSEC 1C (A CPU) O  

MITSUBISHI MELSEC FX O  

MITSUBISHI MELSEC 1E  O 

MITSUBISHI MELSEC 3E  O 

MITSUBISHI MELSEC 3E (ASCII)  O 

MITSUBISHI MELSEC FX Loader O  

MITSUBISHI MELSEC-Q Loader (Q00/01) O  

MITSUBISHI MELSEC-Q Loader (Q02/06/12/25) O  

YASKAWA YASKAWA MEMOBUS RTU O  

MODICON 

MODBUS ASCII Protocol O  

MODBUS RTU Protocol O  

MODBUS TCP  O 

PANASONIC NAIS FPO MEWTOCOL-COM O  

OMRON OMRON PLC (Host Link) O  

SIEMENS 

SIEMENS RK512/3964R O  

SIEMENS S7 Ethernet  O 

SIEMENS S7 MPI O  

SIEMENSE S7 PPI Direct O  

SAIA SAIA S-BUS O  

YOKOGAWA YOKOGAWA Computer Link Protocol O  
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Chapter 23.  Server Function 

 

23. 1   Server Function 

 

Xpanel supports two Server Functions:  MODBUS SLAVE and Xpanel Data Server. 

MODBUS supports MODBUS RTU and TCP. Xpanel Data Server is an exclusive method of communicating 

between Xpanel installations or between Xpanel and Cimon SCADA. Being a Server, Xpanel can request 

and retrieve Data from another Xpanel installation (Client). 

 

 

 

23.1.1 MODBUS SLAVE 

Xpanel supports MODBUS RTU and TCP. 

Go to [Tool]  [ Data Server]  [ MODBUS Slave]. 
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< MODBUS Slave Comm. Setting> 

  

ICON Description 

 Save a Server Tag or Address. 

 
Edit a Server Tag or Address. 

 Delete a Server Tag or Address. 

 Open the Comm. Setting window. 

 
Edit the Communication Settings. 

 Delete the Communication Settings. 

 

 1. Communication Setting. 

In the Communication Setting dialog box, choose MODBUS RTU or TCP, and configure the Slave 

Comm. Settings. Click on the Comm. Setting icon  to bring up the Communication Settings 

dialog box. 
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 1) MODBUS RTU Slave 

 

 
 

 Slave Type : MODBUS RTU 

 Unit No. : Select the Comm. Station number for the Slave. 
 Port:  Select a COM Port for the MODBUS RTU Slave. 
 Baud Rate : 300 ~ 256000 bps. 
 Mode : RS232, RS422/485. 
 Parameter:  Configure Comm. Parameters for communication. 

 

 

2) MODBUS TCP Slave 

 

 
 

 Slave Type : MODBUS TCP 

 Unit No. : MODBUS Unit ID for Slave. 
 Socket No. : 502 

※ The IP address of the MODBUS TCP Slave is the same as the IP Address of the Ethernet 
Loader or Xpanel Config. 
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2.  Connecting a Tag to the MODBUS Address 

  

Either a Tag or an Address can be used to connect with the MODBUS Address. The Xpanel 

MODBUS Slave supports a Coils area and a Holding Register area. The Coils area is used for Bit 

Addresses, and the Holding Register area is used for WORD Addresses. After the Coil or Holding 

Register is set up, click on the New Tag icon . 

 

 1) Coils Area 

 

The Coils Area is a BIT area which allows both Reading and Writing, so a Digital Tag or 

Address should be used. 

 

 
 

If a Tag is selected in the Coils area, the MODBUS Address starts from “00001”. 

The Master Device can Read and Write values to the MODBUS Address assigned to the Tag. 

 

 
 

 

 

2) Holding Register Area 

 

 The Holding Register area is a WORD area which allows both Reading and Writing, so 

an Analog Tag or Address should be used. 
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If a Tag is selected in the Holding area, the MODBUS Address starts from “40001”. 

The Master Device can Read and Write values to the MODBUS Address assigned to the Tag. 

 

 
 

23.1.2 Xpanel Data Sever 

 

The Xpanel Data Server is an exclusive method of communicating between Xpanel installations or 

between Xpanel and Cimon SCADA.  

Go to [Tool]  [ Data Server]  [ Xpanel Data Server]. 
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1. Communication Channel Settings 

The Xpanel Data Server supports Ethernet communication only. No Comm. Channel is needed. 

The Server function uses the IP Address of the Ethernet Loader or Xpanel Config. 

 

 
 

2. Connecting a Tag to the Data Server Address 

Select the Tag or Address to be connected to the Data Server Address. Rather than selecting a 

Bit or WORD area, select the Data Memory (D)  Area and click on the New Tag icon . For a 

String Address, a String Tag or the Address of a String Memory (S) Area should be selected. 

 

When you save the tag, a new Address is provided for the Server. The Client can use this address 

to read and Write data. 

 

 1) Data Memory (D) Area 

The Data Area can use either a BIT or Analog Tag (Address).  

 

 
  

If a Tag is assigned to the Data Area, the Data Server Address starts from Address 

“D0000”.  The Master Device can read and write Tag values using the Data Address. 
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2) String(S) Area 

The String Memory Area can use Sting Tags or Addresses. 

 

 

 

 

 

 

  

If a Tag is assigned to the String Area, the Data Server Address starts from Address 

“S0000”.  The Master Device can read and write Tag values using the Data Address. 

 

 3. Connecting to the Xpanel Data Server with CIMON-SCADA 

  

1) I/O Device Setting 

  Run CIMON-D, and go to the I/O Device configuration. 

   

  I/O Device selection 

 

 

  Select “KDT Systems CIMON-XPANEL Ethernet” as the I/O Device. 
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   Add a Station 

Click on the “Add Station” button, and create a new station. 

 

 

 

  

 

 

 

 

 

 

 

  

The Station IP Address is the same as the Xpanel Server IP. 
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    Setting Up the Communication Block  

 

 
   

Click on [Add COM Block], and enter the settings for communicating with the 

Xpanel Data Server. 

The Address of the COM Block on SCADA must be the Address in the Xpanel 

Data Server. 

 

  Communication Port 

The IP Address of the Communication Port is the IP Address of the PC on which 

CIMON SCADA is installed. 
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2) Database Entry 

Go to [Tool]  [Database] and create a Tag in the Database. Select Xpanel I/O Device in 

the SCADA Database, and save the Tag using the Address in the COM Block. 

 

 

 

 

 

 

 

 

 

  

 

3) Testing Communication By Dynamic Tag 

 

 
 

Communication can be tested by displaying the Tag Value on screen.  You will be able to 

see if SCADA is reading the correct data from the Xpanel Data Server. 
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Chapter 24.  Xpanel System Configuration 

 

24. 1 Xpanel Configuration 

 

Xpanel Configuration is used to edit Xpanel settings, and to check Xpanel's status. 

 

 
 

24. 2 How to run the Xpanel Configuration Window 

 

Touch three corners of the screen in the order shown below to open the Xpanel Configuration dialog 

box. 
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24.3 Xpanel Configuration Functions 

 1. System Log 

 

The System Log records and displays Xpanel device status, Communication status and the 

operation Log. 

 

 

  

2. Communication (Frame) Monitor 

 

The Comm. Monitor displays Xpanel's Communication status. Displaying Communication frames 

allows you to monitor communication in real time. (Some Slave communication Drivers are not 

supported). 
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 Start / Pause : Start or pause Frame monitoring. 

 Clear : Clear all displayed frames from the screen. 

 ASCII : Display all frames in ASCII code. 

 Resize : Control the size of the Frame Monitoring window. 

 

 

3. Comm. Configuration 

 

Xpanel communication settings can be configured in Comm. Config.  The Ethernet settings are 

the same as the settings in the ‘Xpanel Ethernet Loader’. Serial Comm. settings display the 

Device setting of XpanelDesigners ‘I/O Device’. After Comm. settings are modified, the Xpanel 

Application Program must be restarted in order to apply the changes. 

 

You can modify the Serial Comm. Driver Com Port settings and the Comm. parameter settings 

along with the Ethernet IP settings. After modification, the system must be shut down and 

restarted to apply the changes.. 

 

※ Note 

If a project is downloaded from XpanelDesigner to Xpanel, the XpanelDesigner I/O Device 

Comm. settings will replace the Xpanel Comm. settings. 

 

 
 

 

4. Misc. Configuration 

 

The LCD Backlight On/Off, LCD Brightness and Mouse cursor Enable/Disable settings can be 

configured in Misc. Config. 
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 LCD Backlight OFF : If no Touch operation is executed within the interval set in 

Minutes, the Backlight automatically shuts off. 

 Mouse Cursor Enable :  Display the Mouse Cursor on screen. 

 LCD Brightness :  Set the LCD backlight brightness. 

 

 

5. Touch Calibration 

 

The touch point can be calibrated. 
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(Calibration of the type shown above applies to some models (XT10/12CB). For more precise 

calibration, select 16 Points) 

Click the Calibration point as shown on the screen. 

After calibration is complete, selecting [System Shutdown] to restart Xpanel and apply the 

modifications. 

 

 

6. Screen Capture 

 

The current Xpanel screen can be saved as a Bitmap file. It will be saved to the location ‘\Xpanel’, 

with a file name made up of the combined date and time. 

 

 

7. Date/Time 

 

You can set Xpanel's internal time. 
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8. SW Keyboard 

 

A Virtual Keyboard is supported. 

 

 
To close the SW keyboard, click the ‘SW Keyboard’ button again. 

 

 

9. Printer 

 

You can configure the settings for a printer (connected to Xpanel). 

 

 
 

 

1) Print Setting  

 

(1) Printer :  Two types of Printer are supported (PCL Laser and PCL Inkjet) 

(2) Port : Select the port that is connected to the Printer. 

 

A. For a USB Host Printer : Select [LPT1:] 

If the USB printer is connected to Xpanel successfully, [LPT1:] is automatically 

set as the port. 
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B. For a Network Printer : Select [Network] 

If Network is selected, the Net Path field becomes available. Enter the printer 

path in the Net Path field. 

Ex) \\Shared PC name\\shared Printer Name 

(3) Paper Size: Select the Printer paper size. 

(4) Draft Mode : if this feature is disabled, the image will be printed with better 

resolution. 

(5) Print Range : select ‘all(L)’. 

(6) Orientation : Select the print direction. 

(7) Margins : Control the margin size. 

 

 

2) For Network Port 

 

If the port is set to Network with a valid path, the ‘Network Printer Logon’ Dialog box 

will appear. 

 

 
Enter the user name for the shared PC and the password in the “Logon” Dialog box, and 

then click ‘OK’. If the ‘Logon’ process is successful, the Dialog box will close and  the 

‘Network Password warning’ dialog box will appear. 

 

 

 
 

If ‘Yes’ is selected, the Dialog box will close. If ‘No’ is selected, Password entry wo;; be 

required for every attempt at access to the shared PC. 

 

To apply and save the modified settings, click on [System Shutdown] in the “Xpanel 

Config” window to restart the system Otherwise, the modifications will only apply as 

long as Xpanel remains turned on. 



 

Chapter 24. Xpanel System Configuration 370 

 

3) Print Screen 

 

After you have set up the printer, a screen image can be captured and printed out by 

using the ‘HardCopy()’ Function. This function prints out the current screen using the 

default printer. 

 

 

(1) Create a button for Print Screen 

 

 A. Select a Command Expression object. 

 B. Go to [Object Config]  [Touch] [Command Expression]. 

 C. Enter the Function ‘HardCopy();’ as the Command Expression. 

    

 
 

D. After downloading a project to Xpanel, touch the ‘HardCopy()’ button. 

E. Check the result. 

 

If the printer settings are OK, print completion message will appear. 

 

 
10. Modbus 

 

With the Modbus Slave feature enabled, Comm. setting can be modified. Modbus Slave settings 

can only be checked or modified after the Modbus RTU feature has been enabled in 

XpanelDesigner. The Modbus TCP Slave feature uses an Ethernet IP address set in the ‘Ethernet 

Loader’ or ‘Comm Config’.  
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After modification is completed, click [Xpanel Config]  [System Shutdown] to save and apply 

the modification to Xpanel. 

 

※For more detailed information, please see Modbus Slave in Ch.23 (Server Function). 

 

 

11. System Shutdown 

 

This feature saves and applies the modifications made in Xpanel Configuration.  Unless 

modifications are saved using ‘System Shutdown’, they will no longer apply after Xpanel is 

restarted. 

 

if you click on ‘System Shutdown’, Xpanel will restart. Click on ‘OK’ when the confirmation 

message appears. 

 

 
   

After Xpanel restarts, all modifications made before restart will be applied to Xpanel. 
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12. Exit 

 

The Exit feature terminates the Xpanel Application Program (project), and returns to the 

Windows CE Desktop. 

 

 

 ● Ethernet Loader 

The Ethernet Loader program is always running on the Desktop. If the Ethernet Loader is 

forced to quit, Xpanel will not be able to download any projects using Ethernet 

communication. 

 

● My Device 

This is just like My Computer on a Windows PC. Users can search for Files or Folders in 

Xpanel. 

 

※ Deleting or editing the Xpanel System file can affect Xpanel's operation. 

 

● Calibration 

Calibrate Xpanel Touch operations. 

 

● Xpanel 

Execute an Xpanel Application Program (project). 
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Chapter 25.  Communication Port Pinouts 
 

1. Communication Ports 
 

1) Serial Communication Ports  
 

(1) XT04/XT07/XT08 (The same port is used for COM1/COM2) 

 RS232C – COM1 

Connector Pin No Name Description 

 

 

1   

2 RD Receive Data 

3 TD Transmit Data 

4   

5 SG Signal Ground 

6   

7   

8   

9   

 

 RS422/485 – COM2 

 

Connector Pin No Name Description 

 

1 SDA Send Data A 

2   

3   

4 RDA Receive Data A 

5 SG  

6 SDB Send Data B 

7   

8   

9 RDB Receive Data B 

 

 



 

Chapter 25. Communication Port Pin outs 374 

 

 

※ Xpanel Hybrid (7”) uses only the COM1 port for communication (COM2 is used internally to 
communicate with PLCs). COM1 supports all three types of Serial communication (RS232/422/485). 

 

 

(2) XT10/XT12/XT15 

 

 RS232C – COM2 

Connector Pin No Name Description 

 

1 DCD Data Carrier Detect 

2 RD Receive Data 

3 TD Transmit Data 

4 DTR Data Terminal Ready 

5 SG Signal Ground 

6 DSR Data Set Ready 

7 RTS Request To Send 

8 CTS Clear To Send 

9 RI Ring Indicator 

 

 RS422/485 – COM1 

Connector Pin No Name Description 

 

1 RDB Receive Data B 

2 RDA Receive Data A 

3 GND Ground 

4 SDB Send Data B 

5 SDA Send Data A 
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2) Ethernet 

This Ethernet interface complies with IEEE802.3 for 10BaseT/100BaseTX. 

 

 




